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PPrreeffaaccee  

This Preface provides supporting information for the Oracle Financial Services DM Pack 

Installation Guide and includes the following topics: 

 Summary 

 Audience 

 Documentation Accessibility 

 Related Documents 

  Conventions  

SSuummmmaarryy  

You can find the latest copy of this document in OTN library which includes all the recent 

additions/revisions (if any) done till date. 

Before you begin the installation, ensure that you have an access to the Oracle Support Portal 

with the required login credentials to quickly notify us of any issues at any stage. You can obtain 

the login credentials by contacting Oracle Support. 

AAuuddiieennccee  

The Oracle Financial Services DM pack Installation and Configuration Guide is intended for 

Administrators, Business User, Strategists, and Data Analyst, who are responsible for installing 

and maintaining the application pack components.  

The document assumes you have experience in installing Enterprise components. Basic 

knowledge about the OFS DM pack components, OFSAA Architecture, UNIX commands, 

Database concepts and Web Server/ Web Application Server is recommended. 

Prerequisites for the Audience 

Following are the expected preparations from the administrator before starting the actual 

installation: 

The document assumes that you have experience in installing Enterprise components and 

basic knowledge about the following are recommended: 

 

■ Oracle Financial Services Data Management pack components 

■ OFSAA Architecture 

■ UNIX Commands 

■ Database Concepts 

■ Web Server/ Web Application Server 

 

http://docs.oracle.com/cd/E60528_01/homepage.htm
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DDooccuummeennttaattiioonn  AAcccceessssiibbiilliittyy  

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program 

website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc 

Access to Oracle Support 

Oracle customers have access to electronic support through My Oracle Support. For information,   visit   
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info  

Or, 

visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 

impaired. 

RReellaatteedd  DDooccuummeennttss  

This section identifies additional documents related to OFS DM Infrastructure. You can access 

Oracle documentation online from Documentation Library (OTN). 

 Oracle Financial Services Reconciliation Framework Release 8.0.0.0.0 User Guide 

 Oracle Financial Services Analytical Applications Infrastructure User Guide (OTN library) 

 Oracle Financial Services Analytical Applications Infrastructure Environment Check Utility Guide 

(OTN library) 

 

CCoonnvveennttiioonnss  aanndd  AAccrroonnyymmss  

The following text conventions are used in this document: 

Conventions Description 

boldface 

Boldface type indicates graphical user interface elements associated with an 

action, or terms defined in text or the glossary. 

italic 

Italic type indicates book titles, emphasis, or placeholder variables for which you 

supply particular values. 

monospace 

Monospace type indicates commands within a paragraph, URLs, code in 

examples, text that appears on the screen, or text that you enter. 

 

The following table lists the abbreviations used in this document: 

Abbreviation Meaning 

AIX Advanced Interactive executive 

http://www.oracle.com/pls/topic/lookup?ctx=acc&amp;id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&amp;id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&amp;id=trs
http://docs.oracle.com/cd/E60528_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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Abbreviation Meaning 

DEFQ Data Entry Forms and Queries 

DML Data Manipulation Language 

EAR Enterprise Archive 

EJB Enterprise JavaBean 

ERM Enterprise Resource Management 

FTP File Transfer Protocol 

GUI Graphical User Interface 

HTTPS Hypertext Transfer Protocol Secure 

J2C J2EE Connector 

J2EE Java 2 Enterprise Edition 

JDBC Java Database Connectivity 

JDK Java Development Kit 

JNDI Java Naming and Directory Interface 

JRE Java Runtime Environment 

JVM Java Virtual Machine 

LDAP Lightweight Directory Access Protocol 

LHS Left Hand Side 

MOS My Oracle Support 

OFS Oracle Financial Services 

OFSAAI Oracle Financial Services Analytical Application Infrastructure OLAP 

OSDC Oracle Software Delivery Cloud 

OS Operating System 

RAM Random Access Memory 

RDMS Relational Database Management System 

SFTP Secure File Transfer Protocol 

SID System Identifier 
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Abbreviation Meaning 

SSL Secure Sockets Layer 

TNS Transparent Network Substrate 

URL Uniform Resource Locator 

VM Virtual Machine 

Web Archive WAR 

XML Extensible Markup Language 
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11  IInnttrroodduuccttiioonn  ttoo  OOFFSS  DDMM  AApppplliiccaattiioonn  PPaacckk  

This chapter includes the following topics: 

 About Oracle Financial Services Analytical Applications (OFSAA) 

 About Oracle Financial Services Analytical Applications (OFSAA) Applications Pack 

 About Oracle Financial Services Data Management 8.0.0.0.0 Applications Pack 

11..11  AAbboouutt  OOrraaccllee  FFiinnaanncciiaall  SSeerrvviicceess  AAnnaallyyttiiccaall  AApppplliiccaattiioonnss  ((OOFFSSAAAA))  

In today's turbulent markets, financial institutions require a better understanding of their risk-

return, while strengthening competitive advantage and enhancing long-term customer value. 

Oracle Financial Services Analytical Applications (OFSAA) enable financial institutions to 

measure and meet risk adjusted performance objectives, cultivate a risk management culture 

through transparency, lower the costs of compliance and regulation, and improve insight into 

customer behavior. 

OFSAA uses industry-leading analytical methods, shared data model and applications 

architecture to enable integrated risk management, performance management, customer insight, 

and compliance management. OFSAA actively incorporates risk into decision making, enables to 

achieve a consistent view of performance, promote a transparent risk management culture, and 

provide pervasive intelligence. 

Oracle Financial Services Analytical Applications delivers a comprehensive, integrated suite of 

financial services analytical applications for both banking and insurance domain.  

11..22  AAbboouutt  OOrraaccllee  FFiinnaanncciiaall  SSeerrvviicceess  AAnnaallyyttiiccaall  AApppplliiccaattiioonnss  ((OOFFSSAAAA))  PPaacckk  

The following figure depicts the various application packs that are available across the OFSAA 

Banking and Insurance domains: 
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OFSAA Application Pack 

11..33  AAbboouutt  OOrraaccllee  FFiinnaanncciiaall  SSeerrvviicceess  DDaattaa  MMaannaaggeemmeenntt  88..00..00..00..00  AApppplliiccaattiioonnss  

PPaacckk  

OFS DM Application Pack includes the following applications: 

 

 Financial Services Reconciliation Framework: Reconciles the balances from the operational 

systems of a bank with the balances as maintained in the General Ledger (hereinafter referred 

to as GL) of the bank. With this application banks can also reconcile between General Ledgers 

maintained in the bank. The balances in the GL of a bank are the ones which are audited and 
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duly certified by the internal and external auditors. The GL balances are considered to be the 

final version of truth in a bank. Therefore, all data extracted from any other operational systems  

of a bank need to be reconciled with the balances maintained in the GL to ensure that they are 

complete, accurate, and comprehensive. It then acts as an authentic and reliable base for any 

further decision making. 

 

Note: OFSAA DM Pack has to be used with other Application Packs such as: 

 Credit Risk Management Pack 

 Capital Adequacy Pack 

 Treasury Pack 

 Profitability Pack 

11..44  AAbboouutt  OOFFSSAAAA  IInnffrraassttrruuccttuurree  

Oracle Financial Services Analytical Applications Infrastructure (OFS AAI) powers the Oracle 

Financial Services Analytical Applications family of products to perform the processing, 

categorizing, selection and manipulation of data and information needed to analyze, understand 

and report on specific performance, risk, compliance and customer insight issues by providing a 

strong foundation for the entire family of Oracle Financial Services Analytical Applications 

across the domains of Risk, Performance, Compliance and Customer Insight. 

11..44..11  CCoommppoonneennttss  ooff  OOFFSSAAAAII  

The OFSAA Infrastructure is comprised of a set of frameworks that operates on and with the 

Oracle Financial Services Analytical Applications Data Model and form the array of components 

within the Infrastructure.  

 

The OFSAA Infrastructure components/ frameworks are installed in two layers; primarily the 

Metadata Server and Infrastructure services run on one layer, and the UI and presentation logic 

runs on the other. The UI and presentation layer is deployed on any of the supported J2EE 

Servers. 

 

The following figure depicts the various frameworks and capabilities that make up the OFSAA 

Infrastructure:  
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22  UUnnddeerrssttaannddiinngg  OOFFSS  DDMM  AApppplliiccaattiioonnss  PPaacckk  IInnssttaallllaattiioonn  

This chapter includes the following topics: 

 Installation Overview 

 Deployment Topology 

 Hardware and Software Requirements 

 Verifying the System Environment 

 Understanding Installation Modes 
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22..11  IInnssttaallllaattiioonn  OOvveerrvviieeww  

This section gives an overview of the OFS DM Application Pack Installation. The figure below shows the 

order of procedures you need to follow:  

 

OFS DM Applications Pack Installation Tasks and Descriptions 

Tasks Details and Documentation 

Verify Systems Environment To verify that your system meets the minimum necessary requirements 

for installing and hosting the OFS DM Application Pack, see Verifying 

System Environment. 

Obtain the software To access and download the OFS DM  Application Pack,  see Obtaining 

the software. 

Configure and Execute the For instructions on creating the database schemas, see Configuring 
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Tasks Details and Documentation 

Schema Creator Utility and Executing the Schema Creator Utility. 

Install OFS DM Application 

Pack 

For instructions on Installing OFS DM Application Pack , see Installing 

the OFS DM Pack Installer. 

Configure OFS DM Setup See Post Installation Configuration and Post Deployment. 

 

22..22  DDeeppllooyymmeenntt  TTooppoollooggyy  

The following figure depicts the typical deployment topology implemented for OFSAA 

Applications.  
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22..33  HHaarrddwwaarree  aanndd  SSooffttwwaarree  RReeqquuiirreemmeennttss  

This section describes the various Operating Systems, Database, Web Server, and Web 

Application Server versions, and other variant details on which this release of the Oracle Financial 

Services DM Application Pack has been qualified.  

Note: OFS DM Application Pack installation can be performed on both Virtual and Physical servers. 
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22..33..11  CCoonnffiigguurraattiioonnss  ssuuppppoorrtteedd  ffoorr  JJaavvaa  77  

The following table shows the minimum hardware and software requirements for installing OFS 

DM Application Pack (for Java 7). 

Configurations supported for Java 7 

Requirement Sub-Category Value 

Operating 

System 

 

Oracle Linux / Red Hat Enterprise Linux (x86-64) 

Oracle Linux Server release 5.3 up to 5.10 - 64 bit 

Oracle Linux Server release 6.0 and above - 64 bit 

Note: Same versions of RHEL is supported 

Oracle Solaris (SPARC) 
Oracle Solaris v5.10 Update 11 and above - 64 bit 

Oracle Solaris v5.11 update 1 and above – 64 bit 

IBM AIX (PowerPC) AIX 6.1 (TL 09 and above) - 64 bit  

Shell KORN Shell (KSH) 

Note: If the OS is IBM AIX 6.1, configure the size parameter setting for “Large File Support”. Refer link http://www-

01.ibm.com/support/docview.wss?uid=isg3T1000290 for more details. 

If the operating system is RHEL, install the package lsb_release using one of the following commands by logging in as root 

user: 

 yum install redhat-lsb-core 

 yum install redhat-lsb 

Java Runtime 

Environment 

Oracle Linux / Red Hat Enterprise Linux 

Oracle Solaris 

Oracle Java Runtime Environment (JRE) 1.7.x - 64 bit 

IBM AIX IBM AIX Runtime, Java Technology JRE 1.7.x - 64 bit 

Oracle Database 

Server and 

Client 

 

Oracle Database Server Enterprise Edition 11g 

Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-RAC with/ 

without partitioning option 

http://www-01.ibm.com/support/docview.wss?uid=isg3T1000290
http://www-01.ibm.com/support/docview.wss?uid=isg3T1000290
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Requirement Sub-Category Value 

Oracle Database Server Enterprise Edition 12c 

Release 1 (12.1.0.1.0 +)- 64 bit RAC/ Non-RAC with/ 

without partitioning option 

Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit 

Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit 

Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle 

thin driver) 

Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle 

thin driver) 

 Oracle Distribution of R version 2.15.1, 2.15.2 or 

2.15.3.(Optional) 

Oracle R Enterprise (Server) version 1.4. (Optional) 

Note: Ensure that the following patches are applied: 

 Oracle Server 12c,  v12.1.0.1 – 17082699 

 Oracle Server 12c,  v12.1.0.2 - 19392604, 19649591 

 Also for latest information, refer http://support.oracle.com/,  12.1.0.2 Bundle Patches for 

Engineered Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1) 

OLAP 

Oracle Hyperion Essbase V 11.1.2.1+ (Server and Client) with Oracle 11g 

Database 

V 11.1.2.3+ (Server and Client) with Oracle 12c 

Database 

Oracle OLAP 

 

V 11.2.0.3+ with Oracle 11g Database 

V 12.1.0.1+ with Oracle 12c Database 

Note: 

Oracle Hyperion Essbase & Oracle OLAP is required only if you are using the OLAP feature of OFSAAI. For 

Oracle OLAP, ensure that you have configured the Oracle Database server with OLAP option. 

http://support.oracle.com/
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Requirement Sub-Category Value 

Web Server/ 

Web Application 

Server 

 

Oracle Linux / Red Hat Enterprise Linux  

Oracle Solaris 

IBM AIX 

 

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 

2.2.x/ IBM HTTP Server 

 Oracle WebLogic Server 12.1.2+ (64 bit) 

 IBM WebSphere Application Server 8.5+  

with bundled IBM Java Runtime (64 bit) 

 Apache Tomcat 8.0.x (64 bit) 

Note: 

OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle JRockit is not 

supported. 

Desktop 

Requirements 

Operating System MS Windows 7/ Windows 8/ Windows 8.1 

Browser MS Internet Explorer 9 , 10(Compatibility Mode) and 11 

(Compatibility Mode) 

Oracle Java plug-in 1.7.0+* (64- bit) 

Turn on Pop-up blocker settings. For more information, 

refer Internet Explorer Settings 

Office Tools MS Office 2007/ 2010/2013 

Adobe Acrobat Reader 8 or above 

Screen Resolution 1024*768 or 1280*1024 

Directory 

Services  

- 

OFSAAI is qualified on both OPEN LDAP 2.2.29+ and 

Oracle Internet Directory v 11.1.1.3.0. However, it can 

be integrated with other directory services software like 

MS Active Directory. 

Note: 

Configuration of Directory services software for OFSAAI installation is optional. For more information on 

OFSAA_DM_Pack_8%200_Installation_Guide.docx#IE_settings
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Requirement Sub-Category Value 

configuration, see Infrastructure LDAP Configuration.  

Open LDAP needs to be installed on MS Windows Server machine only. 

22..33..22  CCoonnffiigguurraattiioonnss  SSuuppppoorrtteedd  ffoorr  JJaavvaa  88  

The following table shows the minimum hardware and software requirements for installing Oracle 

Financial Services Data Management Application Pack (Java 8) on each machine 

Requirement Sub-Category Value 

Operating 

System 

 

Oracle Linux / Red Hat Enterprise Linux (x86-64) 

Oracle Linux Server release 5.3 up to 5.10 - 64 bit 

Oracle Linux Server release 6.0 and above - 64 bit 

Note: Same versions of RHEL is supported 

Oracle Solaris (SPARC)/Solaris x86 
Oracle Solaris v5.10 Update 11 and above - 64 bit 

Oracle Solaris v5.11 update 1 and above – 64 bit 

IBM AIX (POWERPC) AIX 6.1 (TL 09 and above) - 64 bit  

Shell KORN Shell (KSH) 

Note: If the OS is IBM AIX 6.1, configure the size parameter setting for “Large File Support”. Refer link http://www-

01.ibm.com/support/docview.wss?uid=isg3T1000290 for more details. 

If the operating system is RHEL, install the package lsb_release using one of the following commands by logging in as root 

user: 

 yum install redhat-lsb-core 

 yum install redhat-lsb 

Java Runtime 

Environment 

Oracle Linux / Red Hat Enterprise Linux 

Oracle Solaris 

Oracle Java Runtime Environment (JRE) 1.8.x - 64 bit 

OFSAA_DM_Pack_8%200_Installation_Guide.docx#INFRASTRUC_LDAP_conf
http://www-01.ibm.com/support/docview.wss?uid=isg3T1000290
http://www-01.ibm.com/support/docview.wss?uid=isg3T1000290
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Requirement Sub-Category Value 

IBM AIX IBM AIX Runtime, Java Technology JRE 1.8.x - 64 bit 

Oracle Database 

Server and 

Client 

 Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0 +) - 64 bit RAC/ Non-RAC with/ 

without partitioning option 

 Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1.0 +)- 64 bit RAC/ Non-RAC with/ 

without partitioning option 

 Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit 

 Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit 

 Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver) 

 Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver) 

 

Note: Ensure that the following patches are applied: 

 Oracle Server 12c, v12.1.0.1 – 17082699 

 Oracle Server 12c, v12.1.0.2 - 19392604, 19649591 

Also for latest information, refer http://support.oracle.com/, 12.1.0.2 Bundle Patches for Engineered Systems and 

DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1) 

OLAP 

Oracle Hyperion Essbase V 11.1.2.1+ (Server and Client) with Oracle 11g 

Database 

V 11.1.2.3+ (Server and Client) with Oracle 12c 

Database 

Oracle OLAP 

 

V 11.2.0.3+ with Oracle 11g Database 

V 12.1.0.1+ with Oracle 12c Database 

Note: 

Oracle Hyperion Essbase & Oracle OLAP is required only if you are using the OLAP feature of OFSAAI. For 

Oracle OLAP, ensure that you have configured the Oracle Database server with OLAP option. 

Web Server/ Oracle Linux / Red Hat Enterprise Linux  Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 

http://support.oracle.com/
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Requirement Sub-Category Value 

Web Application 

Server 

 

Oracle Solaris 

IBM AIX 

 

2.2.x/ IBM HTTP Server 

 Oracle WebLogic Server 12.1.3+ (64 

bit) 

 Apache Tomcat 8.0.x (64 bit) 

Note: 

IBM WebSphere 8.5.x (Full Profile) on Java 8 

is not available. 

Note: 

OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle JRockit is not 

supported. 

For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and install patch 18729264 

from http://support.oracle.com/ 

Desktop 

Requirements 

Operating System MS Windows 7/ Windows 8/ Windows 8.1 

Browser MS Internet Explorer 9 , 10(Compatibility Mode) and 11 

(Compatibility Mode) 

Oracle Java plug-in 1.7.0+* (64- bit) 

Turn on Pop-up blocker settings. For more information, 

refer Internet Explorer Settings 

Office Tools MS Office 2007/ 2010/2013 

Adobe Acrobat Reader 8 or above 

Screen Resolution 1024*768 or 1280*1024 

Other Software Directory Services 

OFSAAI is qualified on both OPEN LDAP 2.2.29+ and 

Oracle Internet Directory v 11.1.1.3.0. However, it can 

be integrated with other directory services software like 

MS Active Directory. 

http://support.oracle.com/
OFSAA_DM_Pack_8%200_Installation_Guide.docx#IE_settings
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Requirement Sub-Category Value 

Note: 

Configuration of Directory services software for OFSAAI installation is optional. For more information on 

configuration, see Infrastructure LDAP Configuration.  

Open LDAP needs to be installed on MS Windows Server machine only. 

NOTE:  To upgrade an existing OFSAA 8.0.x Java 7 instance to Java 8, refer Appendix O. 

The following table shows the minimum software requirements for running OFS DM Application Pack on 

each machine. 

Operating System Database Web Application Server Web Server 

Oracle Linux 5.3 up to 

5.10/ 6.0 and above 

Oracle Database  Oracle WebLogic Server 

/Apache Tomcat Server 

Oracle HTTP Server/ 

Apache HTTP Server 

Oracle Solaris 5.10/ 5.11 Oracle Database  Oracle WebLogic Server 

/Apache Tomcat Server 

Oracle HTTP Server/ 

Apache HTTP Server 

IBM AIX 6.1 Oracle Database  IBM WebSphere Application 

Server /Apache Tomcat Server 

IBM HTTP Server/ 

Apache HTTP Server 

22..44  VVeerriiffyyiinngg  tthhee  SSyysstteemm  EEnnvviirroonnmmeenntt  

To verify if your system environment meets the minimum requirements for the installation, a Pre-

Install Check utility (Environment Check) is available within the Install Kit archive file. This utility 

can also be obtained separately by contacting Oracle Support. 

Though the system environment verification is an integral and automated part of the installation of 

this software product, Oracle strongly recommends running this utility prior to beginning the 

installation as part of your organization’s "Installation Readiness Verification Process". 

NOTE:  For more details on download and usage of this utility, see Oracle Financial Services 

Analytical Applications Infrastructure Environment Check Utility Guide given in the Related 

Documents section. 

22..55  UUnnddeerrssttaannddiinngg  IInnssttaallllaattiioonn  MMooddeess  

The following modes of installation are available for the OFS DM Application Pack. 

OFSAA_DM_Pack_8%200_Installation_Guide.docx#INFRASTRUC_LDAP_conf
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22..55..11  GGUUII  MMooddee  

This mode launches the product installation in a Graphical User Interface (GUI) Mode. You 

need to enter the required information on various panels within the UI in a user interaction format 

at various stages. 

NOTE:  For more information on configuration required for GUI Mode installation, refer 

Configuration for GUI Mode Installation. 

22..55..22  SSiilleenntt  MMooddee  

This mode mandates updating the installation configuration files with required details and 

performs installation in a “Silent” non user interactive format. 
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33  PPrreeppaarriinngg  ffoorr  IInnssttaallllaattiioonn  

This chapter provides necessary information to review before installing the OFS DM Pack 

v8.0.0.0.0.  

This chapter includes the following topics: 

 Installer and Installation Prerequisites 

 Obtaining the Software 

 Common Installation Activities 

NOTE:   If you are installing an application pack on an environment, where another application pack is 

already installed, you may get a warning message such as "Object Already Exists". This 

message can be ignored. 

 

NOTE:  Do not perform released model upload after installation. Released model upload cannot be 

performed after installation as it may lead to installation issues. 

33..11  IInnssttaalllleerr  aanndd  IInnssttaallllaattiioonn  PPrreerreeqquuiissiitteess  

The following table mentions the list of prerequisites required before beginning the installation for 

OFS DM Application Pack. The Installer/ Environment Check utility notifies you if any 

requirements are not met. 

Installer and Installation Prerequisites 

Requirement Sub-Category Expected Value 

Environment Settings 

Java Settings PATH in .profile to be set to include the Java 

Runtime Environment absolute path. The path should 

include java version (java 7, or Java 8) based on the 

configuration. 

Note: Ensure the absolute path to JRE/bin is set at the 

beginning of PATH variable. 

For example, 

PATH=/usr/java/jre1.7/bin:$ORACLE_HOME/b

in:$PATH 

Ensure no SYMBOLIC links to JAVA installation is 

being set in the PATH variable. 
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Requirement Sub-Category Expected Value 

Oracle Database 

Settings 

TNS_ADMIN to be set in .profile pointing to 

appropriate tnsnames.ora file 

ORACLE_HOME to be set in .profile pointing to 

appropriate Oracle Client installation 

PATH in .profile to be set to include appropriate 

$ORACLE_HOME/bin path. 

Oracle Essbase 

Settings 

ARBORPATH, ESSBASEPATH, HYPERION_HOME 

to be set in the .profile pointing to an appropriate 

Oracle Essbase Client installation. 

Note: These settings are required only if you want to 

use Oracle Hyperion Essbase OLAP features. 

OS/ File System 

Settings 

File Descriptor 

Settings 

Greater than 15000 

Total Number of 

Process Settings 

Greater than 4096 

Port Settings Default port numbers to be enabled on the system are 

6500, 6501, 6505, 6507, 6509, 6510, 6666, 9999, and 

10101. 

.profile 

permissions 

User to have 755 permission on the .profile file. 

 

Installation 

Directory  

A directory where the installation files will be installed. 

Set 755 permission on this directory.  

This directory needs to be set as FIC_HOME. 

Temporary 

Directory 

Default temporary directory where installation files are 

stored for a short period of time to support faster 

installation. 

 For installation on UNIX OS, your UNIX 

administrator must give you the required read-
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Requirement Sub-Category Expected Value 

write permissions for the /tmp directory and 

disable the NOEXEC option 

 Configure adequate space on the /tmp 

directory. It is recommended that you allocate 

more than 10 GB of space. 

Note: If NOEXEC is enabled, the extraction of files by 

the installer into the /tmp directory is prevented and 

the binaries will not execute in the directory, which will 

fail the installation. 

Staging Area/ 

Metadata 

Repository 

Directory 

A directory to hold the application metadata artifacts 

and additionally act as staging area for flat files.  

The directory should exist on the same system as the 

OFSAA Installation. This directory can be configured 

on different mount or under a different user profile. 

Set 777 permission on this directory. 

Download 

Directory 

A directory where the product installer files will be 

downloaded/ copied. 

Set 755 permission on this directory. 

Database Settings 

 

Database Instance 

Settings 

NLS_CHARACTERSET to be AL32UTF8 

NLS_LENGTH_SEMANTICS to be BYTE 

OPEN CURSORS limit to be greater than 1000 

Web Application Server WebSphere/ 

WebLogic/  

Tomcat 

Web Application Server should be installed and profile 

/domain created. 

You will be prompted to enter the WebSphere Profile 

path or WebLogic Domain path or Tomcat Deployment 

path during OFSAAI installation. 

Note: Refer Appendix C for WebSphere Profile 

Creation and WebLogic Domain Creation. 

For deployment on Oracle WebLogic Server 12.1.3+ 

(64 bit) with Java 8, download and install patch 



   

Oracle Financial Services Software Confidential - Restricted 

30 

Requirement Sub-Category Expected Value 

18729264 from http://support.oracle.com/. 

Web Server Apache HTTP 

Server/  

Oracle HTTP 

Server/ 

IBM HTTP Server 

This is an optional requirement. 

HTTP Server Installation to be present.  

You will be required to enter the Web Server IP/ 

Hostname and Port details during installation. 

Note: Refer Appendix C for Web Server installation. 

Others Oracle R/ Oracle 

R Enterprise 

This is an optional requirement. 

OFSAA  For installation on Java 8, login to 

http://support.oracle.com/ and search for 

21160684 under the Patches & Updates tab. 

 For installation of this release on an existing 

OFSAA instance version 8.0.1.0.0, login to 

http://support.oracle.com/ and search for 

21133780 under the Patches and Updates 

tab. 

OFSAAI One-off Download the consolidated one-off patch 25777667 

from https://support.oracle.com/. 

NOTE:  Ensure that the tablespace(s) used for the database user(s) is set to AUTOEXTEND ON. 

33..22  OObbttaaiinniinngg  tthhee  SSooffttwwaarree  

This release of OFS DM Application Pack v8.0.0.0.0 can be downloaded from the Oracle 

Software Delivery Cloud (https://edelivery.oracle.com). You need to have a valid 

Oracle account in order to download the software. 

33..33  CCoommmmoonn  IInnssttaallllaattiioonn  TTaasskkss  

The following are the common pre-installation activities that you need to carry out before installing 

the OFS DM Application Pack. 

This section includes the following topics: 

http://support.oracle.com/
http://support.oracle.com/
https://support.oracle.com/
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 Configuration for GUI Mode Installation 

 Identifying the Installation, Download and Metadata Repository Directories 

 Download and copy the OFS DM Application Pack Installer 

 Copying and Extracting the Software 

 Setting up the Web Server/ Web Application Server 

33..33..11  CCoonnffiigguurraattiioonn  ffoorr  GGUUII  MMooddee  IInnssttaallllaattiioonn  

To install OFS DM Application Pack in GUI mode, you need to ensure the below software and 

configurations are available: 

 Install and configure any PC X Server software such as Open Text Exceed (formerly 

Hummingbird Exceed) on the user desktop system from which the installation is triggered. 

 Configure DISPLAY variable in the user .profile. 

 Ensure to set the DISPLAY variable on the system on which the OFSAA will be installed, to 

point to the user desktop system where the PC X Server software has been installed. 

Syntax: 

export DISPLAY=hostname:n.n1  

where hostname is the IP Address/ Host Name of the user desktop system and n is the 

sequence number (usually 0). 

For example, 10.11.12.13:0.0 or myhostname:0.0 

33..33..22  IIddeennttiiffyyiinngg  tthhee  IInnssttaallllaattiioonn,,  DDoowwnnllooaadd  aanndd  MMeettaaddaattaa  RReeppoossiittoorryy  DDiirreeccttoorriieess  

For installation of any OFSAA Application Pack, the below folders/ directories required to be 

created. 

 OFSAA Download Directory (Optional) - Create a download directory and copy the 

OFSAA Application Pack Installer File (Archive).  This is the directory where the 

downloaded installer/ patches can be copied. 

 OFSAA Installation Directory (Mandatory) – Create an installation directory. This is the 

directory where the installer would install/ copy the product files. FIC_HOME variable to be 

set in the .profile pointing to this OFSAA Installation Directory. 

 OFSAA Staging/ Metadata Repository Directory (Mandatory) – Create a Staging/ 

Metadata Repository Directory. This is the directory where you would be required to copy 

data loading files, save data extracts etc. Additionally, this folder also maintains the OFSAA 

metadata artifacts. This is commonly referred as “FTPSHARE”. 
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NOTE:  Ensure the user permission is set to 755 on the Installation and Download Directory. 

       Ensure the user permission is set to 777 on the Staging Directory. 

33..33..33  DDoowwnnllooaadd  aanndd  ccooppyy  tthhee  OOFFSS  DDMM  AApppplliiccaattiioonn  PPaacckk  IInnssttaalllleerr  

 To download the OFS DM Application Pack, you need to login to the Oracle Software 

Delivery Cloud (https://edelivery.oracle.com). You need to have a valid Oracle account in 

order to download the software. 

 Copy the downloaded installer archive to the Download Directory (in Binary mode) on the 

setup identified for OFSAA installation. 

33..33..44  CCooppyyiinngg  aanndd  EExxttrraaccttiinngg  tthhee  SSooffttwwaarree  

Once you obtain the installer, copy the installer in Binary mode to the Download Directory. 

NOTE:  You must be logged in to the UNIX operating system as a non-root user. 

 

1. Download the unzip utility (OS specific) unzip_<os>.Z, and copy it in Binary mode to 

the directory that is included in your PATH variable.. If you already have the unzip utility 

to extract the contents of the downloaded archive, skip to the next step. 

2. Uncompress the unzip installer file using the command: 

uncompress unzip_<os>.Z 

NOTE:  In case you notice an error message "uncompress: not found [No such file or directory]" when        

the package is not installed, contact your UNIX administrator. 

 

3. Give EXECUTE permission to the file using the command: 

chmod 751 unzip_<os> 

For example, chmod 751 unzip_sparc 

4. Extract the contents of the Oracle Financial Services Data Management Application Pack 

8.0.0.0.0 to Download Directory using the following command: 

unzip OFS_DM_PACK.zip 

NOTE:  DO NOT rename the Application Pack installer folder name on extraction from the archive. 

5. Copy the below file to the installer folder in Text mode. Provide execute privileges and 

execute the file to remove the ^M characters.  

ctrlRemove.sh
 

https://edelivery.oracle.com/
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6. Give below permission to the installer folder. Navigate to the Download Directory and 

execute the command:  

chmod –R 755 OFS_DM_PACK 

33..33..55  SSeettttiinngg  uupp  tthhee  WWeebb  SSeerrvveerr//  WWeebb  AApppplliiccaattiioonn  SSeerrvveerr  

For setting up the environment based on your selected Web Server/ Web Application Server, 

refer to Appendix A for more information. 
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44  IInnssttaalllliinngg  OOFFSS  DDaattaa  MMaannaaggeemmeenntt  AApppplliiccaattiioonn  PPaacckk  

This chapter describes the steps to be followed to install the OFS DM pack.  

This chapter includes the following sections: 

 Schema Creator Utility 

 Configuring and Executing the Schema Creator Utility 

 Installing the OFS DM Application Pack Installer 

44..11  SScchheemmaa  ccrreeaattoorr  uuttiilliittyy  

Creating database users/ schemas is one of the primary steps in the complete OFSAA 

installation. This release of OFSAA provides a utility to quickly get started with the OFSAA 8.0 

installation by allowing easier and faster creation of database User(s)/ Schema(s), assign the 

necessary GRANT(s) and so on. Additionally, it also creates the required database objects in 

these schemas.  

This section includes the following topics: 

 About Schema Creator utility 

 Execution Modes in Schema Creator Utility 

 Execution Options in Schema Creator Utility 

44..11..11  AAbboouutt  SScchheemmaa  CCrreeaattoorr  uuttiilliittyy  

The schema creator utility should be configured and executed mandatorily every time prior to 

installation of any OFSAA Application Pack. 

The following are the types of schemas that can be configured in the OFSAA: 

 CONFIG – Denotes the unique OFSAA setup configuration schema. It contains entities and 

other objects required for OFSAA setup information.  

NOTE:  There can be only one CONFIG schema per OFSAA instance. 

 ATOMIC – Denotes the schema that contains the data model entities. One ATOMIC 

schema is attached to one Information Domain.  

NOTE:  There can be multiple ATOMIC schemas per OFSAA Instance.  

 SANDBOX – Denotes the schema that contains the data for all Sandbox executions. One 

SANDBOX schema is attached to one Sandbox Information Domain.  

NOTE:  There can be multiple SANDBOX schemas per OFSAA Instance. 



   

Oracle Financial Services Software Confidential - Restricted 

35 

 ADDON – Denotes any additional schema used by the OFSAA Applications.  

44..11..22  EExxeeccuuttiioonn  MMooddeess  iinn  SScchheemmaa  CCrreeaattoorr  UUttiilliittyy  

The Schema Configuration Utility supports the following modes of execution: 

 Online Mode: In the mode, the utility connects to the database and executes the DDLs 

for Users, Objects and Grants. If you have the SYSDBA privileges you can execute the 

Schema Creator Utility in Online mode and thereby create the Users, Objects and 

Grants during the execution process. 

NOTE:   To execute the utility in Online mode, you need to connect as “<User> AS SYSDBA”. 

 Offline Mode:  In the mode, the utility generates SQL script with all the required DDLs 

for Users, Objects and Grants. This script needs to be executed by the DBA on the 

appropriate database identified for OFSAA usage. If you do not have the SYSDBA 

privileges, you can execute the Schema Creator Utility in Offline mode and generate 

the script file that contains the Schemas, Objects and Grants, information. 

Subsequently, a SYSDBA user can execute the script file manually.  

NOTE:  1. To execute the utility in Offline mode, you need to connect as any user with below 

grants(alternatively, you can also connect as a user with SYSDBA privileges): 

      SELECT ON DBA_ROLES 

      SELECT ON DBA_USERS 

      SELECT ON DBA_DIRECTORIES 

      SELECT ON DBA_TABLESPACES 

      CREATE SESSION 

    For more details refer, Executing the Schema Creator Utility in Offline Mode 

2. If there are any errors during the script execution, reconfigure the OFS_DM_SCHEMA_IN.XML 

file and execute the utility. This regenerates the scripts with corrected information. For more 

information, refer Configuring OFS_DM_SCHEMA_IN.XML file. 

 

NOTE:  Do not modify the OFS_DM_SCHEMA_OUT.XML file generated after the execution of this utility. 

44..11..33  EExxeeccuuttiioonn  OOppttiioonnss  iinn  SScchheemmaa  CCrreeaattoorr  UUttiilliittyy  

Depending on the option you choose to run the OFSAA Application Pack Installer, you need to 

choose the schema creator utility execution option. To run the OFSAA Application Pack installer 

in SILENT mode, it is mandatory to execute the schema creator utility with –s option.  

Note: If the schema creator utility is executed without the option –s, it is mandatory to run the OFSAA 

Application Pack Installer in GUI mode.  
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44..22  CCoonnffiigguurriinngg  aanndd  EExxeeccuuttiinngg  tthhee  SScchheemmaa  CCrreeaattoorr  UUttiilliittyy  

This section includes the following topics: 

 Prerequisites 

 Configuring the Schema Creator Utility 

 Executing the Schema Creator Utility 

44..22..11  PPrreerreeqquuiissiitteess  

The following prerequisites must be ensured before configuring the Schema Creator Utility: 

 You must have the Oracle User ID/Password with SYSDBA privileges (not applicable for 

offline mode). 

 You must have the JDBC Connection URL for RAC/Non RAC database. 

 The HOSTNAME/IP of the server on which OFSAA is getting installed. 

 It is recommended to set the PGA_AGGREGATE_LIMIT database-parameter value 

sufficiently, when Oracle 12c is installed. 

 While installing the application on Solaris 5.10 with Java 6, ensure to mandatorily modify 

setup.sh line number 503 as “Line: modelsize=$(ls -l $dataModelFile | tr -

s '\t' ' ' | cut -d ' ' -f5)”. 

 You must add a TNS entry before the installation. 

NOTE:  If this release of the OFS DM Application Pack version 8.0.0.0.0 is installed on an OFSAA 

setup where the underlying OFSAA Infrastructure (OFS AAI) version is upgraded to version 

8.0.1.0.0+, download and install the patch for schema creator utility (Bug 20912588) by 

following the instructions in the Readme.txt packaged in it prior to executing the utility. 

44..22..22  CCoonnffiigguurriinngg  tthhee  SScchheemmaa  CCrreeaattoorr  UUttiilliittyy  

To configure the Schema Creator Utility, follow these steps: 

1. Log in to the system as non-root user. 

2. Navigate to the following path: OFS_DM_PACK/schema_creator/conf. 

3. Edit the OFS_DM_SCHEMA_IN.xml file in a text editor. 

4. Configure the elements as described in Configuring OFS_DM_SCHEMA_IN.XML file. 

5. Save the OFS_DM_SCHEMA_IN.xml file. 

6. Navigate to BIN folder and run the schema creator utility. 
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NOTE:  On successful execution of the utility, the entered passwords in the 

OFS_DM_SCHEMA_IN.xml.xml file are nullified. 

44..22..33  EExxeeccuuttiinngg  tthhee  SScchheemmaa  CCrreeaattoorr  UUttiilliittyy  

This section includes the following topics: 

 Executing the Schema Creator Utility in Online Mode 

 Executing the Schema Creator Utility in Offline Mode 

 Executing the Schema Creator Utility with –s option  

 Executing the Schema Creator Utility while Installing Subsequent Application Pack Schema 

Creation 

NOTE:  If you intend to use Oracle OLAP feature, execute the below grant on all  ATOMIC schema(s)  

grant olap_user to &database_username 

4.2.3.1 EExxeeccuuttiinngg  tthhee  SScchheemmaa  CCrreeaattoorr  UUttiilliittyy  iinn  OOnnlliinnee  MMooddee  

In Online Mode, the Schema Creator Utility will create all the Schemas, Schema Objects, 

Tablespaces, Grants, and Roles in the database during the execution process.  

To execute the schema creator utility while creating the schemas for the application pack, follow 

these steps: 

1. Log in to the system as non-root user. 

2. Navigate to the following folder path: OFS_DM_PACK/schema_creator/bin/ 

3. Execute the following command. 

 ./osc.sh  

   Note: For silent mode installation, execute the osc.sh file using the following command: 

./osc.sh -s 

The following message is displayed: You have chosen ONLINE mode. Triggering the 

utility in ONLINE mode will execute the DDLs directly on the Database. Do you wish to 

proceed? (Y/y or N/n). 

4. Enter Y/y to proceed with the script generation 

or 

Enter N/n to quit script creation. 

5. Enter the DB Username with SYSDBA Privileges.  

For example: SYS as SYSDBA. 

6. Enter the User Password.  
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7. The console runs the initial validation checks and then displays the following message: 

You have chosen to install this Application Pack on <Name of the Atomic 

Schema>ATOMIC schema. Do you want to proceed? (Y/N). 

8. Enter Y/y to proceed with the schema creation. 

or 

9. Enter N/n to quit schema creation 

The following message is displayed. 

You have chosen to install this Application Pack on <Name of the Infodom>. Do you 

want to proceed? (Y/N). 

 

10. Enter Y/y to start the schema creation. 

Or 

Enter N/n if you want to quit executing the schema creation.  
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NOTE:  On successful execution of schema creator utility, the console displays the following status 

message: 

Schema Creator executed successfully. Please proceed with the installation.  

 

Refer log file in OFS_DM_PACK/schema_creator/logs folder for execution status. In case of 

any errors, contact Oracle Support. 

11. Make TNS entries for the created users in TNSNAMES.ORA. For details, see Add TNS 

Entries in TNSNAMES.ORA file. 

4.2.3.2 EExxeeccuuttiinngg  tthhee  SScchheemmaa  CCrreeaattoorr  UUttiilliittyy  iinn  OOfffflliinnee  MMooddee  

In Offline Mode, the Schema Creator Utility will create an output in SQL file format. This script has 

to be executed manually by logging as database user with SYSDBA privileges. The SQL file will 

contain the scripts for creation of Schemas, Schema Objects, Tablespaces, Grants, and Roles. 

Prerequisites: 

To execute the utility in Offline mode, you need to connect as any user with below grants 

(alternatively, you can also connect as a user with SYSDBA privileges): 

 Database user with below privileges: 

• SELECT ON DBA_ROLES 

• SELECT ON DBA_USERS 

• SELECT ON DBA_DIRECTORIES 

• SELECT ON DBA_TABLESPACES 

• CREATE SESSION 
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NOTE:  Explicit Grants to the user are required. Grants assigned through Roles are not supported. 

To execute the schema creator utility in the offline mode, follow these steps: 

1. Log in to the system as non-root user. 

2. Navigate to the following path: OFS_DM_PACK/schema_creator/bin 

3. Execute the osc.sh file using the following command: 

./osc.sh –o 

Note: For silent mode installation, execute the osc.sh file using the following command: 

./osc.sh -s  

4. The following message is displayed:  

You have chosen OFFLINE mode. Triggering the utility in OFFLINE mode will generate 

the script. Do you wish to proceed? (Y/y or N/n). 

5. Enter Y /y to generate the script. 

or 

Enter N/n to quit the schema creation. 

6. Enter the DB Username with SELECT privileges. 

7. Enter the User Password. 

 

8. The console runs the initial validation checks and displays the following message: 

 You have chosen to install this Application Pack on <Name of the Atomic 

Schema>ATOMIC schema. Do you want to proceed? (Y/N). 

9. Enter Y/y to start the script generation. 
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Or 

Enter N/n if you want to quit the script generation. 

The following message is displayed. 

You have chosen to install this Application Pack on <Name of the Infodom>. Do you 

want to proceed? (Y/N). 
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10. Enter Y/y to start the script generation.  

Or 

Enter N/n if you want to quit the script generation. 

 

 

NOTE:  On successful execution of schema creator utility, the console displays the following status 

message:  

Schema Creator executed successfully. Please execute 

scratch/ofsaaapp/OFS_DM_PACK/schema_creator/sysdba_output_scripts.sql 

before proceeding with the installation. 

11. Navigate to the directory: OFS_DM_PACK/schema_creator.  

12. Login to SQLPLUS with a user having SYSDBA Privileges. 

13. Execute the sysdba_output_scripts.sql file using the following command: 

SQL>@sysdba_output_scripts.sql 

Alternatively, you can copy the sysdba_output_scripts.sql file and 

SQLScripts folder to a remote server and execute sysdba_output_scripts.sql 

file, after providing appropriate execute permissions. 

NOTE:  Refer log sysdba_output_scripts.log file for execution status. In case of any errors, 

contact Oracle Support. This log would be empty if there are no errors in the execution. 

14. Make TNS entries for the created users in TNSNAMES.ORA. For details, see Add TNS 

Entries in TNSNAMES.ORA file. 

4.2.3.3 EExxeeccuuttiinngg  tthhee  SScchheemmaa  CCrreeaattoorr  UUttiilliittyy  wwiitthh  ––ss  ooppttiioonn  

If you want to run the OFSAA Application Pack Installer in SILENT mode, it is mandatory to 

execute the schema creator utility with –s option. 

To execute the utility with –s option, follow these steps: 
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1. Edit the file OFS_DM_PACK/schema_creator/conf/OFS_DM_SCHEMA_IN.xml in text 

editor. 

2. Set the value for attribute “INFODOM” of <SCHEMA> tag(s) to specify a specific 

Information Domain name. By default, the value is empty and the utility will derive the 

Information Domain name. If the attribute value is set, the utility/ installer will configure 

the Information Domain against this <SCHEMA>. 

3. Execute the utility with –s option. 

For Example: ./osc.sh –s. 
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4. Make TNS entries for the created users in TNSNAMES.ORA. For details, see Add TNS 

Entries in TNSNAMES.ORA file. 

 

NOTE:  If the utility is executed without the –s option, it is mandatory to launch the OFSAA Application 

Pack Installer in GUI mode. 

 

NOTE:  To execute the utility in OFFLINE mode with SILENT option, type. /osc.sh –o –s. 

4.2.3.4 EExxeeccuuttiinngg  tthhee  SScchheemmaa  CCrreeaattoorr  UUttiilliittyy  wwhhiillee  IInnssttaalllliinngg  SSuubbsseeqquueenntt  AApppplliiccaattiioonn  PPaacckk  

SScchheemmaa  CCrreeaattiioonn  

While executing the schema creator utility for subsequent Application Pack, you can choose to 

install the pack either on the same Information Domain/ Atomic Schema or on a new Information 

Domain/ Atomic Schema. 

NOTE:  OFS DM Application Pack can be installed on any Information Domain/ Atomic schema where 

any OFS Application Packs are installed other than OFS Behavior Detection Application Pack 

or OFS Compliance Regulatory Reporting Application Pack. 

To execute the schema creator utility while installing OFS DM Application Pack over an existing 

Application pack, follow these steps: 

1. Repeat the steps 1 to 8 from Executing the Schema Creator Utility section.  

NOTE:  Ensure to use the same config schema user name as the previous Application Pack  

2. The utility identifies the Application Packs that are already installed on the current 

OFSAA setup and displays the following on console: 

• Atomic schema of the Existing Application Pack  

• Information Domain Name of the Existing Pack 

• List of Installed Application Packs 

3. Enter Y/y to start the schema creation.  

Or 

Enter N/n if you want to quit executing the schema creation. 

4. You can select the Atomic User, on which you want to install the Application Pack. 

5. Make TNS entries for the created users in TNSNAMES.ORA. For details, see Add TNS 

Entries in TNSNAMES.ORA file. 
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NOTE:  On successful execution of schema creator utility, the console displays the following status 

message: Success. Please proceed with the installation.  

NOTE:  Refer log file in OFS_DM_PACK/schema_creator/logs folder for execution status. Refer 

log sysdba_output_scripts.log file for execution status, if executed in offline mode. 

This log would be empty if there are no errors in the execution. In case of any errors, contact 

Oracle Support. 

4.2.3.5 VVeerriiffyyiinngg  tthhee  LLoogg  FFiillee  

If schema creation is successful, the console would display an appropriate message. If the schema 

creation runs into errors, do refer the log file. 

<<OFSDMAP Installer folder>>/<<OFS_DM_PACK>>/schema_creator/logs/ 

<<OFS_DM>>_osc_<timestamp>.log for further details.  

You may contact Oracle support anytime for assistance. 

44..33  IInnssttaalllliinngg  tthhee  OOFFSS  DDMM  AApppplliiccaattiioonn  PPaacckk  

Follow the instructions in this section to install the OFS DM Application Pack depending on the 

mode of installation.  

This section includes the following topics: 

 GUI Mode Installation 

 Silent Mode Installation 

 Verifying the Log File 

44..33..11  GGUUII  MMooddee  IInnssttaallllaattiioonn  

 

Note: Ensure you have followed the steps as mentioned in the Configuration for GUI Mode Installation 

section prior to proceeding with the next steps. 

1. Log in to the system as non-root user. 

2. Identify a directory for installation and set the same in the user .profile file as below: 

FIC_HOME=< OFSAA Installation Directory > 

export FIC_HOME 

3. Execute the user .profile.  

4. Configure and execute the Schema Creator utility. For details, see Configuring and 

Executing the Schema Creator Utility. 

Note: Ensure to make a TNS entry for the new users created. For details, see Add TNS 

Entries in TNSNAMES.ORA file. 
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5. Navigate to the path: OFS_DM_PACK/bin. 

NOTE:  For Java 8: Edit the VerInfo.txt file in the path /OFS_DM_PACK_8.0/OFS_AAI/bin/ to 

modify the value for property JAVA_VERSION to 1.8, and save the changes. 

6. Run the installer in GUI Mode: 

./setup.sh GUI 

Refer the console for any errors during Pre-install checks. 

 

Validating the Installation 
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Initialization Window 

 

License Agreement 

7. Select I accept the terms of the License Agreement option. 

8. Click Next. The Application Pack details are displayed: 
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Application Pack Details 

9. Select the product to enable for which you have already obtained license. 

10. Click Next. The License Agreement page is displayed.  

 

OFSDM License Agreement 

11. Select I accept the terms of the License Agreement option. 

12. Click Next. The Pre Installation Summary page is displayed. 
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Pre Installation Summary 

13. Click Next. The Manage Information Domain page is displayed. 

 

Information Domain 

14. The default Information Domain Name for this Application Pack is OFSDMINFO. Double-

click to edit the Information Domain Name, if it is a new Information domain and you wish 

to change the name of the information domain name. 

15. Click Next. 
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OFSAA App Pack License Agreement 

16. Select I accept the terms of the License Agreement option. 

17. Click Next. The following page is displayed. 

 

License Details 

18. Click Next. The User Installation Directory window is displayed. Enter the installation 

directory path. This is the directory you have set in the user .profile file in step 2. 
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User Installation Directory  

19. Click Next. OFSAA Infrastructure details are displayed in the following figure. Enter the 

IP address or hostname of the OFSAAI server and Database server. 

 

 

OFSAA Infrastructure Server Details 

20. Click Next to view the Web Application Server details. The options are Tomcat, 

WebSphere and WebLogic. 
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Web Application Server Type 

21. Select the web application server type and Click Next. Based on the selection, 

corresponding screens are displayed. 

For WebSphere: The WebSphere Setup Details window is displayed.  

Enter the profile path (up to the Node Cell Name directory) of WebSphere.  

The format is WebSphere path <WebSphere profile 

directory>/installedApps/ <NodeCellName>. 

 

Websphere setup Details 

For Tomcat: The Absolute Tomcat Path window is displayed. Enter the Tomcat 

deployment path (till /webapps) where the application will be deployed. 
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Tomcat Path 

For WebLogic: The WebLogic Home window is displayed. Enter the WebLogic home 

directory path, and click Next.  

 

Weblogic Setup Details 

22. Enter the OLAP details. Enter 1 if you want to configure OFSAAI OLAP feature, using 

Oracle Hyperion Essbase. By default, 0 is displayed.  
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OLAP Details 

23. Click Next. The Web Server Details window is displayed. 

 

Web Server Details 

24. Enter the Web server details. Select Enable HTTPS checkbox if you want to configure 

HTTPS for the OFSAA application. Also, enter the Web Server (HTTP Server) Port, 

Web Server IP Address, Context name for deployment and Local path to any folder on 

the Web Application Server (Tomcat/ WebSphere/ WebLogic). 

25. Click Next. The Database Details window is displayed. 
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Database Details 

26. Enter Oracle SID/Service Name, JDBC URL, Configuration Schema User ID and 

Password, and Absolute Driver Path. 

The JDBC URL, Configuration Schema User ID, Oracle Configuration Schema 

Password, and Absolute Driver Path are auto-populated 

Note: Absolute Driver Path can be the path where Oracle DB client is installed or JDBC driver is installed. 

For example, /scratch/oracle/app/oracle/product/11.2.0/client_1/jdbc/lib 

 

27. Click Next. The Ports Configuration window is displayed. 

 

Ports Configuration 
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28. Enter Java Port, Native Port, Agent Port, ICC Server Port, and ICC Native Port. You 

can proceed with the default port values configured.  

29. Click Next. The Ports Configuration window is displayed. 

 

Ports Configuration 

30. Enter OLAP Port, Message Server Port, Router Port, and AM Port. 

31. Click Next. The Default Infrastructure Administrator and Authorizer User Password 

window is displayed. 

 

Administrator and Authorizer User Password 
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32. Enter the passwords for default System Administrator and System Authorizer users.  

33. Click Next. The SFTP Details window is displayed. 

 

SFTP Details 

34. Enter 1 to enable SFTP or 0 to enable FTP. 

Note: Ensure the system on which the OFSAA Infrastructure is being installed, has either FTP/ SFTP 

enabled. You can also modify the SFTP settings. 

 

35. Enter the port to be used for file transfer. 

36. Click Next.  
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OFSAAI Pre Installation Details 

37. Enter the path of the FTPSHARE directory and the User Id and password for OFSAAI 

Server. This is same as the OFSAA Staging/ Metadata Repository Directory.FTP/SFTP 

User ID and Password for FTPSHARE Directory access. 

Note: The transfer of data (files) between the OFSAAI Server and the Web Application Server happens 

over FTP/ SFTP. Ensure the necessary host configurations are made for a successful handshake. 

 

38. Click Next. The Pre Installation Summary window is displayed. 

 

OFSAAI Pre InstallationSummary 

39. Click Install. The Installing OFSAA Infrastructure window is displayed. 
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Installing OFSAAI Infrastructure 

Anytime during the installation you can click Cancel to stop the installation. Once 

completed, the Installation Summary screen is displayed. 

 

 

OFSAAI Installation Summary 

The Summary screen displays the number of Fatal Errors, Errors, Debug Statements, 

Information, and Warnings along with the location of log files. 

40. Click Next. The Installation Complete window is displayed. 
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OFSAAI Installation Complete 

Note: If the installation is successful with some warnings, you can navigate to the installation log for more 

details and address them. 

 

41. Click Done. You have successfully installed the OFS AAI Application Pack. 

Upon invoking the installer, the Introduction screen is displayed with the 

prerequisites for installation. Ensure that all the prerequisites are met before you 

proceed with the installation. 

42. The Checking OFSAA Service screen is displayed.  

Note: This step verifies the OFSAA services startup. In case of errors during services 

check, an appropriate error message is displayed. 
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Checking OFSAAI Services 

43. After checking the OFSAA services, installation proceeds with the Application Pack 

Installation. The Installing Financial Services Advanced Analytics Infrastructure Pack 

screen is displayed. 

 

Installing OFSAAI Screen 
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Application Pack Installation 

44. Click Next, to start solution setup. 

 

Solution Setup Introduction 

45. Click Next. Choose the log mode for this installer. If Debug is selected, the Passwords 

will be printed in the log file. 

 



   

Oracle Financial Services Software Confidential - Restricted 

63 

 

Log Mode 

46. Click Next. 

 

Pre-Setup Information 

Enter the Data Management Segment, Tablespace, Application Server ftpshare log path and Database 

server ftpshare log path in the Information domain screen. 
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Pre-Infodom Creation Summary 

47. Enter the Tablespace name and click Next. 

 

Tablespace Name 

48. Select Yes, If you want to perform model upload, and click Next. 
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Model Upload Confirmation 

49. Select the type of data model, and click Next.

 

Customizing Data Model 

50. If the option Customized Data Model was chosen, the following panel is displayed 

prompting the user to select the customized data model located in the machine.Choose 

the customized datamodel file from the server, and click Next. 

Note: Data model xml file should be available in the server. 
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In case the installation is being performed on an existing information domain, the data model that is 

planned to be selected in this panel should be merged with the data model that was previously uploaded 

in the information domain.  

In case the installation is being performed on a new information domain, data model that is either 

customized or merged with other data models can be selected in this panel. 

 

 

 

Please Wait 

The following panel displays pre-model upload details. 

51. Verify the summary details, and click Next. 
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Pre- Model Upload Summary 

52.  Select the ETL application/source, and click Next. 

 

Solution Setup - Pre- Setup Information 

53. Enter the ETL application details, and click Next. 
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Solution Setup - Pre- Setup Information 

54. The Pre-installation Summary window is displayed. 

 

Pre-Installation Summary 

55. Click Install. The Installing OFSAA Infrastructure window is displayed. The message Are 

you sure you wish to proceed with the installation? is displayed. 

56. Click Yes, to proceed. The Installing Solution Setup screen is displayed. 
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Installing Solution Setup 

57. Anytime during the installation you can click Cancel to stop the installation. Once 

completed, the Installation Complete screen is displayed. 

 

Install Complete 

58. Click Done. The following message is displayed: Please wait, pack_install is being 

configured for your system. This may take a moment. 
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Please Wait 

59. Click Next. The installation summary page is displayed. 

 

Installation Summary 

60. Click Next, to finish the installation. The Installation Complete screen is displayed. 
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Install Complete 

61. Click Done. Post Install Health checks are displayed: 
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Post Install Checks 

NOTE:  Download and install patch for Bug 21160684 if installing this release of the OFS DM 

Application Pack version 8.0.0.0.0 on Java 8. 

62. Install the consolidated one-off patch 25777667. Refer to the Readme available with the 

patch for further instructions on installing the patch. 
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44..33..22  SSiilleenntt  MMooddee  IInnssttaallllaattiioonn  

In the Silent Mode Installation you must configure the product xml files and follow the instructions 

in command prompt. 

Follow the below steps for installing the OFS DM Pack in SILENT mode. 

1. Log in to the system as non-root user. 

2. Identify a directory for installation and set the same in the user .profile file as below: 

FIC_HOME=< OFSAA Installation Directory > 

export FIC_HOME 

3. Execute the user .profile. 

4. Navigate to OFS_DM_PACK folder (installer folder). 

NOTE:  For Java 8: Edit the VerInfo.txt file in the path /OFS_DM_PACK_8.0/OFS_AAI/bin/ to 

modify the value for property JAVA_VERSION to 1.8, and save the changes. 

5. Edit the OFS_DM_PACK/conf/OFS_DM_PACK.xml to enable the product licenses. Update 

the attribute ENABLE=YES/NO in OFS_DM_pack.xml for licensing the App in the pack.  

NOTE:  Refer Configuring OFS_DM_PACK.XML for details on configuring this XML file.  

NOTE:  Update OFS_DM_PACK.XML, set the attribute “ENABLE=YES” of <APP_ID> tag for 

applications to be enabled during installation. If any application has mentioned OFS_AAAI as 

PREREQ in the <APP_ID> tag, set the attribute “ENABLE=YES” for OFS_AAAI. To install DM, 

ensure to enter "YES" in ENABLE attribute for OFS_AAI, and OFS_GLRECON. 

6. Edit the OFS_DM_PACK/schema_creator/conf/OFS_DM_SCHEMA_IN.xml file to set the 

appropriate attribute values. It is optional to include INFODOM = “<Infodom Name>” in 

OFS_DM_SCHEMA_IN.xml file. If not specified a default INFODOM name is generated. 

NOTE:  Refer Configuring OFS_DM_SCHEMA_IN.XML for details on configuring this XML file. 

NOTE:  Ensure to make TNS entries for the created users in TNSNAMES.ORA. For details, see Add 

TNS Entries in TNSNAMES.ORA file. 

7. Edit the OFS_DM_PACK/OFS_AAI/conf/OFSAAI_InstallConfig.xml file to set the 

appropriate infrastructure installation attribute values.  

NOTE:  This step can be ignored if an installation of OFSAA 8.0 already exists. 

Refer Configuring OFSAAI_InstallConfig.xml for details on configuring this XML file. 

8. Execute the schema creator utility with –s option. 
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NOTE:  This step is mandatory and should be executed before every additional OFSAA Application 

Pack installation. 

Refer Executing the Schema Creator Utility for more details. 

9. The installer folder contains a template file “Silent.template” 

10. Create a copy of this file and rename the copy as “Silent.props” 

11. Edit the file “Silent.props” and specify the parameters as per the requirements. For details, 

see Silent.props. 

12. On successful execution of the schema creator utility, navigate to OFS_DM_PACK/bin/ and 

execute the application pack installer with SILENT option. 

13. Execute ./setup.sh SILENT in the console. 

14. Enter the Infrastructure FTP/SFTP password value, when prompted at the command prompt. 

 

Console Prompts User Inputs 

Please enter 

Infrastructure FTP/SFTP 

password 

Enter the password to access Product Staging/Metadata 

repository directory in the application server. 

Note: During installation stage, you need to enter the 

config schema password again. 

 

15. Enter Always, when prompted to add host key fingerprint. 

16. The OFSAAI License Agreement is displayed. 

 

17. To accept the License Agreement, enter Y/y. 

18. Enter the passwords for default Infrastructure administrator and authorizer users. 
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Console Prompts User Inputs 

Please enter password 

for default Infrastructure 

administrator user 

SYSADMN 

Enter the password for the System Administrator. 

Please re-enter 

password for default 

Infrastructure 

administrator user 

SYSADMN 

Enter the same password again to confirm its validity. 

Please enter password 

for default Infrastructure 

authorizer user 

SYSAUTH 

Enter the password for the System Authorizer. 

Please enter password 

for default Infrastructure 

authorizer user 

SYSAUTH 

Enter the same password again to confirm its validity. 

NOTE:  SYSADMN and SYSAUTH are the two default OFSAAI administrative users created. 
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NOTE:  The installation process continues on the console. Do not close the console until the 

installation process is complete. 

19. The following message is displayed in the console 

Installation completed… 
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20. On completion of installation, refer the installation log files. For more information, refer 

Verifying the Log Files. 

21. Install the consolidated one-off patch 25777667. Refer to the Readme available with the 

patch for further instructions on installing the patch. 

44..33..33  SSiilleenntt..pprrooppss  

Silent installation is achieved via a properties file [Silent.props] that must be updated with proper values, 

before attempting to install using the silent mode.  

NOTE:  Do not install the application in same segment when run management is used. 
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The following table lists all the properties that need to be specified: 

Property Name Description of Property Permissible values  Comments 

LOG_MODE Specify Log Mode 1 = Debug Mode 

0= General Mode 

Password will be printed 

in the log file 

Password will not be 

printed in the log file. 

Default is GENERAL 

SEGMENT_1_CODE Specify the Data Management 

Segment Code 

User Input   

APPFTP_LOG_PATH Specify the Infodom Maintenance 

log path(to be created) for the new 

Infodom 

Please ignore if you are doing 

installation on an existing 

information domain 

User Input   

DBFTP_LOG_PATH Specify the Infodom Maintenance 

log path(to be created) for the new 

Infodom 

Please ignore if you are doing 

installation on an existing 

information domain 

User Input   

UPLOAD_MODEL Specify whether you want to 

perform Model Upload 

0 = If you have already 

performed Model 

Upload and want to skip 

model upload process 

1 = If you want to 

perform Model Upload 

  

MODEL_TYPE Specify whether you want to use 

the released datamodel or 

customized datamodel for model 

upload process 

0 = If you want to 

upload the released 

datamodel 

1 = If you want to 

upload the customized 

datamodel 

  

DATAMODEL 

DM_DIRECTORY 

Specify the path 

(DM_DIRECTORY) and file 

(DATAMODEL) name for the 

cutomized datamodel 

Mandatory only if you want to 

User Input   
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upload the customized datamodel 

i.e you have specified 

MODEL_TYPE=1 

ETL_APPSRC_TYPE Please specify if you want create 

new ETL App/Src pair or use an 

existing one. 

0 = If you want to create 

a new ETL app/src pair 

1 = If you want to use 

an existing pair 

  

ETL_APP_1_DESC ETL Data Management Application 

description 

User Input Please give description 

for the ETL App/Src pair 

Mandatory if you want to 

create new ETL app/src 

pair 

i.e you have specified 

ETL_APPSRC_TYPE=0 

ETL_SRC_1_1_DESC ETL Data Management  source 

description 

User Input Please give description 

for the ETL App/Src pair 

Mandatory if you want to 

create new ETL app/src 

pair 

i.e you have specified 

ETL_APPSRC_TYPE=0 

ETL_APP_1_NAME ETL Data Management Application 

name 

User Input Specify the ETL 

Application and Source 

Name into ETL Area 

Definitions will be 

deployed 

ETL_SRC_1_1_NAME ETL Data Management source 

name 

User Input Specify the ETL 

Application and Source 

Name into ETL Area 

Definitions will be 

deployed 

 

NOTE:  Download and install patch for Bug 21160684 if installing this release of the OFS DM 

Application Pack version 8.0.0.0.0 on Java 8.  

44..33..44  VVeerriiffyyiinngg  tthhee  LLoogg  FFiillee  

Refer the following logs files for more information:  
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 Refer the Pack_Install.log located at OFS_DM_PACK/ OFS_DM /logs/ folder for 

OFS DM Application Pack installation log file. 

 Refer the log file(s) located at OFS_DM_PACK/OFS_AAI/logs/ folder for Infrastructure 

installation log. 

 Refer the OFSAAInfrastucture_Install.log located at $FIC_HOME folder for 

Infrastructure installation log. 

Note: For Pack on Pack installation, the following errors might be logged in the installation log 

and these can be ignored as this has no implication on the product: 

'create sequence SEQ_DIM_GL_ACCOUNT 

minvalue 1 

maxvalue 999999999999999999999999999 

start with 1 

increment by 1 

cache 20' 

      Warning:Object already exists 

 

Query:'create sequence SEQ_DIM_PRODUCT 

minvalue 1 

maxvalue 999999999999999999999999999 

start with 805 

increment by 1 

cache 20' 

      Warning:Object already exists 

 

Query:'create table FSI_MESSAGES 

( 

  MESSAGE_ID          NUMBER(5) not null, 

  MESSAGE_LOCALE      VARCHAR2(5 CHAR) not null, 

  MESSAGE_CODE        VARCHAR2(50 CHAR), 

  MESSAGE_DESCRIPTION VARCHAR2(1024 CHAR), 

  MESSAGE_TYPE        CHAR(1) not null 
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)' 

 Warning:Object already exists 

44..33..55  VVeerriiffyyiinngg  tthhee  IInnssttaallllaattiioonn  

This section explains the steps to verify your installation of App. 

To verify that you have successfully installed the Data Management pack, follow the below steps: 

1. Login in to the atomic schema. 

2. Verify all the database objects like view, procedure, and functions must have been complied 

without any compilation error. 

3. Deploy the war file and check the application screen is coming or not.
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55  PPoosstt  IInnssttaallllaattiioonn  CCoonnffiigguurraattiioonn  

On successful installation of the Oracle Financial Services Data Management Application Pack, 

follow the post installation steps mentioned below. 

This chapter includes the following sections: 

 Configuring Resource Reference 

 Start OFSAA Infrastructure Services 

 Add TNS entries in TNSNAMES.ORA file 

 Changing Batch ownership   

 Meta Data Browser 

 Configurations for Java 8 

 Creating and Deploying the Application Pack Web Archive   

 Access the OFSAA Application 

 Perform Post Deployment Configurations 

 

NOTE:  Ensure to clear the application cache prior to the deployment of Application Pack Web 

Archive. This is applicable to all Web Servers (WebSphere, WebLogic, Tomcat). For more 

information, refer Clearing Application Cache section. 

55..11  CCoonnffiigguurree  RReessoouurrccee  RReeffeerreennccee  

Configure the resource reference in the Web Application Server configured for OFSAA 

Applications. Refer Appendix B for details on configuring the resource reference in WebSphere, 

WebLogic, and Tomcat Application Servers.  

55..22  SSttaarrtt  OOFFSSAAAA  IInnffrraassttrruuccttuurree  SSeerrvviicceess  

Start the OFSAA Infrastructure Services prior to deployment or accessing the OFSAA 

Applications. 

Refer to the Appendix D for details on Start/ Stop OFSAA Services. 

55..33  AAdddd  TTNNSS  eennttrriieess  iinn  TTNNSSNNAAMMEESS..OORRAA  ffiillee  

Add TNS entries in the tnsnames.ora file, for every schema created for the Application Pack 

To find the tnsname for the entries, follow these steps: 

1. Login to the application using System Administrator privileges. 
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2. Navigate to System Configuration & Identity Management tab. 

3. Click Administration and Configuration >> System Configuration >> Database Details. 

4. Expand the dropdown list for Name to get the list of TNS entry names. 

Alternatively, you can connect to the CONFIG schema and execute the below query: 

select dbname from db_master where dbname !='CONFIG' 

55..44  CChhaannggiinngg  BBaattcchh  oowwnneerrsshhiipp      

All the seeded batches are created with SYSADMN as the owner by default. This needs to be 

updated with username of the user who is responsible for maintenance of the batches. This can 

be done by executing the below procedure in the config schema: 

begin  

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP('fromUser','toUser','infodom;  

end;  

OR 

begin  

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP('fromuser','touser');  

end; 

where “FromUser” indicates the user who currently owns the batch and “toUser” indicates the 

user to which ownership needs to be transferred to. “Infodom” is an optional parameter. 

55..55  MMeettaa  DDaattaa  BBrroowwsseerr  

Execute the following as part of post installation step atomic schema:  

 

declare  

result number;  

begin  

result:=fn_mdb_t2t_view;  

dbms_output.put_line(result);  

exception  

when others then  

dbms_output.put_line(SQLERRM);  

end; 

55..66  CCoonnffiigguurraattiioonnss  ffoorr  JJaavvaa  88  

Refer to the following instructions to extract and apply the patch. 

1. Copy the downloaded patch file (21160684) to your OFSAA server in Binary mode. 
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For more information on downloading the patch files, refer Prerequisite Information 

section >> Category - Others >> Sub-Category - OFSAA. 

2. Follow the instructions given in the Readme to apply the patch. 

3. If the Oracle Database version is 12c, copy ojdbc7.jar from 

$ORACLE_HOME/jdbc/lib to the following locations: 

$FIC_HOME/utility/OFSAAGenerateRepository/lib/ 

$FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/ 

$FIC_HOME/ficdb/lib/ 

$FIC_HOME/ficapp/icc/lib/ 

$FIC_HOME/ficapp/common/FICServer/lib/ 

$FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/ 

$FIC_HOME/ficweb/webroot/WEB-INF/lib/ 

$FIC_HOME/ficdb/etl/classes/ 

4. If the Oracle Database version is 11g, copy ojdbc6.jar from 

$ORACLE_HOME/jdbc/lib to the following locations: 

$FIC_HOME/utility/OFSAAGenerateRepository/lib/ 

$FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/ 

$FIC_HOME/ficdb/lib/ 

$FIC_HOME/ficapp/icc/lib/ 

$FIC_HOME/ficapp/common/FICServer/lib/ 

$FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/ 

$FIC_HOME/ficweb/webroot/WEB-INF/lib/ 

$FIC_HOME/ficdb/etl/classes/ 

55..77  CCrreeaattee  aanndd  DDeeppllooyy  tthhee  AApppplliiccaattiioonn  PPaacckk  WWeebb  AArrcchhiivvee    

On successful installation of the OFSAA Application Pack, the web archive file is automatically 

generated. However, you need to deploy the generated web archive file on the Web Application 

Server.  

To deploy the application pack web archive, follow these steps: 

1. Navigate to FICWEBHOME 

2. Run ant.sh 

For identifying the location of the generated web archive file and for generating and deploying the 

web archive file at any time later, refer Appendix C 

NOTE:  Refer the Oracle Financial Services Forms Manager User Guide for instructions on Creating 

and Deploying the Forms Manager Web Archive. 
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55..88  AAcccceessss  tthhee  OOFFSSAAAA  AApppplliiccaattiioonn  

Prior to accessing the OFSAA application ensure the Internet Explorer Settings are configured. 

Refer to Appendix E for details on accessing the OFSAA Application on successful deployment of 

the application web archive. 

55..99  PPeerrffoorrmm  PPoosstt  DDeeppllooyymmeenntt  CCoonnffiigguurraattiioonnss  

Prior to using the OFSAA Application perform the Post Deployment Configuration steps detailed 

in Appendix F. 
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66  OOrraaccllee  RReeccoonncciilliiaattiioonn  FFrraammeewwoorrkk  CCoonnffiigguurraattiioonn  

Following steps are to be followed for configuring Reconciliation Framework Analytics v8.0.0.0.0 

Dashboards and Reports after OBIEE installation (Server): 

 

A. Preliminary Installation of Software  

 

1. Make sure Oracle Business Intelligence (Version 11.1.1.7.1) installation is completed and 

available.  

2. If the OBIEE is installed in other than Windows environment, make sure that a standalone 

OBIEE Client is installed in a Windows environment. 

B. Modify Repository Connection Pool Settings  

For Windows Server 

 

1. Copy the Repository file from the $FIC_HOME/GLBI and place it in the Repository folder 

where OBIEE is installed.  

i.e.<OBIEE Install Folder>/instances/instance1/bifoundation/ 

OracleBIServerComponent/coreapplication_obis1/repository. 

2. Select Start > Programs > Oracle Business Intelligence > Administration. 

3. Select File > Open > Offline. 

4. Locate the OFS GL 8.0.rpd and open.  

5. Provide Repository password. The Repository password is 'weblogic123'  

Set the Connection Pool Properties 
6. In the "Physical" layer, under Database object double-click on the "Connection Pool" to 

update its properties.. 

7. In the ‘General’ tab, edit / check the following entries: 

8. Call Interface: Default (OCI 10g/11g) 

9. Update Data source name as give in the below example: 

For example: 

(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=<Database IP 

Address>)(PORT=<Port no>)))(CONNECT_DATA=(SID=<Database name>)))  

10.  Enter Database Schema user name in the User Name field. 

11. Enter Database Schema password in the Password field. 

12.  Click 'OK' to close the window and click 'Save' to save the RPD file. 
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13.  Click 'No' for the Global Consistency Message. 

14.  Close the RPD file (File / Exit).     

For Other Servers  

 

1. Copy the Repository file from the $FIC_HOME/GLBI and place it anywhere in the local 

Windows system. 

2. Open the BI Administration tool in the windows environment. 

3. Select Start > Programs > Oracle Business Intelligence Enterprise Edition Plus Client> 

Administration. 

4. Select File > Open > Offline. 

5. Locate the file OFS GL 8.0.rpd and open. 

6. Provide Repository password. The Repository password is 'weblogic123' 

Set the Connection Pool Properties as described above 6-14.  

 
C. Starting Node manager and WebLogic Servers 

 

1. Check if the Node Manager is running or not. If not then follow the below steps. 

For Windows Server 

 

1.1 Navigate to the services. 

1.2 Start the Service Oracle Weblogic NodeManager. 

 
Alternatively you can start Node Manager and all the managed services from the All 

Programs -> Oracle Business Intelligence-> Start BI Services option in the start menu. 
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For Other Servers  

 

1.1 Navigate to < OBIEE Install Folder >/ wlserver_10.3/server/bin folder. 

1.2 Run the following command: ‘nohup ./startNodeManager.sh &’. 

2. Check if the Weblogic AdminServer if running or not. If not then follow the below steps. 

For Windows Server 

 

2.1 Navigate to < OBIEE Install Folder >/user_projects/domains/bifoundation_domain/bin 

2.2 Run the following command: startWebLogic.cmd 

Note: The Weblogic Admin Server would have been already started if you had started 

through the, All Programs -> Oracle Business Intelligence-> Start BI Services option as 

stated above. 

 

For Other Servers  

 

2.1 Navigate to < OBIEE Install Folder >/user_projects/domains/bifoundation_domain/bin 

2.2 Run the following command: ‘./startWebLogic.sh’ 

2.3 Enter the weblogic credential defined during the installation. 

2.4 Bringing up this service may take a few minutes depending on your environment, wait 

until the command line stops scrolling and indicates server in RUNNING mode. 

 
3. Start Weblogic Managed Server (bi_server1) 

3.1 Log in to Fusion Middleware Control ‘ http://<hostserver name or IP>:<Port No Default is 

7001>/em’ using the weblogic credentials defined during installation. 

3.2 Under the WebLogic Domain expand the bifoundation_domain node in the navigation tree, 

and select bi_cluster. Select bi_cluster, and click the WebLogic Cluster menu to the right of it. 

Select the Control option from the menu, and select Start Up to start the Managed Servers. 

 



   

Oracle Financial Services Software Confidential - Restricted 

89 

 
 

3.3 Verify the status of the applications. 

 
 

D. Deployment 

 

1. Deploy RPD file.  

1.1 Log in to Fusion Middleware Control ’http://<hostserver name or IP>:<Port No Default is 

7001>/em’ using the weblogic credentials defined during installation. 

1.2 Go to Business Intelligence folder > coreapplication> Deployment and click on Lock and Edit 

Configuration.  

 



   

Oracle Financial Services Software Confidential - Restricted 

90 

 
 

1.3 In the Upload BI Server Repository click on Browse and locate the folder where the new OFS 

GL 8.0.RPD which has to be deployed is present.  

1.4 Now put the existing RPD Password. Then Apply > Activate Changes.  

1.5 You can see the new Default RPD as the OFSGL3_BI0008.0 

 
 

1.6 Restart the BI Server as mentioned in section E. 

1.7 Modify the NQSConfig.INI file to incorporate User Roles and Group Id changes in case any 

GUID related error occurs. The location is  

< OBIEE Install Folder> 

/instances/instance1/config/OracleBIServerComponent/coreapplication_obis1  

Change the FMW_UPDATE_ROLE_AND_USER_REF_GUIDS to YES. 

Example: FMW_UPDATE_ROLE_AND_USER_REF_GUIDS = YES; 

 

1.8 After modifying the file, restart the BI services again to remove the above error.  
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2. Deploy Web Catalog. 

2.1 Copy the GL_Recon_8.0.catolog file from $FIC_HOME/GLBI folder. 

2.2 Go to Business Intelligence folder > coreapplication> Deployment and check for the Catalog 

name. Change to GL then apply and activate changes. This will create a new empty catalog 

with the name given. 

Example: 

$ORACLE_INSTANCE/bifoundation/OracleBIPresentationServicesComponent/$COMPONE

NT_NAME/catalog/GL 

 

 
 

2.3 Go to Catalog Manager. Open the newly created catalog. File -> Open Catalog. 

2.4 Open the catalog offline -> Browse to the catalog path. Click OK.   

 
 

2.5 Now navigate to the /shared folder in the catalog manager and unarchive by selecting the 

path where the GL_Recon_8.0.catolog was present. Then press ok. 
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2.6 Verify that the GL folder appears under /shared folder. 
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2.7 Once the Unarchive is done.  Restart the BI Presentation Services(see section E) to apply 

the change.  

2.8 Modify the instanceconfig.xml file in case of any GUID error related to the BI Presentation 

Server to instruct Presentation Services to refresh GUIDs on restart.  

The location of instanceconfig.xml file is < OBIEE Install Folder> 

/instances/instance1/config/OracleBIPresentationServicesComponent/coreapplication_obips1 

Edit the file to add the line <UpdateAccountGUIDs>UpdateAndExit</UpdateAccountGUIDs> 

and restart the BI presentation services once again. 

2.9 Note that the steps mentioned above will force the BI Presentation Services to shut down 

after updating the Account GUIDS.  

In that case, go to instanceconfig.xml file and revert back the changes made i.e. remove the 

line <UpdateAccountGUIDs>UpdateAndExit</UpdateAccountGUIDs> from the 

instanceconfig.xml file and restart the services again.  

E. Starting the Analytics services  

 

The Oracle Business Intelligence system components can start in any of the following manner.  

 

1. Through OPMN controller 

For Windows Server 

 

1.1 Open a command prompt, navigate to <OBIEE Install Folder>/instances/instance1/bin 

1.2 Run the ‘opmnctl startall’ command. 

For Other Servers  

    

1.1 Navigate to < OBIEE Install Folder > /instances/instance1/bin  
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1.2 Run the command ‘. /opmnctl startall’ 

1.3 Check the status by running the command ‘. /opmnctl status’ 

 
  

2. Through Enterprise Manager 

2.1 Login to the EM administration screen using the url ’http://<hostserver name or IP>:<Port No 

Default is 7001>/em’ 

2.2 Expand 'Business Intelligence' node on the left and choose Core application. 

2.3 Navigate to Capacity management > Availability. 

2.4 Click on the necessary buttons to start and stop the services. 

  

 
 

3. In case of any problems check for the log files present in the respective diagnostic folders of 

analytics server that is, <OBIEE Install Folder>/instances/instance1/diagnostics/logs. 
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F. Testing the Analytics reports  

 

1 Log in to ‘http:// <host server name or IP>:<Port No default is 7001>/analytics/saw.dll?Dashboard’ 

using your Administrator credentials created during platform install. 

2 Check for the reports availability.  

In case of any problems, check for the log files present in the respective diagnostic folders of 

analytics server, that is, <OBIEE Install Folder>/instances/instance1/diagnostics/logs.
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77  AAppppeennddiixx  AA::  CCoonnffiigguurriinngg  WWeebb  SSeerrvveerr  

This appendix includes the following sections: 

 Configuring Web Server 

 Configuring Web Application Server 

77..11  CCoonnffiigguurriinngg  WWeebb  SSeerrvveerr  

This step assumes an installation of a Web Server exists as per the prerequisites. 

Refer the product specific Installation Guide/ Configuration Guide to install/ configure the Web 

Server. If an installation already exists, skip and proceed to the next step. 

NOTE:  Make a note of the IP Address/ Hostname and Port of the web server. This information is 

required during the installation process. 

 

Refer Oracle Financial Services Analytical Applications Infrastructure Security Guide mentioned in 

Documentation Library for OFSAAI 8.0.0.0.0 for additional information on securely configuring your 

Web Server. 

77..22  CCoonnffiigguurriinngg  WWeebb  AApppplliiccaattiioonn  SSeerrvveerr  

This step assumes an installation of a web application server exists as per the prerequisites. To 

configure the Web Application Server for OFSAA Deployment refer the sections below.  

This section includes the following topics: 

 Configuring WebSphere for Application Deployment 

 Configuring WebLogic for Application Deployment 

 Configuring Apache Tomcat Server for Application Deployment 

NOTE:  Make a note of the IP Address/ Hostname and Port of the web application server. This 

information is required during the installation process (required if Web Server is not configured). 

 

Refer OFSAA Secure Configuration Guide/ Security Guide mentioned in the Related Documents 

section for additional information on securely configuring your Web Server. 

http://docs.oracle.com/cd/E60058_01/homepage.htm
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77..22..11  CCoonnffiigguurriinngg  WWeebbSSpphheerree  AApppplliiccaattiioonn  SSeerrvveerr  ffoorr  AApppplliiccaattiioonn  DDeeppllooyymmeenntt  

You can deploy multiple OFSAA applications on different profiles of a WebSphere application 

server. To create multiple WebSphere "Profiles", in a stand-alone server use the command line 

option as explained below. A profile is the set of files that define the runtime environment. At least 

one profile must exist to run WebSphere Application Server. 

This section includes the following topics: 

 Creation of New Profile in WebSphere 

 Manage Applications in WebSphere 

 Delete WebSphere Profiles 

 WebSphere HTTPS Configuration 

 WebSphere Memory Settings 

7.2.1.1 CCrreeaattiioonn  ooff  NNeeww  PPrrooffiillee  iinn  WWeebbSSpphheerree  

The Profile is created in WebSphere through command line using the manageprofiles.sh which 

resides in <WebSphere Install directory>/AppServer/bin. 

The command to create a profile without admin security through command line is as follows: 

"manageprofiles.sh -create -profileName <profile> -profilePath 

<profile_path> -templatePath <template_path> -nodeName 

<node_name> -cellName <cell_name> -hostName <host_name>" 

Example: 

$usr/home>./manageprofiles.sh -create -profileName mockaix -

profilePath/websphere/webs64/Appserver/profiles/mockaix -

templatePath/websphere/webs64/Appserver/profileTemplates/default 

-nodeName ipa020dorNode04 - cellName ipa020dorNode04Cell -

hostName ipa020dor 

The command to create a profile with admin security through command line is as follows: 

"manageprofiles.sh -create -profileName <profile> -profilePath 

<profile_path> -templatePath <template_path> -nodeName <node_name> -

cellName <cell_name> -hostName <host_name> -enableAdminSecurity true -

adminUserName <Admin User Name> -adminPassword < Admin User Password> -

samplespassword <sample User Password>" 

Example: 

$usr/home>./manageprofiles.sh -create -profileName mockaix -

profilePath/websphere/webs64/Appserver/profiles/mockaix -

templatePath/websphere/webs64/Appserver/profileTemplates/default -

nodeName ipa020dorNode04 -cellName ipa020dorNode04Cell -hostName 
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ipa020dor -enableAdminSecurity true -adminUserName ofsaai -

adminPassword ofsaai -samplespassword ofsaai" 

NOTE:  While using the manageprofiles.sh command to create a New Profile in WebSphere, you can 

also use "-validatePorts" to validate if the specified ports are not reserved or in use. 

Additionally, you can specify new ports with "-startingPort <base port>" which specifies the 

starting port number to generate and assign all ports for the profile. For more information on 

using these ports, refer WebSphere manageprofiles command. 

7.2.1.2 MMaannaaggee  AApppplliiccaattiioonnss  iinn  WWeebbSSpphheerree  

To manage the installed applications in WebSphere, do the following: 

1. Open the administrator console using the following URL: 

http://<ipaddress>:<Administrative Console Port>/ibm/console 

Example: http://10.111.222.333:9003/ibm/console (https if SSL is enabled) 

NOTE:  Administrative Console Port value is available in serverindex.xml file within <WebSphere 

Profile Directory>/config/cells/<Node Cell>/nodes/<Node Name> directory. 

 

The Integrated Solutions Console Login window is displayed. 

 

Integrated Solutions Console Login 

2. Log on with the User ID provided with the admin rights. 
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3. From the LHS menu, expand the Applications > Application Type> WebSphere 

Enterprise Applications. 

4. The Enterprise Applications screen is displayed. 

 

Enterprise Applications 

5.  This Enterprise Applications screen helps you to: 

 Install new application 

 Uninstall existing applications 

 Start or Stop the installed applications 

7.2.1.3 DDeelleettee  WWeebbSSpphheerree  PPrrooffiilleess  

To delete a WebSphere profile, do the following: 

1. Select the checkbox adjacent to the required application and click Stop. 

2. Stop the WebSphere profile to be deleted. 

3. Navigate to WebSphere directory: 

4. <WebSphere_Installation_Directory>/AppServer/bin/ 

5. Execute the command: 

6. manageprofiles.sh -delete -profileName <profile_name> 

7. Delete profile folder. 

8. Example: <WebSphere_Installation_Directory>/AppServer/profiles/<profile_name> 

9. Execute the command: 

10. manageprofiles.sh –validateAndUpdateRegistry 
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7.2.1.4 WWeebbSSpphheerree  HHTTTTPPSS  CCoonnffiigguurraattiioonn  

Following are the steps for configuring an HTTPS Transport on WebSphere: 

1. Create a profile using the Profile Creation Wizard in WebSphere. 

2. Note down the https port specified during this process and use the same as servlet port 

or web server port during OFSAAI installation. 

To enable https configuration on Infrastructure, assign value 1 to "HTTPS_ENABLE" in 

OFSAAI_InstallConfig.xml for Silent mode OFSAAI installation.  

7.2.1.5 WWeebbSSpphheerree  MMeemmoorryy  SSeettttiinnggss  

To configure the WebSphere Memory Settings: 

1. Navigate to Websphere applications server > Application servers > server1 > Process 

definition > Java Virtual Machine. 

2. Change the memory setting for Java Heap: 

Initial heap size = 512 

Maximum heap size =3072 

77..22..22  CCoonnffiigguurriinngg  WWeebbLLooggiicc  ffoorr  AApppplliiccaattiioonn  DDeeppllooyymmeenntt  

Applicable only if the web container is WebLogic. 

You can deploy multiple Infrastructure applications on different domains of a stand-alone 

weblogic application server. To create multiple WebLogic "Domains" in a stand-alone server you 

can use the Domain Creation wizard. A domain is the set of files that define the runtime 

environment. At least one domain must exist to run WebLogic Application Server. 

NOTE:  For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and install 

patch 18729264. 

 

This section includes the following topics: 

 Creating Domain in WebLogic Server 

 Delete Domain in WebLogic 

 WebLogic Memory Settings 

7.2.2.1 CCrreeaattiinngg  DDoommaaiinn  iinn  WWeebbLLooggiicc  SSeerrvveerr  

To create a new domain using Configuration Wizard in WebLogic, do the following: 
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1. Navigate to the directory <WLS_HOME>/wlserver/common/bin and execute the 

command: 

.\config.sh 

The Welcome window of the Configuration Wizard is displayed. 

 

Welcome 

2. Select Create a new WebLogic domain option and click Next. 

The Select Domain Source window is displayed. 
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Select Domain Source 

3.  Select the Generate a domain configured automatically to support the following 

products option and click Next.  

4. The Specify Domain Name and Location window is displayed. 

 

Specify Domain Name and Location 
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5. Enter the Domain Name and Location. Click Browse to navigate and specify the 

location. Click Next. 

The Configure Administrator Username and Password window is displayed. 

 

Configure Administrator Username and Password 

6. Enter the User name and User password to be assigned to the Administrator. 

Ensure that the password is of minimum 8 characters in length. 

7. Re-enter the password for confirmation and add a brief Description. Click Next. 

The Configure Server Start Mode and JDK window is displayed. 
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Configure Server Start Mode and JDK 

8. Select the following options:  

In the WebLogic Domain Startup Mode section, select the required mode (Development 

Mode or Production Mode). 

In the JDK Selection section, select Other JDK. Click Browse and navigate to the JDK 

location. Click Next. 

The Select Optional Configuration window is displayed. 
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Select Optional Configuration 

9. Select Administration Server. A WebLogic Server domain must have an 

Administration Server. You can also select Manages Servers, Clusters and Machines 

and RDBMS Security Store if required. Click Next. 

The Configure the Administration Server window is displayed. 
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Configure the Administration Server 

10. Enter Administration Server details such as the Name, Listen address, Listen Port, 

SSL listen port, and SSL enabled (for secure login using https) check box. Click Next. 

The Configuration Summary window is displayed. 

NOTE:  Make a note of the Listen Port or SSL Listen Port value (ex: 7007), since the same has to be 

re-entered in the Servlet port field during Infrastructure installation. 
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Configure Server Start Mode and JDK 

11. Verify the configuration details of the WebLogic domain and click Create.  

12. The Creating Domain window is displayed with the status indication of the domain 

creation process. 
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Configure Server Start Mode and JDK 

13. Click Done when complete. The domain server is created enabling the deployment of 

multiple Infrastructure applications on a single WebLogic. 

Note: Note down the HTTPS port specified during this process and uses the same as servlet port or web 

server port during OFSAAI Installation. 

To enable https configuration on Infrastructure, assign value 1 to "HTTPS_ENABLE" in 

OFSAAI_InstallConfig.xml for silent mode OFSAAI installation 

14. Add a java option entry -DUseSunHttpHandler=true in WLS_HOME/bin/ 

"setDomainEnv.sh" file (Required only if self signed certificate is used). 

7.2.2.2 DDeelleettee  DDoommaaiinn  iinn  WWeebbLLooggiicc  

1. Navigate to the following directory: 

2. <WebLogic Installation directory>/user_projects/domains/<domain name>/bin 

3. Execute stopWebLogic.sh to stop the Weblogic domain. 

4. Delete the Weblogic domain. 

7.2.2.3 WWeebbLLooggiicc  MMeemmoorryy  SSeettttiinnggss  

To configure the WebLogic Memory Settings: 
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1. Change the memory setting for Java Heap to -Xms512m –Xmx3072m in 

setDomainEnv.sh file, which resides in the folder <DOMAIN_HOME>/bin and in 

CommEnv.sh file which resides in the folder common/bin. 

2. Edit this file for customizing memory settings and garbage collector settings 

depending on the available hardware configuration. 

3. Example 1: 

if [ "${JAVA_VENDOR}" = "Sun" ] ; then 

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m" 

export WLS_MEM_ARGS_64BIT 

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m" 

export WLS_MEM_ARGS_32BIT 

else 

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m" 

export WLS_MEM_ARGS_64BIT 

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m" 

export WLS_MEM_ARGS_32BIT 

Example 2: 

JAVA_VM= 

MEM_ARGS="-Xms256m -Xmx1024m" 

77..22..33  CCoonnffiigguurriinngg  AAppaacchhee  TToommccaatt  SSeerrvveerr  ffoorr  AApppplliiccaattiioonn  DDeeppllooyymmeenntt  

This section is applicable only when the Web Application Server type is Tomcat. 

This section includes the following topics: 

 Tomcat User Administration 

 Configure Tomcat to use JAVA 64 bit Executables 

 Configure Servlet Port 

 SSL Port Configuration 

 Apache Tomcat Memory Settings 

 Uninstalling WAR Files in Tomcat 

 Configuration for Axis API 
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7.2.3.1 TToommccaatt  UUsseerr  AAddmmiinniissttrraattiioonn  

The Tomcat administration and manager application does not provide a default login. You are 

required to edit "$CATALINA_HOME/conf/tomcat-users.xml" as instructed below. 

This file contains an XML tag <user> for each individual user, which will display the username 

and password used by admin to log on to Tomcat, and the role names to which the admin user is 

associated with. For example, <user name="admin" password="admin" 

roles="standard,manager"/> 

1. Add the manager role to any one of the existing username/password combination as 

shown in the example above. 

2. Use the same username/password to which the manager-gui role has been assigned 

to access the Tomcat Application Manager. 

3. If the Tomcat server is already running, it requires a re-start after the above 

configuration is done. 

7.2.3.2 CCoonnffiigguurree  TToommccaatt  ttoo  uussee  JJAAVVAA  6644  bbiitt  EExxeeccuuttaabblleess  

1. Navigate to the "$CATALINA_HOME/bin" folder. 

2. Edit the setclasspath.sh as explained below. 

3. Replace the following block of text: 

# Set standard commands for invoking Java. 

RUNJAVA="$JRE_HOME"/bin/java 

if [ "$os400" != "true" ]; then 

RUNJDB="$JAVA_HOME"/bin/jdb 

With: 

# Set standard commands for invoking Java. 

RUNJAVA="$JAVA_BIN"/java 

if [ "$os400" != "true" ]; then 

RUNJDB="$JAVA_BIN"/jdb 

4. If the Tomcat server is already running, it requires a re-start after the above 

configuration is done. 

NOTE:  In case tomcat is installed under different Unix profile, set JAVA_BIN environment variable in 

.profile to include the Java Runtime Environment absolute path. 

For example: 
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export JAVA_BIN /usr/java6_64/jre/bin 

export JAVA_BIN = /usr/java6_64/jre/bin//sparcv9 for Solaris Sparc 

7.2.3.3 CCoonnffiigguurree  SSeerrvvlleett  PPoorrtt  

The default servlet port configured for the Tomcat installation is 8080. Ignore this section if you 

need to use the default port. 

If you need to use a different port number, you must first configure the port in the "server.xml" in 

the "conf" directory of Tomcat Installation directory. The following steps guide you through the 

configuration process: 

1. Navigate to $CATALINA_HOME/conf. Open server.xml and locate the tag: 

"Define a non-SSL HTTP/1.1 Connector on port 8080 "  

2. Against this tag, a parameter is specified 'Connector port = "8080" '. Edit this value 

to the new port number that will be used during the installation process.  

3. Save your changes in "server.xml". 

NOTE:  Make a note of the servlet port configured. This information is required during the installation 

of OFSAA Application Pack. 

7.2.3.4 SSSSLL  PPoorrtt  CCoonnffiigguurraattiioonn  

If you need to configure and access your OFSAA setup for HTTPS access, ensure that the 

following connect tag under "Define a SSL HTTP/1/1 Connector on port 8443" in 

"<Tomcat_installation_folder>/conf/server.xml" file is uncommented for SSL Configuration. 

(By default, it is commented). 

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true" 

maxThreads="150" scheme="https" secure="true" 

clientAuth="false" sslProtocol="TLS" 

NOTE:  Make a note of the servlet port configured. This information would be required during the 

installation of OFSAA Application Pack. To enable https configuration on Infrastructure, assign 

value 1 to "HTTPS_ENABLE" in OFSAAI_InstallConfig.xml for SILENT mode OFSAAI 

installation. 

For more information related to SSL Configuration on Tomcat, refer to 

http://tomcat.apache.org/. 

7.2.3.5 AAppaacchhee  TToommccaatt  MMeemmoorryy  SSeettttiinnggss  

To configure the Apache Tomcat Memory Settings: 

http://tomcat.apache.org/
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1. Locate the file catalina.sh which resides in the folder <CATALINA_HOME>/bin. 

2. Edit this file for customizing the memory settings and garbage collector settings 

depending on the available hardware configuration. 

3. Add the memory setting for Java Heap to -Xms512m -Xmx1024m. 

4. Example: 

if [ -z "$LOGGING_MANAGER" ]; then 

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m 

-

Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager

" 

else 

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m $LOGGING_MANAGER" 

fi 

7.2.3.6 UUnniinnssttaalllliinngg  WWAARR  FFiilleess  iinn  TToommccaatt  

To uninstall WAR files in Tomcat refer Uninstalling WAR Files in Tomcat. 

7.2.3.7 CCoonnffiigguurraattiioonn  ffoorr  AAxxiiss  AAPPII  

This step is optional and required only if the web application server used in Apache 

Tomcat. If you use any other web application server, skip and proceed to next step. 

Copy the jaxrpc.jar from the <OFSAA Installation Directory>/axis-

1_4/webapps/axis/WEB-INF/lib and place it in under <Tomcat 

Installation Directory>/lib and restart the Tomcat Server 
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88  AAppppeennddiixx  BB::  CCoonnffiigguurriinngg  WWeebb  AApppplliiccaattiioonn  SSeerrvveerrss  

88..11  CCoonnffiigguurriinngg  RReessoouurrccee  RReeffeerreennccee  iinn  WWeebb  AApppplliiccaattiioonn  SSeerrvveerr  

This appendix includes the following topics: 

 Configure Resource Reference in WebSphere Application Server 

 Configure Resource Reference in WebLogic Application Server 

 Configure Resource Reference in Tomcat Application Server 

88..11..11  CCoonnffiigguurree  RReessoouurrccee  RReeffeerreennccee  iinn  WWeebbSSpphheerree  AApppplliiccaattiioonn  SSeerrvveerr  

This section is applicable only when the Web Application Server is WebSphere. 

This section includes the following topics: 

 Create JDBC Provider 

 Create Data Source 

 J2C Authentication Details 

 JDBC Connection Pooling 

8.1.1.1 CCrreeaattee  JJDDBBCC  PPrroovviiddeerr  

1. Open the WebSphere admin console in the browser window: 

http://<ipaddress>:<administrative console port>/ibm/console. (https if SSL is 

enabled). The Login window is displayed.  

2. Login with the user ID that has admin rights. 

3. Expand the Resources option in the LHS menu and click JDBC > JDBC Providers. The 

JDBC Providers window is displayed. 
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JDBC Providers 

4. Select the Scope from the drop-down list. Scope specifies the level at which the resource 

definition is visible. 

5. Click New to add new JDBC Provider under the Preferences section. The Create new 

JDBC provider window is displayed. 
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Create a new JDBC Provider 

6. Enter the following details: 

 Database Type - Oracle 

 Provider Type- Oracle JDBC Driver 

 Implementation Type- Connection pool data source 

 Name- The required display name for the resource 

 Description - The optional description for the resource 

7. Click Next.  
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Enter database class path information 

8. Specify the directory location for "ojdbc<version>.jar" file. Ensure that you do not use 

the trailing slash file separators.  

                            The Oracle JDBC driver can be downloaded from the following Oracle Download site: 

 Oracle Database 11g Release 2 (11.2.0.4) JDBC Drivers 

 Oracle Database 12c Release 1 (12.1.0.1) JDBC Drivers 

Once downloaded, you need to copy the file in the required folder on the server. 

NOTE:  Refer Appendix N for identifying the correct “ojdbc<version>.jar” version to be copied. 

9. Click Next. The Summary window is displayed. 

 

Summary 
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10. Verify the details and click Finish to create the JDBC Provider. 

11. The options to Save and Review are displayed. Click Save. 

8.1.1.2 CCrreeaattee  DDaattaa  SSoouurrccee  

The steps given below are applicable for both CONFIG and ATOMIC data source creation. 

1. Open this URL in the browser window: http://<ipaddress>:<administrative 

console port>/ibm/console. (https if SSL is enabled). The Login window is 

displayed. 

2. Login with the user ID that has admin rights. 

3. Expand the Resources option in the LHS menu and click JDBC > Data sources option. 

The Data sources page is displayed. 

 

Data Sources 

4. Select the Scope from the drop down list. Scope specifies the level at which the resource 

definition is visible. 

5. Click New. The Create a Data Source window is displayed. 
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Create a data source 

6. Specify the Data Source name and JNDI name for the new "Data Source". 

The JNDI and Data Source name are case sensitive. Ensure that JNDI name is same as 

the "Information Domain" name.  

7. Click Next. The Select JDBC provider window is displayed. 

 

Select JDBC provider 

8. Select the option Select an Existing JDBC Provider and select the required JDBC 

provider from the drop-down list. Click Next. 
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Enter database specific properties 

9. Specify the database connection URL. 

For Example: jdbc:oracle:thin:@<DB_SEREVER_IP>:<DB_SERVER_PORT>:<SID> 

10. Select Data Store Helper Class Name from the drop-down list and ensure that the 

checkbox Use this data source in container managed persistence (CMP) is selected.  

NOTE:  For RAC configuration, provide the RAC URL specified during installation 

 

For Example: 

jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=10

.11.12.13)(port=1521))(ADDRESS=(PROTOCOL=TCP)(HOST=10.11.12.14)(PORT=1521))(

LOAD_BALANCE=no)(FAILOVER=yes))(CONNECT_DATA=(SERVICE_NAME=pqadb))) 

11. Click Next. 

 

Setup security aliases 
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12. Map the J2C authentication alias, if already created. If not, you can create a new J2C 

authentication alias by accessing the link given (Global J2C authentication alias) or you 

can continue with the data source creation by clicking Next and then Finish. 

 

Summary 

You can also create and map J2C authentication alias after creating the data source. 

13. You must create another Data source by following the above procedure with 

jdbc/FICMASTER as JNDI name pointing to the "configuration schema" of Infrastructure. 

8.1.1.3 JJ22CC  AAuutthheennttiiccaattiioonn  DDeettaaiillss  

The steps given below are applicable for creating both config and atomic J2C Authentication. 

To create J2C Authentication details: 

1. Select the newly created Data Source and click JAAS - J2C authentication data link 

under Related Items.  
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JAAS- J2C authentication data 

2. Click New under the Preferences section. 

 

JAAS- J2C authentication data- New 

3. Enter the Alias, User ID, Password, and Description. Ensure the following: 

 User ID is the Oracle user ID created for the respective CONFIG and ATOMIC 

Schema for the “Information Domain”. 

 Specify the CONFIG database user ID and password information for the 

jdbc/FICMASTER data source, and specify the ATOMIC database user ID and 

password information for the ATOMIC schema data source that you created earlier. 
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4. Click Apply and save the details. 

8.1.1.4 JJDDBBCC  CCoonnnneeccttiioonn  PPoooolliinngg  

To define the JDBC connection pooling ensure that you have created JDBC Provider and Data 

source to access the data from the database. 

1. Expand the Resources option in the LHS menu and click JDBC > Data sources option. 

The Data sources page is displayed. 

2. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Data 

sources>$DATA_SOURCE$>Connection pools. 

 

Connection Pools 

3. Set the values for Connection timeout to 0 seconds, Maximum connections to 100 

connections, and Minimum connections to 10 connections as shown in the above 

figure. You can also define Reap Time, Unused Timeout, and Aged Timeout as 

required. 
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88..22  CCoonnffiigguurree  RReessoouurrccee  RReeffeerreennccee  iinn  WWeebbLLooggiicc  AApppplliiccaattiioonn  SSeerrvveerr  

This section is applicable only when the Web Application Server is WebLogic. 

This section includes the following topics: 

 Create Data Source 

 Create GridLink Data Source 

 Configure Multi Data Sources 

 Advanced Settings for Data Source 

 JDBC Connection Pooling 

In WebLogic, you can create "Data Source" in the following ways: 

 For a Non RAC Database instance, Generic Data Source has to be created. See Create 

Data Source. 

 For a RAC Database instance, Gridlink Data Source has to be created. See Create 

GridLink Data Source. 

 When Load Balancing/Fail over is required, Multi Data Source has to be created. See 

Configure Multi Data Sources. 

88..22..11  CCrreeaattee  DDaattaa  SSoouurrccee  

The steps given below are applicable for both config and atomic data source creation. 

1. Open WebLogic Admin Console in the browser window: 

http://<ipaddress>:<administrative console port>/console. (https if SSL is 

enabled). The Welcome window is displayed.  

2. Login with the Administrator Username and Password.  
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Welcome 

3. From the LHS menu (Domain Structure), click Services > Data Sources. The Summary 

of JDBC Data Sources window is displayed. 

 

Summary of JDBC Data Sources 

4. Click New and select Generic Data Source option. The Create a New JDBC Data 

Source window is displayed. 

You can also select GridLink Data Source or Multi Data Source while creating a Data 

Source. For more information, see Error! Reference source not found.or Error! 

Reference source not found.. 
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Create a New JDBC Data Source 

5. Enter JDBC data source Name, JNDI Name, and select the Database Type from the 

drop-down list. Click Next. 

Ensure the following: 

 The JNDI Name field should be in the format "jdbc/informationdomain" 

 Same steps needs to be followed to create a mandatory data source pointing to the 

"configuration schema" of infrastructure with jdbc/FICMASTER as JNDI name.  

 JNDI Name is the same as mentioned in web.xml file of OFSAAI Application. 

 Required "Database Type" and "Database Driver" should be selected. 

 

JDBC Data Source Properties 

6. Select the Database Driver from the drop-down list. You need to select the Database 

Driver depending on database setup, that is, with or without RAC. Click Next. 
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Transaction Options 

7. Select the Supports Global Transactions checkbox and the One-Phase Commit option. 

8. Click Next. The Connection Properties window is displayed. 

 

Connection Properties 

9. Enter the required details such as the Database Name, Host Name, Port, Oracle User 

Name, and Password.  

10. Click Next. The Test Database Connection window is displayed. 
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Test Database Connection 

11. Verify the details and click Test Configuration and test the configuration settings. 

A confirmation message is displayed stating "Connection test succeeded." 

12. Click Finish. The created "Data Source" is displayed in the list of Data Sources. 

NOTE:  "User ID" is the Oracle user ID that is created for the respective CONFIG and ATOMIC 

schema of the respective "Information Domain". 

 

"User ID" to be specified for data source with "FICMASTER" as "JNDI" name should be the Oracle 

user ID created for the CONFIG schema. 
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13. Select the new Data Source and click the Targets tab.  

 

Select Targets 

14. Select the AdminServer option and click Finish. 

88..22..22  CCrreeaattee  GGrriiddLLiinnkk  DDaattaa  SSoouurrccee  

If you have selected the option, New > GridLink Data Source while creating the "Data Source", 

you can directly specify the JDBC URL as indicated. 

 

Create a New JDBC GridLinkData Source 

1. Enter Data Source Name, and JNDI Name. 

Ensure that the "JNDI Name" field is specified in the format "jdbc/infodomname" and the 

XA Driver checkbox is not selected. Click Next. 
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JDBC GridLinkData Source- Connection Properties 

2. Specify Complete JDBC URL, Database User Name, and Password. Click Finish. The 

created "Data Source" is displayed in the list of Data Sources. 

88..22..33  CCoonnffiigguurree  MMuullttii  DDaattaa  SSoouurrcceess  

A JDBC multi data source is an abstraction around a group of data sources that provides load 

balancing and failover between data sources. As with data sources, multi data sources are also 

bound to the JNDI tree. Applications can look up a multi data source on the JNDI tree and then 

reserve a database connection from a data source. The multi data source determines from which 

data source to provide the connection. 

When the database used is Oracle RAC (Real Application Clusters) which allows Oracle 

Database to run across a set of clustered servers, then group of data sources can be created for 

instances running on a set of clustered servers and a JDBC multi data source can be created so 

that applications can look up a multi data source on the JNDI tree to reserve database 

connection. If a clustered server fails, Oracle continues running on the remaining servers. 

1. Open WebLogic Admin Console in the browser window: 

http://<ipaddress>:<administrative console port>/console. (https if SSL is 

enabled). The Login window is displayed.  

2. Login with the "User ID" that has admin rights. 

3. In the LHS menu (Domain Structure), select Services > JDBC > Multi Data Sources. 

The Summary of JDBC Multi Data Sources window is displayed.  
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Summary of JDBC Multi Data Sources 

4. Click New. The New JDBC Multi Data Source screen is displayed. 

NOTE:  Ensure that the Data Sources which needs to be added to new JDBC Multi Data Source has 

been created. 

 

Configure the Multi Data Source 

5.  Enter the JDBC Source Name, JNDI name, and select the Algorithm Type from the 

drop-down list. Click Next. 

Note: 

 The JNDI Name has to be specified in the format jdbc/infodomname.  

 JNDI Name of the Data Sources that will be added to new JDBC Multi data source should 

be different from the JNDI name specified during Multi Data Source.  

Same steps needs to be followed to create a mandatory data source pointing to the 

"configuration schema" of infrastructure with jdbc/FICMASTER as JNDI name for Data 

Source.  
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 Same steps needs to be followed to create a mandatory data source pointing to the 

"configuration schema" of infrastructure with jdbc/FICMASTER as JNDI name for Data 

Source. 

 JNDI Name provided in multi data source should be the same name that will be mentioned 

in the web.xml file of OFSAAI Application. 

 You can select the Algorithm Type as Load-Balancing. 

 

Select Targets 

6. Select the AdminServer check box and click Next. 

 

Select Data Source Type 

7.  Select the type of data source which will be added to new JDBC Multi Data Source. 

Click Next. 

 

Add Data Sources 

8.  Map the required Data Source from the Available Data Sources. Click Finish. 



  Appendix  

Oracle Financial Services Software Confidential - Restricted 

133 

The New JDBC Multi Data Source is created with added data sources. 

88..22..44  AAddvvaanncceedd  SSeettttiinnggss  ffoorr  DDaattaa  SSoouurrccee  

1. Click the new Data Source fromt the Summary of JDBC Data Sources window. The 

Settings for <Data Source Name> window is displayed. 

2. Select the Connection Pooling tab given under Configuration. 

3. Go to the Advanced option at the bottom of the page, and check the Test Connection 

of Reserve checkbox (Enables Weblogic Server to test a connection before giving it to a 

client). 

4. To verify if the data source is valid, select "Data Source name". For example, 

FICMASTER. 

 

Settings for <Data Source Name> 

5. Select the server and click Test Data Source. 

6. A message is displayed indicating that the test was successful. 

7.  Once the "Data Source" is created successfully, the following messages are displayed: 

 All changes have been activated. No restart is necessary. 

 Settings updated successfully.  

If not, follow the steps given above to recreate the data source.  

88..22..55  JJDDBBCC  CCoonnnneeccttiioonn  PPoooolliinngg  

To define the JDBC connection pooling, ensure that you have created JDBC Provider and Data 

source to access the data from the database. 
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1. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Home 

>Summary of Services: JDBC >Summary of JDBC Data Sources >JDBC Data Source-

<INFODDOM_NAME> 

2. Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity Increment 

by 1, Statement Cache Type to LRU, and Statement Cache Size to 10. 

3.  Click Save. 

88..33  CCoonnffiigguurree  RReessoouurrccee  RReeffeerreennccee  iinn  TToommccaatt  AApppplliiccaattiioonn  SSeerrvveerr  

This section is applicable only when the Web Application Server is Tomcat. 

This section includes the following topics: 

 Create Data Source 

 JDBC Connection Pooling 

 Class loader configuration for Apache Tomcat 

Copy the Oracle JDBC driver file, "ojdbc<version>.jar" from <Oracle Home>/jdbc/lib and place it 

in <Tomcat Home>/lib. 

NOTE:  Refer Appendix N for identifying the correct ojdbc<version>.jar version to be copied. 

88..33..11  CCrreeaattee  DDaattaa  SSoouurrccee  

To create "data source" for OFSAA application, navigate to <Tomcat Home>/conf and edit the 

following block of text by replacing the actual values in server.xml. 

NOTE:  The User-IDs for configuration/ atomic schemas have the prefix of SETUPINFO NAME 

depending on the value set for PREFIX_SCHEMA_NAME in <<APP 

Pack>>_SCHEMA_IN.XML file of Schema Creator Utility. For example:  if the value set for 

SETUPINFO NAME is DEV and PREFIX_SCHEMA_NAME is Y and the schema name was 

mentioned as ofsaaconf, then the actual schema created in the database would be 

DEV_ofsaaconf. 

<Context path ="/<context name>" docBase="<Tomcat Installation 

Directory>/webapps/<context name>" debug="0" reloadable="true" 

crossContext="true"> 

<Resource auth="Container"  

name="jdbc/FICMASTER" 

type="javax.sql.DataSource" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

username="<user id for the configuration schema>"  

password="<password for the above user id>"  
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url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>" 

maxActive="100"  

maxIdle="30" 

maxWait="10000"/> 

<Resource auth="Container" 

name="jdbc/< INFORMATION DOMAIN NAME >" 

type="javax.sql.DataSource" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

username="<user id for the atomic schema>" 

password="<password for the above user id>" 

url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>" 

maxActive="100" 

maxIdle="30" 

maxWait="10000"/> 

</Context> 

NOTE:  The <Resource> tag must be repeated for each Information Domain created. 

After the above configuration, the "WAR" file has to be created and deployed in Tomcat. 

88..33..22  JJDDBBCC  CCoonnnneeccttiioonn  PPoooolliinngg  

To define the JDBC connection pooling, do the following: 

1. Copy $ORACLE_HOME/jdbc/lib/ojdbc<version>.jar to the path 

$TOMCAT_DIRECTORY/lib/. 

NOTE:  Refer Appendix N for identifying the correct “ojdbc<version>.jar” version to be copied. 

2. Edit the server.xml present under the path $TOMCAT_DIRECTORY/conf/ with the below 

changes, which is required for connection pooling. 

<Context path="/ $CONTEXTNAME$" docBase=" $APP_DEPLOYED_PATH$ " 

debug="0" reloadable="true" crossContext="true"> 

<Resource auth="Container" 

name="jdbc/ $INFODOM_NAME$" 

type="javax.sql.DataSource" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

username=" $ATOMICSCHEMA_USERNAME$" 

password="$ATOMICSCHEMA_PASSWORD$" 

url="$JDBC_CONNECTION_URL" 
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maxActive="100" 

maxIdle="30" 

maxWait="10000" 

removeAbandoned="true" removeAbandonedTimeout="60" 

logAbandoned="true"/> 

</Context> 

Note the following: 

 $APP_DEPLOYED_PATH$ should be replaced by OFSAAI application deployed 

path.$INFODOM_NAME$ should be replaced by Infodom Name. 

 $ATOMICSCHEMA_USERNAME$ should be replaced by Atomic schema database user 

name. 

 $ATOMICSCHEMA_PASSWORD$ should be replaced by Atomic schema database 

password. 

 $JDBC_CONNECTION_URL should be replaced by JDBC connection string 

jdbc:Oracle:thin:<IP>:<PORT>:<SID>. For example, jdbc:oracle:thin 

10.80.50.53:1521:soluint 

 The User-IDs for configuration/ atomic schemas have the prefix of setupinfo depending on 

the value set for PREFIX_SCHEMA_NAME in <<APP Pack>>_SCHEMA_IN.XML file of 

Schema Creator Utility. 

 For example: if the value set for PREFIX_SCHEMA_NAME is DEV and the schema name 

was mentioned as ofsaaconf, then the actual schema created in the database would be 

DEV_ofsaaconf. 

88..33..33  CCllaassss  llooaaddeerr  ccoonnffiigguurraattiioonn  ffoorr  AAppaacchhee  TToommccaatt  

1. Edit the server.xml available in $TOMCAT_HOME/conf/ folder. 

2. Add tag <Loader delegate="true" /> within the <Context> tag, above the 

<Resource> tag. This is applicable only when the web application server is Apache 

Tomcat 8. 

NOTE:  This configuration is required if Apache Tomcat version is 8. 
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99  AAppppeennddiixx  CC::  CCrreeaattiinngg  aanndd  DDeeppllooyyiinngg  EEAARR//  WWAARR  FFiillee  

99..11  CCrreeaattiinngg  aanndd  DDeeppllooyyiinngg  EEAARR//WWAARR  FFiillee  

This appendix includes the following topics: 

 Creating EAR/WAR File 

 Deploying EAR/WAR File 

99..11..11  CCrreeaattiinngg  EEAARR//WWAARR  FFiillee  

To create EAR/WAR File, follow these steps: 

1. Navigate to the $FIC_WEB_HOME directory on the OFSAA Installed server. 

2. Execute  ./ant.sh to trigger the creation of EAR/ WAR file.  

3. On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time taken" 

message is displayed and you will be returned to the prompt. 

 

4. The EAR/ WAR file - <contextname>.ear/ .war - is created.  

NOTE:  The <contextname> is the name given during installation.  

This process overwrites any existing version of EAR file that exists in the path. 

In case of OFSAA configured onTomcat installation, <contextname>.war will be created. 
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99..11..22  DDeeppllooyyiinngg  EEAARR//WWAARR  FFiillee  

This section includes the following topics: 

 Deploying WebSphere EAR/WAR Files 

 Deploying WebLogic EAR/WAR Files  

 Deploying Tomcat WAR Files 

NOTE:  Ensure to clear the application cache prior to the deployment of Application Pack Web 

Archive. This is applicable to all Web Servers (WebSphere, WebLogic, and Tomcat). For more 

information, refer Clearing Application Cache section. 

9.1.2.1 DDeeppllooyyiinngg  EEAARR//WWAARR  FFiilleess  oonn  WWeebbSSpphheerree  

To deploy WebSphere EAR/WAR File, follow these steps: 

1. Start WebSphere Profile by navigating to the path 

"/<Websphere_Installation_Directory>/IBM/WebSphere/AppServer/profiles/<Profile_Nam

e>/bin/" and execute the command: 

./startServer.sh server1 

2. Open the following URL in the browser: http://<ipaddress>:<Administrative 

Console Port>/ibm/console. (https if SSL is enabled). The login screen is displayed.  
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Login Window 

3. Enter the user credentials with admin privileges and click Log In. 

4. From the LHS menu, select Applications and click New Application. The New 

Application window is displayed. 

 

New Application 

5. Click New Enterprise Application. The Preparing for the application installation 

window is displayed.  
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Preparing for the application installation 

6. Select Remote File System and click Browse. Select the EAR file generated for 

OFSAA to upload and install. Click Next.  

 

Installation Options 

7. Select the Fast Path option and click Next. The Install New Application window is 

displayed. 
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Install New Application 

8. Enter the required information and click Next. The Map Modules to Servers window is 

displayed. 
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Map Modules to Servers 

9.  Select the Web Application and click Next. The Map Resource References to 

Resources window is displayed. 

 

Map Resource References to Resources 

10. Map each resource defined in the application to a resource JNDI name defined earlier. 

11. Click Modify Resource Authentication Method and specify the authentication method 

created earlier. 

12. You can specify "config" for FICMASTER resource or "atomic" for atomic resource as 

the authentication method. 
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13. Select the OFSAAI Web Application check box and click Next. The Map Virtual hosts 

for Web Modules window is displayed. 

 

Map Virtual host for Web Modules 

14. Select the Web Application check box and click Next. The Summary page is 

displayed. 
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Summary 

15. Click Finish and deploy the Infrastructure Application on WebSphere. 

16. On successful installation, a message is displayed. Click Save and save the master file 

configuration. The details are displayed in the Master File Configuration window. 

To start the application 

1. Expand Applications > Application Type > WebSphere enterprise applications. The 

Enterprise Applications window is displayed. 
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Enterprise Applications 

2. Select the installed application and click Start. 

NOTE:  <profile name> is the profile name given while creating the WebSphere profile. 

<cell name > is the cell name given during profile creation  

<contextname> is the context name given during installation. 

9.1.2.2 DDeeppllooyyiinngg  WWAARR  FFiillee  oonn  WWeebbLLooggiicc  

Following are the steps for deploying Infrastructure application that would be created during 

installation: 

1. Navigate to the path <WebLogic Installation 

directory>/user_projects/domains/<domain name>/bin in the machine in 

which WebLogic is installed. 

2. Start WebLogic by executing the command: 

./startWebLogic.sh -d64 file 

3. Open the URL in the browser window: http://<ipaddress>:<admin server port>/console. 

(https if SSL is enabled). The Sign in window of the WebLogic Server Administration 

Console is displayed. 

NOTE:  Ensure that you have started Infrastructure Server by executing “./reveleusstartup.sh" 

as mentioned in Start Infrastructure section 

 

4. Log on to the WebLogic Server by entering the user credentials having privileges to 

deploy the EAR file. 
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5. From the Domain Structure LHS menu, click Deployments. The Summary of 

Deployments window is displayed. 

 

Summary of Deployments 

6. Click Install. The Install Application Assistant window is displayed. 

7. Select the Exploded EAR directory after browsing to the directory where it is saved and 

click Next. 

EExxppllooddee  EEAARR  

To explode EAR, follow the below steps: 

1. Create the "applications" folder under domain name. For example, 

/Bea/user_projects/domains/ <Domain _name>/applications. 

2. Create <context_name>.ear folder under "applications" folder.  

3. Copy the <$FIC_WEB_HOME/<context_name>.ear file to 

<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/a

pplications/<context_ name>.ear. 

4. Explode the <context_name>.ear file by executing the command: 

jar -xvf <context_name>.ear 

5. Delete the <context>.ear and < context >.war files (recently created) 

<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_ 

NAME>/applications/<context_name>.ear. 

6. Create a directory <context_name>.war under <WEBLOGIC_INSTALL_ 
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DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<conte

xt_ name>.ear 

7. Copy <$FIC_WEB_HOME/<context_name>.war file to <WEBLOGIC_INSTALL_ 

DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<conte

xt_ name>.ear/<context_name>.war. 

8. Explode the <context_name>.war file by executing the following command to get 

the directory structure: 

jar -xvf <context_name>.war 

IInnssttaallll  AApppplliiccaattiioonn  

To install Application:  

1. Open the Install Application Assistant.  

 

Install Application Assistant 

2. Click Next.  

 

Install Application Assistant 

3. From the Choose targeting style section, select the Install this deployment as an 

application option and click Next. The Optional Settings window is displayed. 
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Optional Settings 

4. Enter a Name for the deployment if required. 

5. Under the Security section, select the DD only option to specify that only roles and 

policies that are defined in the deployment descriptors should be used. 

6. Select the I will make the deployment available from the following location option 

under the Source accessibility section.  

7. Click Next to continue. The Deployment Summary window is displayed. 
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Deployment Summary 

8. Select the Yes, take me to the deployment's configuration screen option and click 

Finish. The Settings for <Deployment Name> window is displayed. 
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Settings for <Deployment Name> 

9. Review the general configuration details of the deployment. You can also update the 

configuration of the deployment in this window. In the Overview tab you can view the 

complete deployment configuration. 

10. Click Save to update the changes, if any. 

11. From the LHS menu, click Deployments. The Summary of Deployments window is 

displayed. 
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Summary of Deployments 

12. Select the newly deployed Infrastructure application and click Start > Servicing all 

requests. Ensure that the Infrastructure server is up and running. 

 

Summary of Deployments 

13. The State of the deployed application is displayed as Active if started successfully. 

9.1.2.3 DDeeppllooyyiinngg  WWAARR  FFiilleess  oonn  TToommccaatt  

Before deploying the WAR files, ensure that the previously deployed applications of Infrastructure 

are uninstalled. See Uninstalling Previously Deployed WAR Files in Tomcat for the procedure to 

uninstall the previously deployed Infrastructure war files. 

On the machine that hosts Tomcat, follow the below steps outlined to deploy Infrastructure 

application: 

1. Copy the <context-name>.war from $FIC_WEB_HOME/<context-name.war> to 

<Tomcat Installation Directory>/webapps/ directory.  
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2. Click Manager App. The Connect to dialog box is displayed.  

3. Enter the User Id and Password that has admin rights and click OK. (For user creation 

in tomcat, see Tomcat User Administration. The Tomcat Web Application Manager 

window is displayed with the list of all the applications deployed. 

 

4. In the Deploy section, enter the Context Path provided during the installation as 

"/<context-name>".  
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5. Enter the path where the <context-name>.war file resides (by default "$FIC_WEB_ 

HOME/<context-name>.war") in the WAR or Directory URL field and click Deploy.  

6. On successful application deployment, a confirmation message is displayed. Start the 

Tomcat server. Refer Starting Web Application Servers for more details. 
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1100  AAppppeennddiixx  DD::  SSttaarrttiinngg  //  SSttooppppiinngg  SSeerrvviicceess    

1100..11  SSttaarrtt//SSttoopp  OOFFSSAAAA  IInnffrraassttrruuccttuurree  SSeerrvviicceess  

This chapter details on how to start and stop OFSAA Infrastructure services. This chapter 

includes the following sections: 

 Starting Infrastructure services 

 Starting Web Application Servers 

 Stopping Infrastructure Services 

 Stopping Web Application Servers 

1100..11..11  SSttaarrttiinngg  IInnffrraassttrruuccttuurree  SSeerrvviicceess  

Once the installation of Infrastructure has been completed successfully and the post-installation 

steps are completed, the servers must be started. Log on to each machine and run the .profile 

file. All servers mentioned must be started from the same shell encoding. The servers mentioned 

below are dependent on each other. It is mandatory to maintain the order in which the servers are 

started. Allow each of the servers to initialize completely before starting the next server. 

1. On the machine in which Infrastructure Application components have been installed, 

navigate to $FIC_APP_HOME/common/FICServer/bin and execute the following command 

to start the Infrastructure Server. 

./startofsaai.sh 

NOTE:  You can also start the Infrastructure Server by executing the command "nohup ./ 

startofsaai.sh &". Starting the process using "nohup" and "&" will return the command prompt 

without having to wait till the process completes. However, this command cannot be used 

when you are starting the server for the first time or starting after changing user password in 

the configuration database schema.You can also start the Infrastructure Server by executing 

the command "nohup ./ startofsaai.sh &". Starting the process using "nohup" and "&" will 

return the command prompt without having to wait till the process completes. However, this 

command cannot be used when you are starting the server after changing the 

CONFIGURATION schema user password  in the configuration database schema. 

Select the required webserver start up option from the table. 

Start up Option Description 

Starting WebSphere profile On the machine in which Web sphere is installed, navigate to 

[Webshpere_Install_Directory] /AppServer/<profiles>/<profile 

name>/bin and execute the command: ./startServer.sh server1. 
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Start up Option Description 

Starting WebLogic Domain On the machine in which WebLogic is installed navigate to <WebLogic 

Installation directory>/user_projects/domains/<domain 

name>/bin and execute the command: startWebLogic.sh -d64. 

Note: If WebLogic is already running, access the WebLogic Admin 

Console. Stop and start the application <context name>.ear. 

Starting Tomcat Application On the machine in which Tomcat is installed, navigate to 

<Tomcat_Install_ Directory>/bin and execute the command: 

./catalina.sh run 

2. Start ICC server: 

 On the machine in which Infrastructure default Application components have been 

installed, navigate to $FIC_HOME/ficapp/icc/bin and execute the command. 

./iccserver.sh 

NOTE:  Only Infrastructure Default Application Server would hold ICC component. 

 

3. To start Back-end Services: 

 On the machine on which Infrastructure Database components have been 

installed, navigate to $FIC_DB_HOME/bin and execute the command to start 

"Agent server": 

./agentstartup.sh  

Or 

 Start Back-end services using the command: 

nohup ./agentstartup.sh & 

NOTE:  This agent internally starts the Router, Message Server, OLAP data server and AM services. 

1100..11..22  SSttaarrttiinngg  WWeebb  AApppplliiccaattiioonn  SSeerrvveerrss  

Start the Web Application Server depending on the type from the following table. 

Start up Option Description 
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Start up Option Description 

Starting WebSphere profile On the machine in which Web sphere is installed, navigate to 

[Webshpere_Install_Directory] /AppServer/<profiles>/<profile 

name>/bin and execute the command: ./startServer.sh server1. 

Starting WebLogic Domain On the machine in which WebLogic is installed navigate to <WebLogic 

Installation directory>/user_projects/domains/<domain 

name>/bin and execute the command: startWebLogic.sh -d64. 

Note: If WebLogic is already running, access the WebLogic Admin 

Console. Stop and start the application <context name>.ear. 

Starting Tomcat Application On the machine in which Tomcat is installed, navigate to 

<Tomcat_Install_ Directory>/bin and execute the command: 

./catalina.sh run 

1100..11..33  SSttooppppiinngg  IInnffrraassttrruuccttuurree  SSeerrvviicceess  

To stop Infrastructure services: 

1. On the machine in which Infrastructure Application components have been installed, 

navigate to $FIC_APP_HOME/common/FICServer/bin and execute the command: 

./stopofsaai.sh 

2. To stop ICC server, on the machine in which Infrastructure default Application 

components have been installed, navigate to $FIC_HOME/ficapp/icc/bin and 

execute the command: 

./iccservershutdown.sh 

NOTE:  Only Infrastructure Default Application Server would hold ICC component. 

 

3. To stop Back-end server, on the machine in which Infrastructure database 

components have been installed, navigate to $FIC_DB_HOME/bin and execute the 

command: 

./agentshutdown.sh 

1100..11..44  SSttooppppiinngg  WWeebb  AApppplliiccaattiioonn  SSeerrvveerrss  

Stop the Web Application Server depending on the type from the following table. 

Stop Option Description 
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Stop Option Description 

Stopping WebSphere profile On the machine in which Web sphere is installed, navigate to 

[Webshpere_Install_Directory] /AppServer/<profiles>/<profile 

name>/bin and execute the command: ./stopServer.sh server1. 

Stopping WebLogic Domain On the machine in which WebLogic is installed navigate to <WebLogic 

Installation directory>/user_projects/domains/<domain 

name>/bin and execute the command: startWebLogic.sh -d64. 

Note: If WebLogic is already running, access the WebLogic Admin 

Console. Stop the application <context name>.ear. 

Stopping Tomcat Application On the machine in which Tomcat is installed, navigate to 

<Tomcat_Install_ Directory>/bin and execute the command: 

./shutdown.sh 
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1111  AAppppeennddiixx  EE::  AAcccceessssiinngg  OOFFSSAAAA  AApppplliiccaattiioonn  

This appendix gives details the steps to be performed to access OFSAA Application. 

1111..11  AAcccceessss  tthhee  OOFFSSAAAA  AApppplliiccaattiioonn  

1. From a your desktop, open the browser and enter the URL in below format:  

<scheme>://<IP address/ hostname>:<port>/<context-

name>/login.jsp 

For example, https://111.222.333.444:5555/ofsaa/login.jsp 

The OFSAA login window is displayed as below: 

 

 

OFSAA Login window 

2. With installation of every OFSAA Application Pack, there are two seeded user profiles 

configured in the system: 

 SYSADMN – System Administrator 

 SYSAUTH – System Authorizer 
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3. Login to the application using the "SYSADMN" User ID. (Note that, there is no "I" in 

the SYSADMN login USER ID). Enter the password that was provided during 

installation. On the first login, you will be prompted to change the password. 

Once you have logged into the Infrastructure system, you need to perform the following additional 

configurations to setup the OFSAAI environment: 

 Define Server Details for Database, Application and Web servers.  

 Add Database Details.  

 Create an Information Domain.  

 Create a Segment.  

 Create / Add User with access to all permissions. 

Note: 

Each new file that is created in the ftpshare folder of any installation layer should be 

granted specific / explicit permission. If you encounter any problems during setup, please 

contact Infrastructure Support. 

 

1111..11..11  OOFFSSAAAAII  LLooggiinn  

While accessing Oracle Financial Services Analytical Applications Infrastructure, the Splash 

screen is as displayed: 
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You can select the required language from the Language drop-down list. The language options 

displayed in the drop down are based on the license. Based on the selection of Language, the 

appropriate language login screen is displayed. 

Enter the User ID and Password provided by the System Administrator and click Login. You will 

be prompted to change your password on your first login. Alternatively, you can also choose to 

change your password any time. 

 

 

In the Change Password screen, enter a new password, confirm it and click OK to view the 

Splash screen. Refer to the following guidelines for Password Creation: 

 Passwords are displayed as asterisks (stars) while you enter. This is to ensure that the 

password is not revealed to other users. 

 Ensure that the entered password is at least six characters long. 

 The password must be alphanumeric with a combination of numbers and characters. 

 The password should not contain spaces. 

 Passwords are case sensitive and ensure that the Caps Lock is not turned ON. 

 By default the currently used password is checked for validity if password history is not 

set. 

 New password should be different from previously used passwords based on the 

password history which can be configured. 

 If you encounter any of the following problems, contact the System Administrator: 

o Your user ID and password are not recognized. 
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o Your user ID is locked after three consecutive unsuccessful attempts. 

o Your user ID has been disabled. 

o Guest user cannot change the password. 
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1122  AAppppeennddiixx  FF::  PPoosstt  DDeeppllooyymmeenntt  CCoonnffiigguurraattiioonnss  

1122..11  PPoosstt  DDeeppllooyymmeenntt  CCoonnffiigguurraattiioonn  

This chapter covers the following topics: 

 Deploying the Application 

 Logging as System Administrator 

 Creating Application Users 

 Mapping Application User(s) to User Group 

1122..22  DDeeppllooyyiinngg  tthhee  AApppplliiccaattiioonn  

This section explains steps to deploy the application. Web Layer deployment is required, For 

more information refer, Appendix A. 

1122..33  LLooggggiinngg  aass  SSyysstteemm  AAddmmiinniissttrraattoorr  

Post installation, the first login into Infrastructure is possible only for a System Administrator 

through user id “sysadmn”. This ID is created at the time of installation with the password 

provided during installation. Enter login id “sysadmn” and password that was provided during 

installation. Click Login.  

1122..44  CCrreeaattiinngg  AApppplliiccaattiioonn  UUsseerrss  

User Maintenance facilitates you to create user definitions, view, manage, modify, and delete 

user information. You can access User Maintenance by expanding User Administrator section 

within the tree structure of LHS menu. 

The User Maintenance screen displays user details such as User ID, Name, Profile Name, Start 

and End dates. You can also identify the user status if enabled to access the Infrastructure 

system. 

To add a user in the User Maintenance screen: 

1. Select add button from the User Maintenance tool bar. Add button is disabled if you have 

selected any User ID in the grid. The New User screen is displayed. 
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2. Enter the user details as tabulated. 

Field Description 

Fields marked in red asterisk (*) are mandatory.  

User ID  Enter a unique user id. Ensure that there are no special characters and extra spaces in the id 
entered.  

User Name  Enter the user name. The user name specified here will be displayed on the Infrastructure 
splash screen. Ensure that the User Name does not contain any special characters or spaces 
except ”–“, “’”. and “.”.  

Contact Address  Enter the contact address of the user. It can be the physical location from where the user is 
accessing the system. Ensure that Contact Address does not contain any special characters 
except ".", "#", "-", ",".  

Date Of Birth  Specify the date of birth. You can use the popup calendar to enter the date.  

Designation  Enter the user designation. Ensure that Designation does not contain any special characters 
except “_, “:” and "-".  

Profile Name  Select the profile name by clicking on the drop down list.  

User Start Date  Specify the user start date based on the day slot the user is enabled to access the system. 
Ensure that User Start Date is greater than today’s date. You can use the popup calendar to 
enter the date.  

User End Date  Specify the user end date based on month and year when the user Id expires. Ensure that user 
End Date is greater than User Start Date. You can use the popup calendar to enter the date.  
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Password  Enter the default password for the user for the initial login. User needs to change the default 
password during the first login.  

A user is denied access in case the user has forgotten the password or enters the wrong 
password for the specified number of attempts (as defined in the Configuration screen). To 
enable access, enter a new password here.  

Notification Time  (Optional) Specify the notification start and end time within which the user can be notified with 
alerts.  

E-mail ID  Enter the e-mail address of the user.  

Mobile No  (Optional) Enter the mobile number of the user.  

Pager No  (Optional) Enter the pager number of the user.  

Enable User  Select the checkbox to allow user to access the system.  

A deselected checkbox denies access to the user. 

3. Click Save to upload the user details. 

The new User details are populated in the User Authorization screen which has to be 

authorized by System Authorizers. Once authorized, the User details are displayed in 

User Maintenance screen and can then be mapped to the required user group in the 

User UserGroup Map screen. 

NOTE:  This step may not be required if you have already setup users in the OFSAA setup. 

For more information refer user creation section from the Oracle Financial Services Analytical 

Applications Infrastructure User Guide. 

 

1122..55  MMaappppiinngg  AApppplliiccaattiioonn  UUsseerr((ss))  ttoo  UUsseerr  GGrroouupp  

User UserGroup Map facilitates you to map user(s) to specific user group which in turn is mapped 

to a specific Information Domain and role. Every UserGroup mapped to the infodom needs to be 

authorized. Else, it cannot be mapped to users. 

User UserGroup Map screen displays details such as User ID, Name, and the corresponding 

Mapped Groups. You can view and modify the existing mappings within the User UserGroup 

Maintenance screen. 

Starting the OFSAA 8.0 release, with installation of DM Application Pack, preconfigured 

Application user groups are seeded. These user groups are unique to every OFSAA Application 

Pack and have application roles pre-configured. 

You can access User UserGroup Map by expanding User Administrator section within the tree 

structure of LHS menu. 

Below three user-groups are available in Data management Pack.  

1. Recon Administrator 

2. Recon Framework Analyst 

3. Recon Framework Authorizer 
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1133  AAppppeennddiixx  GG::  OOFFSSAAAA  LLaannddiinngg  PPaaggee  

This appendix includes the following topics: 

 Installation Checklist 

 OFSAA Landing Page 

 Enabling a Product within an Application 

 Uninstalling the OSFAA Installation 

1133..11  IInnssttaallllaattiioonn  CChheecckklliisstt  

Before starting on the OFSAAI Installation Kit, ensure that the following pre-installation activities checklist 

is completed successfully. It is recommended to take a print out of the checklist and follow the checklist 

step by step.  

Table with (General, Pre-Install, Install, and Post Install) Checklist 

Step No. Task  Done 

General 

1 Check the OFS Data Management Release Notes and Read Me document for any 

additional steps to be performed on OFS Data Management Pack or OFSAAI. 

 

Note: For more details, contact Oracle support. 



 

Data Management Pack Pre Installation + During Installation 

1 Prior to installation, ensure that sufficient free temp space (minimum 1 GB free) is 

available in /tmp directory of unix server hosting OFSAAI. 



 

Data Management Pack Post Installation 

1 Perform post-installation steps 
 

1133..22  OOFFSSAAAA  LLaannddiinngg  PPaaggee  ffoorr  DDMM  AAddmmiinniissttrraattoorr  

On successful authentication, the OFSAA 8.0 Landing Page is displayed. This is a common 

landing page for all users until a preferred application landing page is set by the user in his 

preferences.  
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The landing page includes multiple tabs and each tab has specific links to OFSAA Infrastructure 

and/or Application modules. The tabs and links are displayed based on the OFSAA Application 

accessed and the access roles mapped to the logged in user. 

Each tab contains LHS Menu and RHS Menu. The LHS Menu holds link(s) to modules in a tree 

structure. The RHS Menu holds link(s) to modules in a navigational panel format. 

NOTE:  Refer the User Manual for more details on how to operate on each tab. 

1133..22..11  AAcccceessssiinngg  OOFFSSAAAA  IInnffrraassttrruuccttuurree  

Infrastructure can be accessed through your web-browser as soon as the System Administrator 

(SA) installs and configures Oracle Financial Services Analytical Applications Infrastructure. 

The SA will provide you with a link through which you can access Oracle Financial Services 

Analytical Applications Infrastructure. You can access the Infrastructure application login screen 

through your web-browser using the URL: <IP Address of the Web Server > :<servlet 

port>/<context name>/login.jsp. 

You can also login to the Infrastructure application with the host name instead of the IP address. 

To do this, it is necessary to have the host name mapped to the IP address in the hosts file the 

client Windows machine. The hosts file will be in %systemroot%\system32\ drivers\etc\ directory. 

1133..33  EEnnaabblliinngg  aa  PPrroodduucctt  wwiitthhiinn  aann  AApppplliiccaattiioonn  

Each product is marketed by a separate team and which is headed by a Sales Manager who 

reports to the Sales Head. Each Sales Manager in turn has two Sales Officers who are 

responsible for sales and profitability of the product.  
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The Sales Head has decided that the Sales Officer of each product will not have access to the 

information of other products. However, each Sales Manager will have access to Sales figures of 

the other products.  

Using the Oracle Infrastructure Security Hierarchy feature Administrator can provide information 

security at hierarchy level by defining security options for each hierarchy node. Thus, the Bank 

can control access of information at a node level and not increase the overheads.  

 

This is how it is done in Oracle Infrastructure:  

 First, the users are created in Oracle Infrastructure and then, a business hierarchy (as 

defined above) is created.  

 Now, the bank can restrict access of certain information to certain people in the Hierarchy 

Security configuration. In this window,  

 The administrator can control security by mapping the users to various nodes in 

hierarchy.  

For example, the administrator maps Sales Officer 1 and Sales Officer 2 to only the Personal 

Loans Node in the Product hierarchy. This restricts Sales Officer 1 and 2 to only viewing and 

maintaining their particular node in the hierarchy.  

By default, all the users mapped to a domain can access all the hierarchy levels to which they are 

mapped. This function allows the administrator to restrict or exclude a user/s from accessing 

restricted nodes. 

1133..44  EEnnaabblliinngg  aa  PPrroodduucctt  wwiitthhiinn  aann  AApppplliiccaattiioonn  PPaacckk  

You can also enable a product/ application within an application pack post installation at any point 

of time.  

To enable a product through the application UI, follow these steps: 

1. Login to the application as SYSADMN user or any user with System Administrator 

privileges. 

2. Navigate to System Configurations & Identity Management tab and expand Financial 

Services Analytical Applications Infrastructure >> Administration and Configuration >> 

System Configuration. 

3. Click Manage OFSAA Product License(s) 

4. The Manage OFSAA Product License(s) page is displayed as below. 



   

Oracle Financial Services Software Confidential - Restricted 

169 

 

This page includes the following sections: 

 INSTALLED APPLICATION PACKS 

 PRODUCTS IN THE APPLICATION PACK 

5. The following fields are displayed in the INSTALLED APPLICATION PACKS section: 

Field Description 

Application Pack ID 

Displays a unique Application Pack ID related to the application pack.  

Select the appropriate Pack id using the radio button. The Products in the 

application pack will be displayed below in the PRODUCTS IN THE 

APPLICATION PACKS section. 

Application Pack Name Displays the name of the Application Pack. 

Description Displays the description of the Application Pack. 

Install Date Displays the date when the Application Pack was installed. 

6. The following fields are displayed in the PRODUCTS IN THE APPLICATION PACK 

section: 

Field Description 

Enable Select the checkbox to enable a product within an Application Pack. 

Product ID Displays a unique product id for the product. 

Product Name Displays the name of the Product 
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Field Description 

Description Displays the description of the product. 

Enable Date Displays the date when the product was enabled. 

7. Select an Application Pack by clicking the radio button next to the Application Pack ID 

field. 

8. Selecting an Application Pack will display below the products within the Application Pack. 

9. Products which were enabled at the time of installation will have the checkbox “ENABLE” 

disabled. You can enable any product within the selected Application Pack by clicking the 

“ENABLE” checkbox against the respective Product ID. 

10. Click on RESET button to cancel the operation and refresh the screen. 

11. Click VIEW LICENSE AGREEMENT button. 

12. The License Agreement section is displayed. 

13. Select the option I ACCEPT THE LICENSE AGREEMENT. 

14. Click ENABLE. 

15.   An appropriate pop-up message confirmation is displayed showing that the product is 

enabled for the pack. 

NNOOTTEE::    To use the newly enabled product, you need to map your application users to the appropriate 

product specific User_Group(s) and subsequently, authorize the actions by logging in as 

System Authorizer.  

 

NNOOTTEE::    For more information refer to Mapping/Unmapping Users section in the Oracle Financial 

Services Analytical Applications Infrastructure User Guide 8.0.  

To identify the newly enabled product specific UserGroups/ Application Pack specific 

User_Groups, refer to the respective Application Pack specific Installation and Configuration 

Guide/ User Manual.  

1133..55  UUnniinnssttaalllliinngg  OOFFSSAAAA  IInnssttaallllaattiioonn  

This section will guide you through the necessary steps to uninstall the OFSAA 8.0 installation. 

Before you start the uninstall process, ensure that no open connections exist to the OFSAA 

Config and Atomic Schemas and Infrastructure services are brought down. 

To uninstall OFSAA: 

1. Log in to the system as non-root user. 
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2. Navigate to the $FIC_HOME directory and execute the command: 

./Uninstall.sh 

3. Enter the password for OFSAA Configuration Schema when prompted as shown in the 

following figure. 

 

Uninstall process does not uninstall the OFSAA application from the Web Application 

Server. This has to be done manually. The files/ folders under the file system staging 

area (ftpshare) have to be deleted manually. 

All the Database objects from Atomic Schemas have to be dropped manually. 
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1144  AAppppeennddiixx  HH::  AAddddiittiioonnaall  CCoonnffiigguurraattiioonnss  

1144..11  AAddddiittiioonnaall  CCoonnffiigguurraattiioonnss  

The following sections provide detailed module specific post installation configurations. 

This section includes the following topics: 

 FTP/SFTP Configuration for File Transfer 

 Configure Infrastructure Server Memory 

 Internet Explorer Settings 

 OLAP Data Server Configuration 

 Configure Infrastructure Ports 

 OFSAAI Setup Information Fetching Tool 

 Encryption Changer 

 Infrastructure LDAP Configuration 

 Configure OFSAAI Web Services 

 Deploy OFSAAI Web Services 

 Configure Message Details in Forms Designer 

 Clearing Application Cache 

 Configuring Password changes 

 Configure Internal Service (Document Upload/ Download) 

1144..11..11  FFTTPP//SSFFTTPP  CCoonnffiigguurraattiioonn  ffoorr  FFiillee  TTrraannssffeerr  

In OFSAA, certain modules require transfer of files from the web application server to the OFSAA server 

over SSH.  

Follow these steps to ensure the OFSAA server recognizes the web application server during file 

transfers.  

1. Login to the web application server. 

2. Type sftp <user>@<OFSAA Server> 

3. Specify Yes when prompted for permission. 

Are you sure you want to continue connecting (Yes/No)? 

4.  This will add an entry into the "known_hosts" file. 

5. A  confirmation message is displayed: 
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Permanently added <OFSAA Server> RSA) to the list of known hosts. 

 

1144..11..22  CCoonnffiigguurree  IInnffrraassttrruuccttuurree  SSeerrvveerr  MMeemmoorryy  

The memory settings for Infrastructure Application Server, Tomcat, WebSphere, and WebLogic 

can be edited for customizing memory settings and garbage collector settings depending on the 

available hardware configuration as explained below. These settings are base minimum and has 

to be incremented considering the deployment metrics into account. The increments are usually 

handled in multiples of 128mb for heap and 64mb for stack. 

14.1.2.1 IInnffrraassttrruuccttuurree  SSeerrvveerr  MMeemmoorryy  SSeettttiinnggss  

You can configure the Infrastructure Application Memory settings as follows: 

1. Locate .profile file. 

2. Edit X_ARGS field in this file for customizing memory settings and garbage collector 

settings depends on the hardware configuration. 

This has a default value X_ARGS_APP ="-Xms200m" 

X_ARGS_APP =" "$X_ARGS" $DELIM -Xmx2048m" 

NOTE:  You need to modify X_ARGS_APP variable in the .profile file to customize Java Memory 

Settings for Model Upload based on the Data Model size. 

For Run and Rule executions, the following value is recommended:   

 

X_ARGS_RNEXE="-Xms1g -Xmx1g -XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=512M -

XX:+UseParallelOldGC -XX:+DisableExplicitGC"   

 

X_ARGS_RLEXE="-Xms1g -Xmx1g -XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=512M -

XX:+UseParallelOldGC -XX:+DisableExplicitGC" 
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1144..11..33  IInntteerrnneett  EExxpplloorreerr  SSeettttiinnggss  

NOTE:  OFSAAI supports only default zoom setting in Internet Explorer, that is, 100%. 

Cookies should be enabled. 

 

The following browser settings have to be specified at every client machine prior to accessing the 

Infrastructure application. 

1. Open Internet Explorer. Select Tools > Internet Options. The Internet Options window 

is displayed. 

2. Click the Settings button. The Settings window is displayed. 

3. Select the option Everytime I Visit the webpage and click OK. 

 

4. In the Internet Options window, select the Security tab and select the Internet option 

under Select a zone to view or change the security settings. 

5. Click Default Level under Security level for this zone. 
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6. Click OK to save. 

7. Click Internet Explorer >> Tools >> Compatibility View Settings. 

8. Enter the OFSAA setup URL in the Add this website field. 

9. Click Add. 

10. Ensure the URL is listed under Websites you've added to Compatibility View. 

11. In the Internet Options window, select the Privacy tab and select the Turn on Pop-up 

Blocker option under Pop-up Blocker settings. 



   

Oracle Financial Services Software Confidential - Restricted 

176 

 

12. Click Settings. The Pop-up Blocker Settings window is displayed. 

13. Enter the URL of the OFSAA Application in the Address of Website to Allow: field. 

14. Click Add. The OFSAA URL is displayed in the Allowed Sites section. 

15. Click Close. 

16. Click OK in the Internet Options window. 

1144..11..44  RReettrriieevvee  PPaattcchh  IInnffoorrmmaattiioonn  

To identify the list of patches installed on your OFSAA setup, follow these steps: 

1. Login to the OFSAA application as a user with Object AdminAdvanced Role. 

2. Navigate to Object Administration tab. 

3. Click System Utilities. 

4. Click Patch Information. 

5. The page displays the list of patches installed on the OFSAA setup across Applications/ 

Platform. 
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1144..11..55  OOLLAAPP  DDaattaa  SSeerrvveerr  CCoonnffiigguurraattiioonn  

This section is applicable if you are using the OLAP feature of OFSAAI. 

The following parameters must be set to ensure that the system limitations are not exceeded at 

any stage. The values for these OS parameters should be specified based on the expected load 

at each implementation site. 

Example: 

Process Memory Limit 

Max Thread Stack Size 

Max Number of Threads per Process 

 Sort Buffer settings: This must be set at the Essbase application level appropriate to the 

anticipated load. 

 Shutdown and Restart: During shutdown of OFSAAI Server that has an instance of Data 

Services that is communicating with an OLAP Data Server, it is imperative to ensure that 

the cleanup of the old instance is completed on the OLAP Data Server before restarting the 

OFSAAI Server. Pause for a period of time based on the load the system was subjected to, 

before restarting the Data Services subsystem. 
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1144..11..66  CCoonnffiigguurree  IInnffrraassttrruuccttuurree  PPoorrttss  

This step is applicable only in the event you wish to change any of the ports used by 

Infrastructure services after the installation process. The ports that are used by the Infrastructure 

application are distributed across the machines on which Infrastructure Web; Application, and 

Database components have been installed. Therefore you must perform the port changes on all 

the machines on which Infrastructure components have been installed. 

"PortC.jar" can be executed in two modes. 

 GUI 

 CMD 

To execute "PortC.jar" in GUI mode, ensure that the "Hummingbird Exceed" to be running and do 

the following: 

1. Navigate to the path $FIC_HOME in each machine. 

2. Enter the command  

java -jar PortC.jar GUI 

3. The OFSAA Infrastructure Port Changer window is displayed. 

 

OFSAA Infrastructure Port Changer 
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The OFSAA Infrastructure Port Changer window displays the following: 

 The path in which Infrastructure components have been installed. 

 The check-boxes corresponding to Application Layer, Database Layer, or Web Layer are 

enabled based on: 

In the event you have performed a single-tier installation on the current machine, the check-boxes for all 

three components will be enabled.  

If you have installed more than one category of components on the current machine, the 

corresponding checkboxes for the respective components you have installed will be enabled. 

To edit the port value, enter the new port value. User has the option to change the required ports 

and leave the other ports unchanged. Only the ports for which values are modified will change 

and the ports that are unchanged will retain its default value. 

NOTE:  All ports on a machine must be unique. The range of port numbers that are given should 

preferably be between 1025 and 65535. The Servlet port can have 80 or 443 as port numbers 

if Default HTTP/HTTPS ports are being used. 

 

Select the Database Type as Oracle from the drop-down list. 

 The IP / Host Address of the machine on which the corresponding database is installed will 

be populated. 

 The Port Number on which the database is listening is displayed. 

 The SID details are displayed. 

 The Configuration Schema username is displayed. 

 Enter the Configuration schema password. 

 Click Change to initiate the port changes. 

To execute PortC.jar in CMD mode: 

4. Navigate to the path $FIC_HOME. 

5. Enter the command: 

java -jar PortC.jar CMD 

Then enter the requested information to change the ports. Once the port numbers are changed in 

the Infrastructure configuration, a message will be displayed confirming the changes. The log 

"Portchanger.log" in the Infrastructure installation path provides the status of port changes 

performed. 

For above port changes to take effect, a re-start of all Infrastructure servers is required. 
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NOTE:  Do not execute the "PortC.jar" with CMD option in the "nohup" mode. The port changes are 

done only on Infrastructure web components where EAR/WAR files are deployed. After the port 

changes are done, you need to re-create the EAR/WAR files and re-deploy these files. 

1144..11..77  OOFFSSAAAAII  SSeettuupp  IInnffoorrmmaattiioonn  FFeettcchhiinngg  TTooooll  

Executing the SetupInfo.jar file available in the FIC_HOME path will help you retrieve the related 

information about the OFSAAI Set up such as Operating System Name and version, Database 

Type and Version, OFSAAI architecture, Log file locations and so on. 

To execute "SetupInfo.jar" in console: 

1. Navigate to the path $FIC_HOME. 

2. Enter the command: 

java -jar SetupInfo.jar 

After execution, the output file location is displayed in the console. 

1144..11..88  EEnnccrryyppttiioonn  CChhaannggeerr  

This utility helps you to regenerate the new AESCryptKey.ext file and encrypt all the encrypted 

values of the OFSAAI setup according to the new key. 

To execute EncryptC.jar in console: 

1. Navigate to the path $FIC_HOME. 

2. Enter the command: 

java -jar EncryptC.jar 

A confirmation message is displayed after execution. 

Once executed, you need to create and deploy the EAR / WAR file depending on the configured 

Web Application Server. For more information, see Create and Deploy EAR/ WAR files. 

 

1144..11..99  IInnffrraassttrruuccttuurree  LLDDAAPP  CCoonnffiigguurraattiioonn  

This provides you with the option of using LDAP (Lightweight Directory Access Protocol) 

authentication or Infrastructure SMS authentication for logging on to Infrastructure. 

If you are using the Infrastructure authentication, the user and user group details, profile creation, 

function and role maintenance and other mappings can be done through the Infrastructure 

Administration module under Security Management. The data in this case, will be updated in the 

CSSMS table. 
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However, if you wish to use LDAP for user authentication, then you have to ensure that the LDAP 

server is installed and configured. Also make sure that OPEN LDAP 2.2.29+ is installed and 

configured in Windows machine. Before doing the following configuration, it is required to select 

the "Authentication type" as LDAP in the Configuration screen of Infrastructure. This screen can 

be accessed by selecting System Configuration > Configuration in the LHS menu of 

Infrastructure. In the Windows machine in which LDAP Server is installed, go to the OpenLDAP 

installation directory through the command prompt and execute the command "slapd -d 1" to 

start the LDAP server. 

14.1.9.1 CCoonnffiigguurree  IInnffrraassttrruuccttuurree  ""CCoonnffiigguurraattiioonn  SScchheemmaa""  

In the Infrastructure "configuration schema", ensure the following entries in Configuration Table. 

Configuration Schema 

PARAMNAME Description PARAM Value Example 

AUTHENTICATIONTYPE Authentication type 3 - AUTHENTICATIONTYPE value must be 3 for 

LDAP 

ROOTCONTEXT The Root Context for the LDAP 

Directory 

dc=<OFSAA>, dc=<com> 

ROOTDN The Root dn for LDAP directory cn=<Manager>, dc=<Reveleus>, dc=<com> 

ROOTPASS Password for the Root <secret> 

LDAPURL LDAP URL <ldap://10.11.12.13.1234/> 

LDAP_SSL_MODE LDAP in SSL Mode N for non - SSL and Y for SSL 
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PARAMNAME Description PARAM Value Example 

HASHPASS Should the user password be 

Hashed 

FALSE or TRUE. 

When HASSPASS is set as FALSE, we need to 

have the ROOTDN value as "uid=ORCLADMIN, ou 

=Users, dc=OFSAAI, dc=com". ORCLADMIN is a 

dummy user, it will be replaced dynamically with the 

logged in user. 

When HASSPASS is set as TRUE, we need to have 

the ROOTDN value as "cn=orcladmin, cn=Users, 

dc=i-flex,dc=com" and proper oracladmin LDAP 

password as ROOTPASS. First OFSAAI connects 

to LDAP directory using orcladmin user and fetches 

the login user details and verifies the entered 

password. 

RETRIEVE_DN To retrieve Distinguished Name TRUE 

 

NOTE:  ROOTCONTEXT, ROOTDN, and ROOTPASS entries should be same as in the slapd.conf file. 

14.1.9.2 CCoonnffiigguurree  OOppeennLLDDAAPP  FFiilleess  

1. Copy the reveleusSchema.schema from <Infrastructure Installation Directory> 

/ficapp/common/FICServer/conf/LDAP_LDIF folder to LDAPServer Schema folder. 

2. Copy the Domains.ldif and Reveleus.ldif files from <Infrastructure 

Installation Directory>/ficapp/common/FICServer/conf/LDAP_LDIF folder to 

OpenLDAPServer folder. 

Note: Make sure that the ROOTCONTEXT in the Domains.ldif and Reveleus.ldif files are the same as 

slapd.conf file. 

 

3. Provide the appropriate entries for ROOTDN, ROOTPASS, and ROOTCONTEXT in 

slapd.conf file in the OpenLDAPServer folder. 

4. Add the text "include schema/reveleusSchema.schema" as the first line of the 

slapd.conf file  

Note: The above steps of the configuration are for OpenLDAP Server only. If you need to configure 

Infrastructure for any other LDAP Server, you will have to make the changes appropriately. 

 



   

Oracle Financial Services Software Confidential - Restricted 

183 

5. In the command prompt, navigate to the LDAP installation directory and execute the 

command "ldapadd -D"ROOTDN"  -w ROOTPASS -f/data/Reveleus.ldif" 

This is for creating the entries for Users, User Groups, Functions, Profiles, Segments, 

Domains, Roles, and HolidayMaster in the Data information Tree of LDAP. 

6. Make an entry in the Domains.ldif file for each Information Domain that is created 

through the Infrastructure UI. 

To add an entry corresponding to the new Information Domain to the Domains.ldif file, add the 

following block of text with the appropriate values: 

NOTE:  DSNID refers to Information Domain name. 

 

dn: DSNID=<DSN ID>,ou=Domains,@LDAP_DIRECTORY_ROOTCONTEXT@ 

changetype: add 

mappedsegments: <Mapped segments/~> 

dsnid: <DSN ID> 

infodomname: < Information Domain Name> 

objectClass: Infodom 

objectClass: top 

infodomdescription: < Information Domain Description> 

Example: 

dn: DSNID=FUSIONMOCK, ou=Domains, dc=FTP1,dc=com 

mappedsegments: ~ 

dsnid: FUSIONMOCK 

infodomname: FUSIONMOCK 

objectClass: Infodom 

objectClass: top 

infodomdescription: FUSIONMOCK 

Then, navigate to LDAP installation directory and execute the command "D"ROOTDN"  -w 

ROOTPASS -f/data/Domains.ldif" 

NOTE:  You can add entries for multiple Information Domains at the same time. 
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14.1.9.3 MMiiggrraattee  DDaattaa  ffrroomm  CCSSSSMMSS  ttaabblleess  ttoo  LLDDAAPP  sseerrvveerr  

If you are using LDAP authentication, it is required to migrate all the details from the CSSMS 

table, which contains the information entered using the Infrastructure Administration module 

under Security Management to the LDAP Server. 

To migrate data from CSSMS tables to LDAP server: 

1. Invoke the LDAP_Migration.sh file in 

$FIC_HOME/MigrationUtilities/Migration_LDAP/ bin folder. The Select Source & 

Destination for Migration window is displayed with the option to migrate the data from 

SMS to LDAP or vice versa. 

 

Select Source & Destination for Migration 

2. Select the SMS to LDAP option and click OK. The Select Entities to Migrate window 

is displayed. 

 

Select Entities to Migrate 
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You can select the data that you wish to migrate such as Users, User Groups, 

Functions, Roles, Segment, Profiles, Holiday Master, Function Role Maps, User - User 

Group Maps, User Group Role Map, and User Group- Domain Map. 

3. Select the entities that you wish to migrate and click Migrate. The data is migrated and 

a confirmation dialog is displayed. 

4. You can verify the data migrated to LDAP server through the LDAP Browser. 

NOTE:  You should also enter the passwords for all the users as passwords are not migrated in 

migration process. 

1144..11..1100  CCoonnffiigguurree  OOFFSSAAAAII  WWeebb  SSeerrvviicceess  

Web Services in OFSAAI is meant for exposing a web service to "asynchronously" or 

"synchronously" execute requested tasks offered by OFSAAI. The configuration steps given 

below are to be done only if you are using the Web Services feature of OFSAAI. 

14.1.10.1 CCoonnffiigguurree  DDyynnaammiiccWWSSCCoonnffiigg..xxmmll  FFiillee  

For each third party web service that needs to be accessed using the OFSAAI Web services 

framework and the operations to be invoked, corresponding entries are to be made in the 

DynamicWSConfig.xml template file. 

The variable <WebServer> denotes any one of the application server, i.e. WebSphere, 

WebLogic, or Tomcat. 

The DynamicWSConfig.xml file will be available in the <OFSAAI Installation 

Directory>/EXEWebService/ <WebServer>/ROOT/conf directory. This file can be 

placed in any directory that is accessible by the application and this location must be specified in 

the web.xml file, as WSCONFIGFILE parameter. 

The DynamicWSConfig.xml template file will be in <WebServer Deployment Path>/ 

EXEWebService.ear/EXEWebService.war/conf directory. 

This template is given below: 

<XML> 

<WEBSERVICES> 

<WEBSERVICE CODE="$CODE" 

ENDPOINT="$ENDPOINT" TARGETNAMESPACE="$TARGETNAMESPACE" 

XMLNS_XSD="$XMLNS_XSD" ENCODINGSTYLE="$ENCODINGSTYLE" 

SERVICENAME="$SERVICENAME" PORTTYPENAME="$PORTTYPENAME" 

SESSION_MAINTAIN_PROPERTY="$SESSION_MAINTAIN_PROPERTY" 
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USERNAME="$USERNAME" 

PASSWORD="$PASSWORD" STYLE="$WEBSERVICESTYLE" 

STUBIMPLEMENTATION="$STUBIMPLEMENTATION"> 

<OPERATION CODE="$CODE" 

NAME="$NAME" 

SOAPACTION="$SOAPACTION" 

STYLE="$STYLE" 

PACKAGENAME="$PACKAGENAME"> 

<INPUT ORDER="$ORDER" 

PARAMNAME="$PARAMNAME" 

ARGTYPE="$ARGTYPE" 

CLASSNAME="$CLASSNAME"/> 

<OUTPUT PARAMNAME="$PARAMNAME" 

RETURNTYPE="$RETURNTYPE" 

CLASSNAME="$CLASSNAME"/> 

</OPERATION> 

</WEBSERVICE> 

</WEBSERVICES> 

</XML> 

The DynamicWSConfig.xml has the placeholders as tabulated below. These have to be updated 

depending on the web service chosen and the mode of accessing it. For each Web service to be 

accessed, the entire webservice tag in the DynamicWSConfig.xml file must be repeated. The 

placeholders tabulated below should be set in accordance to the parameters published in the 

third party wsdl files (webservices) to be accessed. The stub class specified must implement the 

"com.iflex.Oracle Reveleus.execution.webservice.EXEWebIF" interface. 

14.1.10.2 AAttttrriibbuutteess  ffoorr  WWEEBBSSEERRVVIICCEE  ttaagg  

WEBSERVICE tag 

Placeholder Description 

$CODE Unique number within the xml file and cannot be 999 or 0. 
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Placeholder Description 

$ENDPOINT soap: address location in the wsdl: service name tag of the wsdl file. 

$TARGETNAMESPACE The attribute value for the targetNamespace of the wsdl: definitions 

tag. 

$XMLNS_XSD The attribute value for the xmlns:s of the wsdl:definitions tag 

$ENCODINGSTYLE The attribute value for the xmlns:soapenc of the wsdl:definitions 

tag. 

$SERVICENAME Name of the service found under the wsdl:service name tag of the 

wsdl file. 

$PORTTYPENAME wsdl port type name as mentioned in the wsdl file. 

$SESSION_MAINTAIN_PROPER

TY 

This could be given as "" also. 

$USERNAME User name to access the web services. Enter "" if no user name is 

required. 

$PASSWORD Password to access the web services. Enter "" if no password is 

required. 

$WEBSERVICESTYLE This can take either "rpc" in case of DII mode of invoking web 

services or "stub" in case of static mode. This is a mandatory 

parameter. 

$STUBIMPLEMENTATION Fully qualified class name (package name.classname). 

14.1.10.3 AAttttrriibbuutteess  ffoorr  OOPPEERRAATTIIOONN  ttaagg  

Ensure that the "operation tag attributes" are repeated for each of the operation tags. 

OPERSTION tag 

Placeholder Description 

$CODE Should be unique within the Webservice tag. 
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$NAME The name of the Function that is to be called by the wsdl 

file. 

$SOAPACTION The URL for the Operation to access. This is associated 

with the Operation tag of the wsdl file. 

$STYLE This can take "rpc" if the web services invoking is in DII 

mode or "stub" if it is in static mode. This is a mandatory 

parameter. 

$PACKAGENAME Represents the JAXB package of input object. 

 

14.1.10.4   AAttttrriibbuutteess  ffoorr  IINNPPUUTT  ttaagg  

INPUT tag 

Placeholder Description 

$ORDER The sequential number of the INPUT tag. Should start 

from 0. This is in line with the input order of the 

arguments that the API accepts which is called by this 

operation. 

$PARAMNAME Input parameter name to be called by the wsdl file. 

$ARGTYPE Input Parameter Data Type. If the input argument type is 

complex object, specify $ARGTYPE as "xmlstring". 

$CLASSNAME Represents class name of input object parameter. 

 

14.1.10.5   AAttttrriibbuutteess  ffoorr  OOUUTTPPUUTT  ttaagg  

OUTPUT tag 

Placeholder Description 

$PARAMNAME Output parameter name to be returned by the web 

service. 

$RETURNTYPE Output parameter Data Type. If the web service response 

is a complex object, then specify $RETURNTYPE as 

"object". 

$CLASSNAME Represents class name of output object parameter. 
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14.1.10.6 wweebb..xxmmll  EEnnttrriieess  

1. This step is optional and required only if the web application server used is Tomcat. In case of 

any other application server, skip and proceed with next step. 

Navigate to $FIC_HOME/webroot/WEB-INF/ and edit the web.xml file. Set parameter value 

DOCSERVICEAPP to EXEWebServiceAXIS. 

2. Navigate to <OFSAAI Installation 

Directory>/EXEWebService/<WebServer>/ROOT/WEB-INF/ and edit the web.xml file as 

explained below. 

NOTE:  In case of Java 7 when WebLogic is  used as web application server replace following  line of 

<OFSAAI Installation Directory>/EXEWebService/Weblogic/ROOT/WEB-

INF/web.xml file that is 

 

<?xml version='1.0' encoding='UTF-8'?>  

<web-app id="WebApp_ID" version="3.0"  

xmlns="http://java.sun.com/xml/ns/javaee"  

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"  

xsi:schemaLocation="http://java.sun.com/xml/ns/javaee  

http://java.sun.com/xml/ns/javaee/web-app_3_0.xsd" metadata-

complete="true"> 

 

with  

 

<?xml version='1.0' encoding='UTF-8'?>  

<web-app xmlns="http://java.sun.com/xml/ns/j2ee"  

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"> 

EEnnttrryy  ffoorr  WWSSCCoonnffiigg  FFiillee  

The WSCONFIG file (DynamicWSConfig.xml) is available in the <WebServer Deployment 

Path>/ EXEWebService.ear/EXEWebService.war/conf directory. This file can be placed 

in any directory that is accessible by the application. 

The path where the WSCONFIG file is placed must be specified in place of 

$WSCONFIGFILELOCATION$ in the below block of text in web.xml. 

<context-param> 

<description>WebServices Configuration File</description> 

<param-name>WSCONFIGFILE</param-name> 

<param-value>$WSCONFIGFILELOCATION$</param-value> 
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<!--Specify the Location of DynamicWSConFig.xml--> 

</context-param> 

PPrrooxxyy  SSeettttiinnggss  

The following block of text in web.xml file, replace the <param-value> given in bold below with 

appropriate values. 

If no values are required, leave the <param-value> blank. 

<context-param> 

<description>http Proxy Host</description> 

<param-name>http.proxyHost</param-name> 

<param-value>$PROXYHOST$</param-value> 

<!-- Specify the IP address or hostname of the http proxy server--> 

</context-param> 

<context-param> 

<description>http Proxy Port</description> 

<param-name>http.proxyPort</param-name> 

<param-value>$PROXYPORT$</param-value> 

<!--Port Number for the Proxy Server--> 

</context-param> 

<context-param> 

<description>http proxy UserName</description> 

<param-name>http.proxyUserName</param-name> 

<param-value>$PROXYUSERNAME$</param-value> 

<!-- User ID To get authenticated by proxy server--> 

</context-param> 

<context-param> 

<description>http proxy Password</description> 

<param-name>http.proxyPassword</param-name> 

<param-value>$PROXYPASSWORD$</param-value> 

<!-- User Password To get authenticated by proxy server--> 
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</context-param> 

<context-param> 

<description>http non-ProxyHosts</description> 

<param-name>http.nonProxyHosts</param-name> 

<param-value>$NONPROXYHOST$</param-value> 

<!--Hosts for which the proxy settings should get by-passed (Note: 

Separate them by "|" symbol) --> 

</context-param> 

OOFFSSAAAAII  HHoommee  EEnnttrryy  

This entry should point to the Application layer / Web layer of the OFSAAI installation and should 

be accessible. 

Replace $FIC_HOME$ in the following block of text in web.xml with <WebServer 

Deployment Path>/EXEWebService.ear/EXEWebService.war. 

<context-param> 

<description>OFSAAI Web Home</description> 

<param-name>FIC_HOME</param-name> 

<param-value>$FIC_HOME$</param-value> 

<!--OFSAAI Installation Folder--> 

</context-param> 

<context-param> 

<description>OFSAAI Web Home</description> 

<param-name>FIC_PHYSICAL_HOME</param-name> 

<param-value>$FIC_HOME$</param-value> 

<!--OFSAAI Installation Folder--> 

</context-param> 

DDyynnaammiiccWWSSCCoonnffiigg..xxmmll  

For each third party web service that needs to be accessed using the OFSAAI Web services 

framework, and the operation to be invoked, make corresponding entries into this file. This file is 

to be placed in the location that is specified in the web.xml, as WSCONFIGFILE parameter. 
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1144..11..1111  DDeeppllooyy  OOFFSSAAAAII  WWeebb  SSeerrvviicceess  

You can deploy OFSAAI Web Services separately if you had not configured OFSAAI Web 

Services as part of the installation. 

1. Complete the manual configuration of OFSAAI Web Services. 

2. Navigate to <OFSAAI Installation Directory>/EXEWebService/<WebServer> and 

execute the command: 

./ant.sh 

3. This will trigger the EAR/WAR file creation, which is required for the deployment.  

4. Deploy the generated EXEWebService.EAR/EXEWebService.WAR file into the 

WebServer. 

If you have already configured OFSAAI Web Services as part of the installation, deploy the 

generated EXEWebService.EAR/ EXEWebService.WAR file into the OFSAAI Deployment area in 

WebServer profile. 

1144..11..1122  CCoonnffiigguurraattiioonn  ttoo  EEnnaabbllee  PPaarraalllleell  EExxeeccuuttiioonn  ooff  DDMMLL  ssttaatteemmeennttss  

A configuration file, OracleDB.conf has been introduced to accommodate any configurable 

parameter related to operations on oracle database. If you do not want to set a parameter to a 

specific value, then the respective parameter entry can be removed/commented off form the 

OracleDB.conf file which resides in the path $FIC_DB_HOME/conf. 

As of now, the OracleDB.conf file has only one parameter namely 

CNF_DEGREE_OF_PARALLELISM. This parameter indicates the degree of parallelism to be used 

for a DML operation if parallel DML is explicitly enabled in the session with the ENABLE 

PARALLEL DML clause of the ALTER SESSION statement. The default mode of a session is 

DISABLE PARALLEL DML. If CNF_DEGREE_OF_PARALLELISM is not set, then the default 

degree, as decided by Oracle will be used. 

1144..11..1133  CCoonnffiigguurree  MMeessssaaggee  DDeettaaiillss  iinn  FFoorrmmss  DDeessiiggnneerr  

You can configure the Message Details in Forms Designer under Data Entry Forms and Queries 

module by updating the details of mail server in the "NotificationConfig.cfg" file which resides in 

the path $FIC_APP_HOME/common/FICServer/conf. 

Ensure that the "authorized User details" for whom you need to configure the Message details are 

included in Administration > Security Management > User Administrator > User Maintenance 

window. 

Update the following parameters in the "NotificationConfig.cfg" file: 
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NotificationConfig.cfg File 

Parameter Description 

SMTP_SERVER_IP Specify the hostname or IP address of SMTP Server. 

SMTP_DEBUG_MODE To run SMTP service in Debug mode, set value to 'true', 

otherwise set value to 'false'. 

SMTP_AUTHORIZATION Set to 'true' if SMTP server requires the client to be 

authenticated, otherwise set to 'false'. 

SMTP_USERNAME Username required for logging into SMTP server, if 

authentication is not required use a dummy value. 

SMTP_PASSWORD Password required for logging into SMTP server, if 

authentication is not required use a dummy value. 

SMTP_MAILID If the Messages has to go from a Particular ID that ID 

need to be added. Exchange server forces you set a valid 

ID that is there in the exchange server. (Based on Security 

settings) 

 

Ensure that the authorized User details are included in Administration > Security Management > 

User Administrator > User Maintenance window. 

1144..11..1144  CClleeaarriinngg  AApppplliiccaattiioonn  CCaacchhee  

This is applicable to all Web Servers (i.e. WebSphere, WebLogic, and Tomcat).  

Prior to the deployment of Infrastructure or Application Service Packs / One-off patches, navigate 

to the following path depending on the WebServer configured and clear the cache: 

 Tomcat: <Tomcat installation 

folder>/work/Catalina/localhost/<Application name>/org/apache/jsp 

 WebLogic: <Weblogic installation location>/domains/<Domain 

name>/servers/<Server name>/tmp/_WL_user/<Application 

name>/qaelce/jsp_servlet 

 WebSphere: <Websphere installation 

directory>/AppServer/profiles/<Profile name>/temp/<Node 

name>/server1/<Application name>/<.war file name> 
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1144..11..1155  CCoonnffiigguurriinngg  PPaasssswwoorrdd  cchhaannggeess  

This section explains about how to modify the OFSAA Infrastructure Config Schema and Atomic 

Schema passwords. 

14.1.15.1 OOFFSSAAAA  IInnffrraassttrruuccttuurree  CCoonnffiigg  SScchheemmaa  ppaasssswwoorrdd  mmooddiiffiiccaattiioonn  

To change the Config Schema password, perform the following steps: 

1. Change the Config schema User Password in the database. 

2. Delete the $FIC_HOME/conf/Reveleus.SEC file. 

3. Shutdown the OFSAAI App service: 

cd $FIC_APP_HOME/common/FICServer/bin 

./ reveleusshutdown.sh 

4. Start the Infrastructure Server in foreground directly on the server or through X-

Windows software using the command: 

./ reveleusstartup.sh 

At the prompt, enter System Password. Enter the "new Config schema" password. The 

service will start and initialize itself if it is able to successfully connect to the DB. 

5. Post successful startup of the service, if required, the Infrastructure server may be shut 

down and restarted in the background using nohup mode. 

14.1.15.2 OOFFSSAAAA  IInnffrraassttrruuccttuurree  AAttoommiicc  SScchheemmaa  ppaasssswwoorrdd  mmooddiiffiiccaattiioonn  

To change the Atomic Schema password, perform the following steps: 

1. Change the Atomic schema User Password in the database. 

2. Login to the application from the browser using SYSADMN account or any user id, 

which has System Administrator role mapped. 

3. Navigate to System Configuration > Database Details window. Select the appropriate 

connection and edit the password. 

4. Navigate to Unified Metadata Manager > Technical Metadata> Data Integrator > Define 

Sources window. Update the appropriate Source details. 

5. If you are using Apache Tomcat as Web server, update the <Context> -> Resource tag 

details in Server.xml file from the $CATALINA_HOME/conf folder. (In case of Tomcat 

only Atomic <Resource> will exist). 

6. If you are using WebSphere as Web server: 

a. Login to the WebSphere Administration Console, from the left side menu. 
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b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be 

populated on the right side.  

c. Select the appropriate Data Source and edit the connection details. (In this case, 

both Config and Atomic data sources will need to be modified). 

If you are using WebLogic as Web server: 

d. Login to the WebLogic Administration Console, from the left side menu 

e. Under Domain Structure list box, expand the appropriate Domain and navigate to 

Services > JDBC >Data Sources. A list of data sources will be populated on the 

right side.  

f. Select the appropriate Data Source and edit the connection details. (In this case, 

both Config and Atomic data sources need to be modified). 

7. Restart the OFSAAI services. 

1144..11..1166  CCoonnffiigguurree  IInntteerrnnaall  SSeerrvviiccee  ((DDooccuummeenntt  UUppllooaadd//  DDoowwnnllooaadd))  

This step can be ignored if it has already been configured as part of any previous IR /ML 

installation. 

The Document Upload /Download feature has undergone a change and can now be configured to 

use Internal service for document upload / download instead of the earlier ExeWebService. 

To facilitate Internal service for document upload/ download, perform the following configurations: 

1. Create the folders download, upload, TempDocument and Temp in the local path of Web 

application server and provide Read/Write permission. 

 To find the exact location, execute the following query in CONFIG schema: 

select localpath from web_server_info 

 To create folders with Read/Write permission, execute the command: 

mkdir -m 777 download upload TempDocument Temp 

2. Create DocStorage folder in the FTPSHARE location of APP tier and provide 

Read/Write permission. 

 To find the exact location, execute the query in CONFIG schema: 

select ftpdrive from app_server_info 

 To create folder with Read/Write permission, execute the command: 

mkdir -m 777 DocStorage 

By default, the parameter DOCUMENT_SERVICE_TYPE_EXTERNAL value is set to FALSE in 

the Configuration table in CONFIG schema and hence the application “ExeWebService” will not 
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be used. It is recommended that the value to be set to FALSE and use the Internal service for 

document upload/ downloads. If you intend to continue using the External ExeWebService, set 

the value to TRUE. 

Navigate to $FIC_HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier and type 

./ant.sh. This triggers the creation of EAR/WAR file EXEWebService.ear/.war. The EAR/WAR file 

EXEWebService.ear/.war will be created in 

$FIC_HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier. Redeploy the 

generated EAR/WAR file onto your configured web application server. 
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1155  AAppppeennddiixx  II::  PPaattcchhiinngg  DDMM  PPaacckk  IInnssttaallllaattiioonn  

1155..11  PPaattcchhiinngg  YYoouurr  OOFFSS  DDMM  PPaacckk  IInnssttaallllaattiioonn  

Oracle strongly recommends installing the latest available patchset so as to be up to date with the 

various releases of the OFSAA Infrastructure product. 

Refer http://support.oracle.com for more information on latest releases. 

 

http://support.oracle.com/
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1166  AAppppeennddiixx  JJ::  GGrraannttss  ffoorr  AAttoommiicc//  CCoonnffiigg  SScchheemmaa  

This Appendix includes the following sections: 

 Grants for Atomic Schema 

 Grants for Config Schema 

 Grants for Config Schema Entities for Atomic Users 

1166..11  GGrraannttss  ffoorr  AAttoommiicc  SScchheemmaa  

Atomic Schema creation requires certain grants for object creation. This can be located in 

$FIC_HOME/privileges_atomic_user.sql file  

grant create SESSION to &database_username 

/ 

grant create PROCEDURE to &database_username 

/ 

grant create SEQUENCE to &database_username 

/ 

grant create TABLE to &database_username 

/ 

grant create TRIGGER to &database_username 

/  

grant create VIEW to &database_username 

/ 

grant create MATERIALIZED VIEW to &database_username 

/ 

grant olap_user to &database_username 

/ 

grant select on SYS.V_$PARAMETER to &database_username 

/ 

grant create SYNONYM to &database_username 

/ 

NOTE:  If you intend to use Oracle OLAP feature, execute the below grant on all  ATOMIC schema(s)  

grant olap_user to &database_username 

1166..22  GGrraannttss  ffoorr  CCoonnffiigg  SScchheemmaa  

Config Schema creation requires certain grants for object creation. This can be located in 

$FIC_HOME/privileges_config_user.sql file  

The following are the Grants for Config Schema: 

grant create SESSION to &database_username 

/ 

grant create PROCEDURE to &database_username 

/  

grant create SEQUENCE to &database_username 
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/  

grant create TABLE to &database_username 

/  

grant create TRIGGER to &database_username 

/  

grant create VIEW to &database_username 

/  

grant create MATERIALIZED VIEW to &database_username 

/  

grant olap_user to &database_username 

/ 

grant select on SYS.V_$PARAMETER to &database_username 

/ 

grant create SYNONYM to &database_username 

/ 

1166..33  GGrraannttss  oonn  CCoonnffiigg  SScchheemmaa  EEnnttiittiieess  ffoorr  AAttoommiicc  UUsseerrss  

Atomic Schema creation requires certain grants for config schema object access. This can be 

located in $FIC_HOME/config_table_privileges_for_atomic_user.sql file.  

The following are the Grants for Config Schema entities for Atomic Users: 

grant select on CSSMS_USR_PROFILE to &database_username 

/ 

grant select on CSSMS_ROLE_MAST to &database_username 

/ 

grant select on CSSMS_GROUP_MAST to &database_username 

/ 

grant select on CSSMS_FUNCTION_MAST to &database_username 

/ 

grant select on CSSMS_USR_GROUP_MAP to &database_username 

/ 

grant select on CSSMS_USR_GROUP_DSN_SEG_MAP to &database_username 

/ 

grant select on CSSMS_ROLE_FUNCTION_MAP to &database_username 

/ 

grant select on CSSMS_GROUP_ROLE_MAP to &database_username 

/ 

grant select on CSSMS_SEGMENT_MAST to &database_username 

/ 

grant select on BATCH_TASK to &database_username 

/ 

grant select on CSSMS_USR_DSN_SEG_MAP to &database_username 

/ 

grant select on CSSMS_USR_ROLE_MAP to &database_username 

/ 

grant select on CSSMS_METADATA_SEGMENT_MAP to &database_username 

/ 

grant select on BATCH_RUN to &database_username 

/ 

grant select on PR2_FILTERS to &database_username 
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/ 

grant select on PR2_TASK_FILTER to &database_username 

/ 

grant select on PR2_TASK_FILTER_DETAIL to &database_username 

/ 

grant select on ST_STRESS_MASTER to &database_username 

/ 

grant select on ST_SCENARIO_MASTER to &database_username 

/ 

grant select on ST_SHOCK_MASTER to &database_username 

/ 

grant select on BATCH_MASTER to &database_username 

/ 

grant select on ICC_MESSAGELOG to &database_username 

/ 

grant select on PR2_MASTER to &database_username 

/ 

grant select on PR2_RUN_REQUEST to &database_username 

/ 

grant select on MF_MODEL_SCRIPT_MASTER to &database_username 

/ 

grant select on MF_INPUT_VALUES to &database_username 

/ 

grant select on MF_MODEL_OUTPUT_VALUES to &database_username 

/ 

grant select on DB_MASTER to &database_username 

/ 

grant select on DSNMASTER to &database_username 

/ 

grant select on pr2_rule_map to &database_username 

/ 

grant delete on pr2_rule_map_pr to &database_username 

/ 

grant insert on pr2_rule_map_pr to &database_username 

/ 

grant update on pr2_rule_map_pr to &database_username 

/ 

grant select on pr2_rule_map_pr to &database_username 

/ 

grant delete on pr2_rule_map_pr_tmp to &database_username 

/ 

grant insert on pr2_rule_map_pr_tmp to &database_username 

/ 

grant update on pr2_rule_map_pr_tmp to &database_username 

/ 

grant select on pr2_rule_map_pr_tmp to &database_username 

/ 

grant select on pr2_rule_map_exclude to &database_username 

/ 

grant delete on pr2_rule_map_exclude_pr to &database_username 

/ 

grant insert on pr2_rule_map_exclude_pr to &database_username 

/ 
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grant update on pr2_rule_map_exclude_pr to &database_username 

/ 

grant select on pr2_rule_map_exclude_pr to &database_username 

/ 

grant delete on pr2_rule_map_exclude_pr_tmp to &database_username 

/ 

grant insert on pr2_rule_map_exclude_pr_tmp to &database_username 

/ 

grant update on pr2_rule_map_exclude_pr_tmp to &database_username 

/ 

grant select on pr2_rule_map_exclude_pr_tmp to &database_username 

/ 

grant select on pr2_run_object to &database_username 

/ 

grant select on pr2_run_object_member to &database_username 

/ 

grant select on pr2_run_map to &database_username 

/ 

grant select on pr2_run_execution_b to &database_username 

/ 

grant select on pr2_run_execution_filter to &database_username 

/ 

grant select on pr2_firerun_filter to &database_username 

/ 

grant select on pr2_filters to &database_username 

/ 

grant select on configuration to &database_username 

/ 

grant select on batch_parameter to &database_username 

/ 

grant select on component_master to &database_username 

/ 

grant select on MDB_OBJECT_TYPE_ATT_LAYOUT to &database_username 

/ 

grant select on REV_OBJECT_ATTRIBUTE_DTL to &database_username 

/ 

grant select on FORMS_LOCALE_MASTER to &database_username 

/ 

grant select on mdb_object_dependencies to &database_username 

/ 

grant select on mdb_execution_details to &database_username 

/ 

grant select on REV_STAT_DATA to &database_username 

/ 

grant select on REV_OBJECT_REPOSITORY_B to &database_username 

/ 

grant select on REV_OBJECT_REPOSITORY_TL to &database_username 

/ 

grant select on REV_OBJECT_ATTRIBUTE_DTL_MLS to &database_username 

/ 

grant select on REV_OBJECT_APPLICATION_MAP to &database_username 

/ 

grant select on MDB_OBJ_EXPR_DETAILS to &database_username 
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/ 

grant select on MDB_EXECUTION_DETAILS to &database_username 

/ 

grant select on REV_OBJECT_TYPES_CD to &database_username 

/ 

grant select on REV_OBJECT_TYPES_MLS to &database_username 

/ 

grant select on REV_APPLICATIONS_CD to &database_username 

/ 

grant select on REV_APPLICATIONS_MLS to &database_username 

/ 

grant select on METADATA_BROWSER_LOCALE to &database_username 

/ 

grant select on MDB_STAT_DATA to &database_username 

/ 

grant select on MDB_OBJECT_TYPE_LAYOUT to &database_username 

/ 

grant select on ofsa_md_id_ref to &database_username 

/ 

grant select on MDB_ETL_MAPPING to &database_username 

/ 

grant select on setupinfo to &database_username 

/ 

grant select on LOCALEREPOSITORY to &database_username 

/ 

grant select on MF_MODEL_MASTER to &database_username 

/ 

grant select on MF_SANDBOX_MASTER to &database_username 

/ 

grant select on MF_VARIABLE_MASTER to &database_username 

/ 

grant select on MF_TECHNIQUE_MASTER to &database_username 

/ 

grant select on MDB_RULE_SOURCE_HEADER to &database_username 

/ 

grant select on MDB_RULE_TARGET_HEADER to &database_username 

/ 

grant select on MDB_RULE_TARGET_MEMBER_HEADER to &database_username 

/ 

grant select on MDB_RULE_GRID_DATA to &database_username 

/ 

grant select on MDB_MODEL_MAPPING to &database_username 

/ 

grant delete on AAI_MAP_MAPPER to &database_username 

/ 

grant insert on AAI_MAP_MAPPER to &database_username 

/ 

grant update on AAI_MAP_MAPPER to &database_username 

/ 

grant select on AAI_MAP_MAPPER to &database_username 

/ 

grant select on RTI_UI_EXCLUDE_PDM_LIST  to &database_username 

/ 
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grant select on RTI_VIR_PHY_TBL_NAME  to &database_username 

/ 

grant select on infodom_patches to &database_username 

/ 
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1177  AAppppeennddiixx  KK::  CCoonnffiigguurriinngg  DDMM  PPaacckk  XXMMLL  FFiilleess  

1177..11    OOFFSS__DDMM__PPAACCKK..xxmmll  

The OFS_DM_PACK.xml file holds details on the various products that are packaged together in 

DM Application Pack.  

This section details the various tags/ parameters available in the file and the values that need to 

be updated. Prior to installing the DM Application Pack in SILENT mode, it is mandatory to 

update this file.  

 

1177..11..11  CCoonnffiigguurriinngg  OOFFSS__DDMM__PPAACCKK..XXMMLL  ffiillee  

The OFS_DM_PACK.xml file holds details on the various OFSAA products that are packaged in a 

particular Application Pack.  

The following table gives details about the various tags/ parameters available in the file and the 

values that need to be updated. Prior to installing the OFSAA Application Pack in SILENT mode, 

it is mandatory to update this file.  

NOTE:  If you are installing in the GUI mode, then this file need not be updated. 

OFS_DM_PACK.XML Parameters 

Tag Name/ Attribute Name Description Mandatory  

(Y/ N) 

Default Value/ 

Permissible Value 

Comments 

APP_PACK_ID Unique 

Application 

Y Unique Seeded 

Value  

DO NOT modify 

this value. 
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Tag Name/ Attribute Name Description Mandatory  

(Y/ N) 

Default Value/ 

Permissible Value 

Comments 

Pack Identifier 

APP_PACK_NAME Unique 

Application 

Pack Name 

Y Unique Seeded 

Value 

DO NOT modify 

this value. 

APP_PACK_DESCRIPTION Unique 

Application 

Pack 

Description 

Y Unique Seeded 

Value 

DO NOT modify 

this value. 

VERSION Unique release 

version 

Y Unique Seeded 

Value 

DO NOT modify 

this value. 

APP Unique 

Application 

Entries 

Y Unique Seeded 

Value 

DO NOT remove 

these tags. 

APP_ID Unique 

Application 

Identifier 

Y Unique Seeded 

Value 

DO NOT modify 

this value. 

APP_ID/ PREREQ Prerequisite 

Application/ 

Product 

Y Unique Seeded 

Value 

For most 

applications 

Infrastructure 

would be the 

prerequisite set. 

For certain other 

applications, an 

appropriate 

Application ID 

would be set. 

DO NOT modify 

this value. 

APP_ID/ DEF_SEL_FLAG Default 

Selected Flag 

Y Default - YES In all Application 

Packs, 

Infrastructure 

would have this 

value set to 

“YES”. DO NOT 
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Tag Name/ Attribute Name Description Mandatory  

(Y/ N) 

Default Value/ 

Permissible Value 

Comments 

modify this value. 

APP_ID/ ENABLE Enable 

Application/ 

Product 

YES if 

installing 

in 

SILENT 

mode. 

Default:  

YES for 

Infrastructure 

NO for Others 

Permissible: YES 

or NO 

Set this attribute-

value to YES 

against every 

APP_ID which is 

licensed and 

should be 

enabled for use. 

 

Note: Application/ 

Product once 

enabled cannot 

be disabled. 

However, 

Application/ 

Product not 

enabled during 

installation can be 

enabled later 

through the 

Administration UI. 

APP_NAME Unique 

Application/ 

Product Name 

Y Unique Seeded 

Value 

DO NOT modify 

this value. 

APP_DESCRIPTION Unique 

Application/ 

Product Name 

Y Unique Seeded 

Value 

DO NOT modify 

this value. 

VERSION Unique release 

version 

Y Unique Seeded 

Value 

DO NOT modify 

this value. 
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1177..22  OOFFSS__DDMM__SSCCHHEEMMAA__IINN..xxmmll  

The OFS_DM_SCHEMA_IN.XML file contains details on the various application schemas that 

should be created prior to the DM Application Pack installation.  

This section details the various tags/ parameters available in the file and the values that need to 

be updated. Prior to executing the schema creator utility, it is mandatory to update this file. 

 

 

1177..22..11  CCoonnffiigguurriinngg  OOFFSS__DDMM__SSCCHHEEMMAA__IINN..XXMMLL  ffiillee  

Creating database schemas, object within schemas and assigning appropriate grants are the 

primary steps in the installation process of OFSAA Applications.  The OFS_DM_SCHEMA_IN.xml 

file contains details on the various application schemas that should be created prior to the 

Application Pack installation.  

The following table gives details about the various tags/ parameters available in the file and the 

values that need to be updated. Prior to executing the schema creator utility, it is mandatory to 

update this file. 

OFS_DM_SCHEMA_IN.XML 

Tag Name/  

Attribute Name 

Description Mandatory 

(Y/N) 

Default Value/  

Permissible Value 

Comments 

<APP_PACK_ID> Unique Application 

Pack Identifier 

Y Unique Seeded Value  DO NOT modify this 

value. 

<JDBC_URL> Enter the JDBC URL. 

Note: You can enter 

RAC and NON-RAC 

enabled database 

connectivity URL. 

Y Example,  

jdbc:oracle:thin:@<HOST/IP>:<

PORT>:<SID> 

or 

jdbc:oracle:thin:@//[HOST][:PO

RT]/SERVICE 

or 
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Tag Name/  

Attribute Name 

Description Mandatory 

(Y/N) 

Default Value/  

Permissible Value 

Comments 

jdbc:oracle:thin:@(DESCRIPTI

ON=(ADDRESS_LIST=(ADDRE

SS=(PROTOCOL=TCP)(HOST

=[HOST])(port=[PORT]))(ADDR

ESS=(PROTOCOL=TCP)(HOS

T=[HOST])(PORT=[PORT]))(LO

AD_BALANCE=yes)(FAILOVER

=yes))(CONNECT_DATA=(SER

VICE_NAME=[SERVICE])))  

For example, 

jdbc:oracle:thin:@//dbhost.serve

r.com:1521/service1  

or 

jdbc:oracle:thin:@//dbshost.serv

er.com:1521/scan-1 

or 

jdbc:oracle:thin:@(DESCRIPTI

ON=(ADDRESS_LIST=(ADDRE

SS=(PROTOCOL=TCP)(HOST

=dbhost1.server.com)(port=152

1))(ADDRESS=(PROTOCOL=T

CP)(HOST=dbhost2.server.com

)(PORT=1521))(LOAD_BALAN

CE=yes)(FAILOVER=yes))(CO

NNECT_DATA=(SERVICE_NA

ME=service1))) 

<JDBC_DRIVER> By default this driver 

name is seeded.  

Note: Do not edit this 

attribute value. 

Y Example,  

oracle.jdbc.driver.OracleDriver 

Only JDBC Thin 

Driver is supported. 

DO NOT modify this 

value. 

<HOST> Enter the Hostname/ IP 

Address of the system 

on which you are 

installing the OFSAA 

components. 

Y  

Host Name/ IP Address 
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Tag Name/  

Attribute Name 

Description Mandatory 

(Y/N) 

Default Value/  

Permissible Value 

Comments 

<SETUPINFO>/ NAME Enter the acronym 

for the type of 

implementation. This 

information will be 

displayed in the 

OFSAA Home Page. 

Note: On executing the 

schema creator utility, 

this value will be 

prefixed with each 

schema name. For 

example: 

dev_ofsaaconf, 

uat_ofsaaatm. 

Y Accepts strings with a 

minimum length of two and 

maximum of four. 

Example,  

DEV, SIT, PROD 

This name would 

appear in the OFSAA 

Landing Page as 

“Connected To: xxxx” 

The schemas being 

created would get this 

prefix. For E.g. 

dev_ofsaaconf, 

uat_ofsaaconf etc. 

<SETUPINFO>/ 

PREFIX_SCHEMA_NA

ME 

Identifies if the 

value specified in 

<SETUPINFO>/ 

NAME attribute 

should be prefixed 

to the schema 

name. 

N  YES or NO Default value is YES. 

<PASSWORD>/ 

APPLYSAMEFORALL 

Enter as Y if you want 

to apply the password 

specified in DEFAULT 

attribute for all the 

schemas.  

If you enter as N, you 

need to provide 

individual passwords 

for all schemas. 

Note: In case you have 

entered Y in 

APPLYSAMEFORALL 

attribute and also have 

specified individual 

Y Default – N 

Permissible – Y or N 

Note: Setting this 

attribute value is 

mandatory, If 

DEFAULT attribute is 

set. 
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Tag Name/  

Attribute Name 

Description Mandatory 

(Y/N) 

Default Value/  

Permissible Value 

Comments 

passwords for all the 

schemas, then the 

specified individual 

passwords will take 

precedence. 

<PASSWORD>/ 

DEFAULT* 

Enter the password 

if you want to set a 

default password for 

all schemas. 

Note: You also need 

to set 

APPLYSAMEFORA

LL attribute as Y to 

apply the default 

password for all the 

schemas. 

N The maximum length 

allowed is 30 characters. 

Special characters are not 

allowed. 

 

<SCHEMA>/ TYPE The different types of 

schemas that are 

supported in this 

release are  ATOMIC, 

CONFIG, SANDBOX, 

and ADDON. 

By default, the 

schemas types are 

seeded based on the 

Application Pack.  

Note: Do not edit this 

attribute value. 

 

Y ATOMIC/CONFIG/SANDBOX/A

DDON 

 

Note:  

SANDBOX AND ADDON 

schemas are not applicable for 

OFS AAAI Application Pack. 

Only One CONFIG 

schema can exist in 

the file. 

This schema identifies 

as the 

CONFIGURATION 

schema that holds the 

OFSAA setup details 

and other metadata 

information. 

Multiple ATOMIC/ 

SANDBOX/ ADDON 

schemas can exist in 

the file. 

ATOMIC schema 

refers to the 

Information Domain 

schema. SANDBOX 

schema refers to the 

SANDBOX schema. 
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Tag Name/  

Attribute Name 

Description Mandatory 

(Y/N) 

Default Value/  

Permissible Value 

Comments 

ADDON schema 

refers to other 

miscellaneous 

schema (not 

applicable for this 

Application Pack).  

<SCHEMA.>/ NAME By default, the 

schemas names are 

seeded based on 

the Application 

Pack. 

You can edit the 

schema names if 

required.  

Note: 

The Schema Name 

will have a prefix of 

the SETUPINFO/ 

NAME attribute. 

SCHEMA NAME 

must be same for all 

the ATOMIC 

Schemas of 

applications within 

an Application Pack. 

Y The permissible length is 15 

characters and only 

alphanumeric characters 

allowed. No special characters 

allowed except underscore ‘_’. 

SETUPINFO/ NAME 

attribute value would 

be prefixed to the 

schema name being 

created. 

For E.g. if name is set 

as ‘ofsaaatm’ and 

setupinfo as ‘uat’ then 

schema being created 

would be 

‘uat_ofsaaatm’.  

NAME should be 

same where 

APP_GRP=1 for all 

SCHEMA tags (Not 

applicable for this 

Application Pack). 

<SCHEMA>/ 

PASSWORD* 

Enter the password of 

the schema to be 

created.  

Note:  

If this attribute is left 

blank, then the 

password specified in 

the 

<PASSWORD>/DEFA

ULT attribute is applied 

N 

 

The maximum length allowed is 

30 characters. Special 

characters are not allowed. 

Note: You need to 

mandatorily enter the 

password if you have 

set the 

<PASSWORD>/ 

APPLYSAMEFORALL 

attribute as N. 
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Tag Name/  

Attribute Name 

Description Mandatory 

(Y/N) 

Default Value/  

Permissible Value 

Comments 

as the Schema 

Password. 

 

<SCHEMA>/ APP_ID By default, the 

Application ID is 

seeded based on 

the Application 

Pack.  

Note: Do not edit this 

attribute value. 

Y Unique Seeded Value Identifies the 

Application/ Product 

for which the schema 

is being created. 

DO NOT modify this 

value. 

<SCHEMA>/ 

DEFAULTTABLESPAC

E 

Enter the available 

default tablespace 

for DB User. 

Note:  

If this attribute is left 

blank, then USERS is 

set as the default 

tablespace. 

N Default – USERS 

Permissible – Any existing valid 

tablespace name. 

 

Modify this value to 

associate any valid 

tablespace with the 

schema. 

<SCHEMA>/ 

TEMPTABLESPACE 

Enter the available 

temporary 

tablespace for the 

DB User.  

Note:  

If this attribute is left 

blank, then TEMP is 

set as the default 

tablespace. 

N Default – TEMP 

Permissible – Any existing valid 

temporary tablespace name. 

Modify this value to 

associate any valid 

tablespace with the 

schema. 

<SCHEMA>/ QUOTA Enter the quota to be 

set on 

DEFAULTTABLESPAC

E attribute for the 

schema/ user. By 

default, the quota size 

is set to 500M. 

N Example,  

600M/m 

20G/g 

UNLIMITED/unlimited 

 

Modify this value to 

grant the specified 

quota on the 

mentioned tablespace 

to the user.  
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Tag Name/  

Attribute Name 

Description Mandatory 

(Y/N) 

Default Value/  

Permissible Value 

Comments 

Minimum: 500M or 

Unlimited on default 

Tablespace 

<SCHEMA>/ 

INFODOM 

Enter the name of 

the Information 

Domain to associate 

this schema. 

The schema creator 

utility automatically 

derives an 

Information Domain 

Name based on the 

Application Pack if 

no value is specified 

for this attribute. 

N 

(Optional for 

Atomic and 

mandatory for 

sandbox ) 

Permissible length is 16 

characters and only 

alphanumeric characters 

allowed. No special 

characters allowed. 

Enter this field in 

UPPERCASE. 

*On successful execution of the utility, the entered passwords in the OFS_DM_SCHEMA_IN.xml file are nullified. 
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1188  AAppppeennddiixx  LL::  OOFFSSAAAAII__IInnssttaallllCCoonnffiigg..xxmmll  ffiillee  

1188..11  CCoonnffiigguurriinngg  OOFFSSAAAAII__IInnssttaallllCCoonnffiigg..xxmmll  ffiillee  

1. Navigate to OFS_DM_PACK/OFS_AAI/conf/ 

2. Open the file OFSAAI_InstallConfig.xml in text editor. 

3. Configure the OFSAAI_InstallConfig.xml as mentioned in the below table: 

4. You need to manually set the InteractionVariable parameter values as mentioned in the 

table. If a value is not applicable, enter NA and ensure that the value is not entered as 

NULL. 

InteractionVariable Name Significance and Expected Value Mandatory 

Y/N 

<Layer name="GENERAL"> 

WEBAPPSERVERTYPE Identifies the web application server on which the OFSAA 

Infrastructure web components would be deployed. 

The below numeric value should be set depending on the type: 

Apache Tomcat = 1 

IBM WebSphere Application Server = 2 

Oracle WebLogic Server = 3 

For example,  <InteractionVariable 

name="WEBAPPSERVERTYPE">3</InteractionVari able> 

Yes 

DBSERVER_IP Identifies the hostname or IP address of the system on which the 

Database Engine is hosted. 

Note: For RAC Database , the value should be NA. 

For example, <InteractionVariable name="DBSERVER_ 

IP">14.15.16.17</InteractionVariable> or 

<InteractionVariable name="DBSERVER_ 

IP">dbhost.server.com</InteractionVariable 

> 

Yes 
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InteractionVariable Name Significance and Expected Value Mandatory 

Y/N 

ORACLE_SID/SERVICE_ 

NAME 

Identifies the Oracle DB Instance SID or SERVICE_NAME 

Note: The Oracle_SID value should be exactly the same as it is 

mentioned in JDBC_URL. 

For example, <InteractionVariable 

name="ORACLE_SID/SERVICE_ 

NAME">ofsaser</InteractionVariable> 

Yes 

ABS_DRIVER_PATH Identifies the directory where the JDBC driver (ojdbc<version>.jar) 

exists. This would typically be the 

$ORACLE_HOME/jdbc/lib 

For example, <InteractionVariable name="ABS_DRIVER_ 

PATH">">/oradata6/revwb7/oracle 

</InteractionVariable> 

Note: Refer Appendix N for identifying the correct 

“ojdbc<version>.jar” version to be copied. 

 

Yes 

OLAP_SERVER_ 

IMPLEMENTATION 

Identifies if the OFSAA Infrastructure OLAP component needs to 

be configured depending on whether you intend to use the OLAP 

feature. The below numeric value should be set depending on the 

choice: 

YES - 1 

NO - 0 

No 

Note: If value for OLAP_SERVER_IMPLEMENTATION  is set to 1, it checks for following environment variables are set in .profile: 

ARBORPATH, HYPERION_HOME and ESSBASEPATH. 

SFTP_ENABLE Identifies if the SFTP (Secure File Transfer Protocol) feature is to 

be enabled. The below numeric value should be set depending on 

the choice: 

SFTP - 1 

FTP - 0 

Yes 
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InteractionVariable Name Significance and Expected Value Mandatory 

Y/N 

Note: The default value set is 1 as this release of the OFSAA Infrastructure mandates the SFTP service be up and running on the 

system where OFSAA Infrastructure would be installed. 

For example, <InteractionVariable name="SFTP_ENABLE">0</InteractionVariable> 
FILE_TRANSFER_PORT Identifies the port used for the file transfer service. The default 

value specified is 22 (SFTP). Specify value as 21 or any other 

PORT value if value for SFTP_ENABLE is 0. 

For example, <InteractionVariable name="FILE_TRANSFER_ 

PORT">21</InteractionVariable> 

Yes 

LOCALE Identifies the locale information to be used during the installation. 

This release of the OFSAA Infrastructure supports only US English. 

For example, <InteractionVariable 

name="LOCALE">en_US</InteractionVariable> 

Yes 

Note: The below ports are used internally by the various OFSAA Infrastructure services. The default values mentioned below are 

set in the installation. If you intend to specify a different value, update the parameter value accordingly and ensure this port value is 

in the range of 1025  to 65535          and the respective port is enabled. 

JAVAPORT 9999 Yes 

NATIVEPORT 6666 Yes 

AGENTPORT 6510 Yes 

ICCPORT 6507 Yes 

ICCNATIVEPORT 6509 Yes 

OLAPPORT 10101 Yes 

MSGPORT 6501 Yes 

ROUTERPORT 6500 Yes 

AMPORT 6505 Yes 

Note: If value for HTTPS_ENABLE is set to 1, ensure you have a valid certificate available from a trusted CA and the same is 

configured on your web application server. 
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InteractionVariable Name Significance and Expected Value Mandatory 

Y/N 

HTTPS_ENABLE Identifies if the UI should be accessed using HTTP or HTTPS 

scheme. The default value set is 0. The below numeric value 

should be set depending on the choice: 

YES - 1 

NO - 0 

For example, <InteractionVariable 

name="HTTPS_ENABLE">0</InteractionVariable> 

Yes 

WEB_SERVER_IP Identifies the HTTP Server IP/ Hostname or Web Application 

Server IP/ Hostname, to be used for accessing the UI. This IP 

would typically be the HTTP Server IP. 

If no separate HTTP Server is available, the value should be Web 

Application Server IP/Hostname. 

For example, <InteractionVariable name="WEB_SERVER_ 

IP">10.11.12.13</InteractionVariable> 

or 

<InteractionVariable name="WEB_SERVER_ 

IP">myweb.server.com</InteractionVariable> 

No 

WEB_SERVER_PORT Identifies the Web Server Port. This would typically be 80 for non 

SSL and 443 for SSL. If no separate HTTP Server exists, the value 

should be the port configured for Web Application Server. 

Note: The port value will not be accepted as 80 if HTTPS_ENABLE 

is 1 and as 443, if HTTPS_ENABLE is 0. 

For example, <InteractionVariable name="WEB_ 

SERVER_PORT">80</InteractionVariable> 

Yes 
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InteractionVariable Name Significance and Expected Value Mandatory 

Y/N 

CONTEXT_NAME Identifies the web application context name which will be used to 

built the URL to access the OFSAA applications. The context name 

can be identified from a URL as below: 

<scheme>://<host>:<port>/<context-name>/lo gin.jsp 

Sample URL: 

https://myweb:443/ofsaadev/login.jsp 

For example, <InteractionVariable name="CONTEXT_ 

NAME">ofsaadev</InteractionVariable> 

Yes 

WEBAPP_CONTEXT_PATH Identifies the absolute path of the exploded .ear file on the web 

application server. 

For Tomcat, specify the Tomcat directory path till 

/webapps, such as 

/oradata6/revwb7/tomcat/webapps/. 

For WebSphere, enter the WebSphere path as 

<WebSphere profile directory>/installedApps/ 

<NodeCellName>. For example, 

/data2/test//WebSphere/AppServer/profiles/ 

<Profile_ 

Name>/installedApps/aix-imfNode01Cell. Where aix-imf is Host 

name. 

For WebLogic, provide the WebLogic home directory path as 

/<WebLogic home directory path>/bea/wlserver_10.3 

Yes 

WEB_LOCAL_PATH Identifies the absolute path to any directory on the web application 

server that can hold temporary files being uploaded as part of the 

applications usage. 

Note: In case of a clustered deployment, ensure this path and 

directory is same on all the nodes. 

Yes 
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InteractionVariable Name Significance and Expected Value Mandatory 

Y/N 

WEBLOGIC_DOMAIN_HOM

E 

Identifies the WebLogic Domain Home. 

For example, <InteractionVariable name="WEBLOGIC_DOMAIN_ 

HOME">/home/weblogic/bea/user_ projects/domains/mydomain 

</InteractionVariable> 

Yes  

Specify the 

value only if 

WEBSERVER

TYPE is set as 

3 (WebLogic) 

OFSAAI_FTPSHARE_PATH Identifies the absolute path to the directory identified as file system 

stage area. 

Note:  

1.The directory should exist on the same system on which the 

OFSAA Infrastructure is being installed (can be on a separate 

mount). 

2.The user mentioned in APP_SFTP_USER_ID parameter below 

should have RWX permission on the directory. 

For example, <InteractionVariable 

name="APP_FTPSHARE_PATH">">/oradata6/revwb7/ftpshare</In

teractionVariable> 

Yes 

OFSAAI_SFTP_USER_ID Identifies the user who has RWX permissions on the directory 

identified under parameter APP_FTPSHARE_PATH above. 

Yes 
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1199  AAppppeennddiixx  MM::  MMiiggrraattiioonn  ffoorr  EExxcceell  UUppllooaadd  

This appendix provides detailed instructions to migrate for excel upload. 

1199..11..11  PPrreerreeqquuiissiitteess  

 Data model in ATOMIC schemas should be same on the source and target setups. 

 OFS AAI (platform) patch level version should be same on the source and target setups. 

 PL/SQL Developer to connect and query the database. 

 WinSCP to connect and access server file system. 

1199..11..22  MMiiggrraattiioonn  ffoorr  EExxcceell  UUppllooaadd  

To migrate, follow these steps: 

1. Open PL/SQL Developer and logon to the source setup’s configuration (CONFIG) 

schema by entering the appropriate username and password. 

2. In a new SQL window query the data of table EXCEL_MAPPING_MASTER.  

3. Open a new session in PL/SQL developer and logon to the target setup’s configuration 

(CONFIG) schema by entering the appropriate username and password.  

4. Insert the records from Step 1 above in to this table. 

5. In V_INFODOM column of EXCEL_MAPPING_MASTER table update the infodom name 

with the target infodom name. 

NOTE:  If all the mappings can work out of the single target Infodom, update same Infodom value 

across all rows. If only few mappings will work out of the target infodom, update the infodom 

value for selective records. Kindly note, excel upload mappings will work only if the target 

infodom has same data model entities as used in the mappings defined on source setup. 

6. Update V_CREATED_BY column with the name of any user present in the target setup 

that has appropriate roles to perform Excel Upload tasks. 

NOTE:  It is mandatory to update values for V_INFODOM and V_CREATED_BY columns. 

7. Open WinSCP and login a new session by entering the host name, port number, user 

name and password to access the source setup.  

8. Navigate to the folder referred as FTPSHARE. 
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9. Copy the excel-entity mapping xml file(s) which are located in this folder according to 

their folder structure on to your desktop. For example: /ftpshare 

/STAGE/ExcelUpload/$SOURCE_INFODOM_NAME/$EXCEL_FILE_NAME.xml 

NOTE:  Actual file name of Excel Sheet is mentioned in the V_EXCEL_NAME column of 

EXCEL_MAPPING_MASTER table. 

10. Copy the excel templates (.xls/ .xlsx) file(s) which are located in this folder according to 

their folder structure on to your desktop. For example: 

/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx 

NOTE:  Ignore this step if files are not present at the location. 

11. Login a new session in WinSCP by entering the host name, port number, user name 

and password to access the target setup.  

12. Copy  the xml file(s) from Step3 to the below location in the target setup. For example: 

/ftpshare/STAGE/ExcelUpload/$TARGET_INFODOM_NAME/$EXCEL_FILE_NAME

.xml 

NOTE:  $TARGET_INFODOM_NAME should be target setup infodom in which you have uploaded the 

appropriate data model and the name should be same as the V_INFODOM column value 

updated in EXCEL_MAPPING_MASTER table. 

13. Copy the xls/ xlsx file(s) from Step 3 to the below location in target setup. For example: 

/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx 

NOTE:  Ignore this step if files are not present at the location. 
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2200  AAppppeennddiixx  NN::  JJDDBBCC  JJaarr  FFiilleess  

The ojdbc<version>.jar file should be copied based on Database & Java version. Refer to 

the following table for details.  

Oracle Database 

version 

JDK Version supported JDBC Jar files specific to the 

release 

12.1 or 12cR1 JDK 7 and JDK 8 ojdbc7.jar for JDK 7/JDK 8 

11.2 or 11gR2 JDK 7 and JDK 8 supported in 11.2.0.3 and 

11.2.0.4   

ojdbc6.jar for JDK 7 / JDK 8 
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2211  AAppppeennddiixx  OO::  UUppggrraaddiinngg  aann  EExxiissttiinngg  OOFFSSAAAA  88..00..xx  JJaavvaa  77  IInnssttaannccee  

ttoo  JJaavvaa  88  

This section explains the configurations required to upgrade an existing OFSAA 8.0.x Java 7 instance to 

Java 8. It consists of the following topics: 

 Prerequisites 

 Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8 

 Web Application Server Configurations 

 OFSAA Generic Configurations 

 OFSAA Configurations for New Web Application Server Installation 

2211..11  PPrreerreeqquuiissiitteess  

The following are the prerequisites for upgrading OFSAA 8.0.x Java 7 instance to Java 8: 

 Java 8 should be installed on the OFSAA server and Web Application Server. 

 Oracle WebLogic Server should be 12.1.3.0 or above. Download and install patch 18729264 from 

http://support.oracle.com/ for the same. 

NOTE:  IBM WebSphere 8.5.x (Full Profile) on Java 8 is not available. 

2211..22  SStteeppss  ffoorr  uuppggrraaddiinngg  OOFFSSAAAA  88..00..xx  JJaavvaa  77  iinnssttaannccee  ttoo  JJaavvaa  88  

To upgrade OFSAA 8.0.x Java 7 instance to Java 8, follow these steps: 

1. Configure Web Application Server to Java 8. For more information, refer Web Application Server 

Configurations. 

2. Configure the OFSAA instance to Java 8. For more information, refer OFSAA Generic 

Configurations. For a newly installed Web Application Server, refer OFSAA Configurations for 

New Web Application Server Installation 

3. Restart the OFSAA services. For more information, refer the Start/Stop Infrastructure Services 

section in Appendix D 

4. Generate the application EAR/WAR file and redeploy the application onto your configured web 

application server. For more information on generating and deploying EAR / WAR file, refer 

Appendix C. 

2211..33  WWeebb  AApppplliiccaattiioonn  SSeerrvveerr  CCoonnffiigguurraattiioonnss  

This section describes the changes to be made in the Web Application Server. Following are the two 

options to perform Web Application Server Configurations which are listed as follows: 

 Upgrade the existing Web Application Server installation to Java 8 

 Install a new instance of the Web Application Server with Java 8 

This section consists of the following topics: 

http://support.oracle.com/
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 Oracle WebLogic Server Updates 

 Apache Tomcat Server Updates 

2211..33..11  OOrraaccllee  WWeebbLLooggiicc  SSeerrvveerr  UUppddaatteess  

Perform the following configurations to upgrade the existing WebLogic server instance to Java 8: 

1. Navigate to <WLS_HOME>/Middleware/Oracle_Home/wlserver. 

2. Edit the product.properties file. Set JAVA_HOME, WLS_JAVA_HOME, JAVAHOME properties 

to the new Java path and java.vm.version to the new Java version. For example, 

JAVA_HOME=/usr/java/jdk1.8.0_45 

WLS_JAVA_HOME=/usr/java/jdk1.8.0_45 

JAVAHOME=/usr/java/jdk1.8.0_45 

java.vm.version=1.8.0_45 

3. Navigate to 

<WLS_HOME>/Middleware/Oracle_Home/user_projects/domains/<domain>/bin. 

Update SUN_JAVA_HOME, DEFAULT_JAVA_HOME, JAVA_HOME in the setDomainEnv.sh file to 

point to the new Java path. For example, 

SUN_JAVA_HOME="/usr/java/jdk1.8.0_45" 

DEFAULT_SUN_JAVA_HOME="/usr/java/jdk1.8.0_45" 

JAVA_HOME="/usr/java/jdk1.8.0_45" 

4. Clear the Application cache. Navigate to the following path and delete the files: 

<Weblogic installation location>/domains/<Domain name>/servers/<Server 

name>/tmp/_WL_user/<Application name>/qaelce/jsp_servlet 

If you wish to install a new instance of the Oracle WebLogic Server, follow these steps: 

1. Install Oracle WebLogic Server 12.1.3.x on Java 8. 

2. Perform the configurations for the newly installed WebLogic server. For more information refer 

Configuring Resource Reference in Weblogic Application Server. 

NOTE:  While creating WebLogic Domain, the Listen Port should be set same as that of the existing 

Domain. 

                  Note down the new Domain path to perform OFSAA Configurations. 

2211..33..22  AAppaacchhee  TToommccaatt  SSeerrvveerr  UUppddaatteess  

Perform the following configurations to upgrade the existing Apache Tomcat Server from Java 7 to Java 

8: 

1. Login to the Apache Tomcat Server as a non-root user. 
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2. Edit the user .profile. Update the value for JAVA_HOME from JRE 1.7 to JRE 1.8. For 

Example,x  

JAVA_HOME=/usr/java/jre1.8.0_45 

3. Clear the Application cache. Navigate to the following path and delete the files: 

<Tomcat installation folder>/work/Catalina/localhost/<Application 

name>/org/apache/jsp 

 

If you wish to install a new instance of the Apache Tomcat Server, follow these steps: 

1. Install Apache Tomcat Server 8 with Java 8. 

2. Perform the configurations for the newly installed Tomcat server. For more information refer 

Configuring Resource Reference in Tomcat Application Server. 

NOTE:  Update the Connector Port in /apache-tomcat-8.0.21/conf/server.xml file to that of 

the existing Tomcat instance. 

 Note down the new deployment path to perform OFSAA Configurations. 

2211..44  OOFFSSAAAA  GGeenneerriicc  CCoonnffiigguurraattiioonnss  

This section consists of the following topics: 

 User .profile Settings 

 Configurations for Java 8 

2211..44..11  UUsseerr  ..pprrooffiillee  SSeettttiinnggss  

Perform the following configurations: 

1. Login to the OFSAA Server as a non-root user. 

2. Edit the user .profile. Update the value for PATH variable from JRE 1.7 to JRE 1.8. For 

Example, 

PATH=/usr/java/jdk1.8.0_45/jre 

JAVA_BIN=/usr/java/jdk1.8.0_45/jre/bin 

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/java/jdk1.8.0_45/jre/lib/amd64/se

rver 

2211..44..22  CCoonnffiigguurraattiioonnss  ffoorr  JJaavvaa  88  

Perform the configurations explained in the section Configurations for Java 8 
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2211..55  OOFFSSAAAA  CCoonnffiigguurraattiioonnss  ffoorr  NNeeww  WWeebb  AApppplliiccaattiioonn  SSeerrvveerr  IInnssttaallllaattiioonn  

This configuration is required only if you have freshly installed Oracle WebLogic 12.1.3 or Apache Tomcat 

Server 8.0. Follow these steps: 

1. Modify the following parameters in the Configuration table present in the Config Schema with the 

new Domain Path in case of WebLogic or with the new deployment path in case of Tomcat: 

 DeFiHome 

 REV_IMG_PATH 

 EMBEDDED_JSP_JS_PATH 

 

2. Login to the OFSAA Server as a non-root user. 

 

3. Navigate to $FIC_HOME/ficweb/webroot/WEB_INF and update the following parameters in 

the web.xml file with the new Domain path in case of WebLogic or with the new deployment path 

in case of Tomcat: 

 FIC_PHYSICAL_HOME_LOC 

 FIC_HOME 

 ICC_SERVLET_LOG_FILE 

 

4. Navigate to $FIC_HOME/ficweb/webroot/conf and update the Domain path in case of 

WebLogic or with the new deployment path in case of Tomcat: 

 OFSAALogger.xml 

 MDBLogger.xml 

 RevLog4jConfig.xml 

 RFDLogger.xml 

 ExportLog4jConfig.xml 

 RFDLogger.xml 

 PR2Logger.xml 

 



   

 

Oracle Financial Services Software Confidential - Restricted 

227 

 

2222  AAppppeennddiixx  PP  ––  RReemmoovviinngg  OOFFSSAAAA  

This chapter includes the following sections: 

 Uninstalling OFSAA Infrastructure 

 Uninstalling EAR Files in WebSphere 

 Uninstalling EAR Files in WebLogic 

 Uninstalling WAR Files in Tomcat 

2222..11  UUnniinnssttaalllliinngg  OOFFSSAAAA  IInnffrraassttrruuccttuurree  

This section will guide you through the necessary steps to uninstall the OFSAA Infrastructure 

product. Before you start the uninstallation process, ensure that no open connections exist to the 

OFSAA Infrastructure Config and Atomic Schemas and Infrastructure services are brought down. 

To uninstall OFSAA Infrastructure: 

1. Log in to the system as non-root user. 

2. Navigate to the $FIC_HOME directory and execute the command: 

./Uninstall.sh 

3. Enter the password for OFSAAI Configuration Schema when prompted as shown in the following 

figure. 

 

NOTE:   

Uninstallation does not remove the Infrastructure application from the Web Application Server. This has to 

be done manually. 

The entries in the .profile file will have to be removed manually. 

The files/ folders under the file system staging area (ftpshare) have to be deleted manually. All the 

Database objects from Atomic Schemas have to be dropped manually. 
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2222..22  UUnniinnssttaalllliinngg  EEAARR  FFiilleess  iinn  WWeebbSSpphheerree  

Following are the steps to uninstall any previously deployed application: 

1. Open the URL in the browser window: http://<ipaddress>:<Administrative Console 

Port>/ibm/console (https if SSL is enabled). The Login window is displayed. 

2. Login with the user id that has admin rights. 

3. Expand Applications > Application Types > WebSphere enterprise applications from the LHS. 

The Enterprise Applications window is displayed with all the deployed applications. 

 

4. Select the checkbox adjacent to the application to be uninstalled and click Stop. 

5. Click Uninstall. The Uninstall Application window is displayed. 

 

6. Click OK to confirm. 

7. Click Save to save the master file configuration. 
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2222..33  UUnniinnssttaalllliinngg  EEAARR  FFiilleess  iinn  WWeebbLLooggiicc  

On the machine that hosts WebLogic, perform the following steps to uninstall any previously deployed 

application: 

1. Open the URL in the browser window: http://<ipaddress>:<admin server 

port>/console (https if SSL is enabled). The Login window of the WebLogic Server 

Administration Console is displayed. 

2. Login with the WebLogic user credentials having administrator privileges. 

3. From the Domain Structure LHS menu, click Deployments. The Summary of Deployments 

screen is displayed 

 

4. Select the checkbox adjacent to the application to be uninstalled and click Stop> Force Stop 

Now. 

5. Click Yes in the confirmation dialog to stop the selected deployment. 
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6. Select the checkbox adjacent to the application and click Delete to delete the selected 

deployment. 

7. Click Yes in the confirmation dialog to remove the selected deployment from the domain 

configuration. 

2222..44  UUnniinnssttaalllliinngg  WWAARR  FFiilleess  iinn  TToommccaatt  

On the machine that hosts Tomcat, perform the following steps to uninstall any previously 

deployed application: 

1. Comment out Context path section from server.xml file in $CATALINA_HOME/conf 

directory to avoid conflict during undeploy and re-deploy of the WAR file. 

Place comment <!-- --> in between the context path section. For 

example: 

<!-- 

<Context path ="/pr2test" docBase="/home/perfuser/tomcat-

7.0.19/webapps/pr2test" debug="0" reloadable="true" 

crossContext="true"> 

<Resource auth="Container" 

name="jdbc/PR2ATM" 

type="javax.sql.DataSource" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

username="pr2atm" 

password="pr2atm" 

url="jdbc:oracle:thin:@10.184.74.99:1521:PERFTEST" 

maxActive="100" 

maxIdle="30" 

maxWait="10000"/> 

</Context> 

--> 

Restart the Tomcat service by doing the following: 

a. Login to the "Unix server" through a terminal emulator. 

b. Navigate to $catalina_home/bin directory. 
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c. Stop the tomcat services using the command ./shutdown.sh 

d. Start the tomcat services using the command ./startup.sh 

2. Open the URL in a browser window: http://<IP address>:<Tomcat server port>. (https if 

SSL is enabled). The Tomcat home window is displayed. 

3. Click the Manager App. The Connect to window is displayed. 

4. Login with the user credentials having admin rights. The Tomcat Web Application 

Manager window is displayed with the list of all applications deployed in Tomcat. 

 

5. Click the Undeploy link against the deployed Infrastructure application. A confirmation 

message is displayed on the application /Infrastructure being uninstalled. 
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2233  AAppppeennddiixx  QQ::  FFAAQQss  aanndd  EErrrroorr  DDiiccttiioonnaarryy  

This section of the document consists of resolution to the frequently asked questions and error 

codes noticed during OFSAAI installation. 

 Frequently Asked Questions 

 Error Dictionary 

OFSAAI installer performs all the pre-requisite validation check during installation. Any errors 

encountered in the process are displayed with an appropriate Error Code. You can refer to the 

Error Dictionary to find the exact cause and resolution to rectify the error. 

2233..11  FFrreeqquueennttllyy  AAsskkeedd  QQuueessttiioonnss  

You can refer to the Frequently Asked Questions which has been developed with the interest to 

help you resolve some of the OFSAAI Installation and configuration issues. This intends to share 

the knowledge of problem resolution to a few of the known issues. This is not an official support 

document and just attempts to share the knowledge of problem resolution to a few of the known 

issues. 

This section includes the following topics: 

 OFSAAI FAQs 

 Application Pack 8.0.0.0.0 FAQs 

2233..11..11  OOFFSSAAAAII  FFAAQQss  

What are the different components that get installed during OFSAAI? 

The different components of OFSAAI are illustrated in Figure 1–1, "OFSAA Infrastructure 

Framework". 

If OFS AAI/ AAAI needs to be installed on different versions of an Operating System, which 

installer needs to be downloaded? 

OFS AAI/AAAI installer downloaded for a specific Operating System can be used to install on all 

its supported versions. 

For Solaris OS, only one installer OFSAAI_73300_Solaris is available and it can be used to install 

OFSAAI on both versions of Solaris, that is, v5.10 or v5.11. Similarly, the installer 

OFSAAI_73300_Linux can be used to install OFSAAI on all supported versions of Oracle Linux, 

that is, v 5.3 up to 5.10 and v6.0 and above. The installer OFSAAI_73300_AIX can be used to 

install OFSAAI on all supported versions of AIX, that is, v5.3 and v6.1. 

Same is applicable for OFSAAAI installers available for specific Operating Systems. 
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Can the OFSAA Infrastructure components be installed on multi-tier? 

No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed on multi-tier. By 

default, they will be installed on single-tier. However, OFSAA Infrastructure can be deployed 

within the n-Tier architecture where the Database, Web Server and Web Application Server is 

installed on separate tiers. 

What are the different modes of OFSAAI installation? 

OFSAAI can be installed in two modes, Silent Mode, and GUI mode. 

Is JDK (Java Development Kit) required during installation of OFSAA? Can it be 

uninstalled after OFSAA installation? 

JDK is not required during installation of OFSAA and only a run time is needed for details. Refer 

Hardware and Software Requirements, Java Runtime Environment section. 

Is JRE required during installation of OFSAA? Can it be uninstalled after OFSAAI 

installation?  

Only JRE (Java Runtime Environment) is required during installation of OFSAA and cannot be 

uninstalled as the JRE is used by the OFSAA system to work. 

How do I know what is the Operating system, webservers and other software versions that 

OFSAA supports? 

Refer to OFSAA Technology Stack Matrices. 

What are the different files required to install OFSAAI? 

The following files are required: 

 setup.sh. 

 envCheck.sh 

 preinstallcheck.sh 

 VerInfo.txt 

 OFSAAInfrastructure.bin 

 validatedXMLinputs.jar 

 MyResources_en_US.properties 

 log4j.xml 

 OFSAAI_PostInstallConfig.xml 

 OFSAAI_InstallConfig.xml 

 privileges_config_user.sql 
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 privileges_atomic_user.sql 

 XML_Utility.jar 

Is OFSAAI license specific to Applications? 

No, OFSAAI license is not specific to any application. 

Where can I reach out for the license key for installations? 

OFSAAI 7.3.3.0.0 installer does not need a license code or a license file. With the license 

agreement acceptance, one could proceed with the installation. 

During installation, when one gets an error message, "Execute Permission denied", what 

is to be done? 

Please check whether all the files provided for OFSAAI installation has execute permissions. 

To give execute permissions, 

Navigate to the path OFSAAI_73300 and execute the command 

chmod 755 

"Graphical installers are not." 

If error resembles "Graphical installers are not supported by the VM. The console mode will be 

used instead..." then check whether any of the X-windows software has been installed. 

Example: Hummingbird Exceed is started and configured to Graphical mode installation. 

NOTE:  Type 'xclock' from prompt and this should display clock in graphical mode. 

"No Java virtual machine could be…" 

If the error message reads "No Java virtual machine could be found from your PATH environment 

variable. You must install a VM prior to running this program", then 

 Check whether "java path" is set in PATH variable. See the Table, "Prerequisite 

Information" section in this document. 

 Check whether sufficient temporary space is available. 

 Ensure that the movement of OFSAAI Installer text files to the target system is done in the 

Text mode so that setup.sh file does not contain control line feed characters (^M). 

During the installation, what should one do if the error message shows "OracleDriver Files 

Not Found, Please Choose the Right Path To Continue"? 

Check whether the provided path for Oracle Driver files is correct and whether the user has 

permissions to access the files. 
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During installation, what is to be done if the error always reads "User must have CREATE 

TABLE, CREATE VIEW, CREATE TRIGGER, CREATE INDEX, CREATE SEQUENCE, 

CREATE PROCEDURE" even though the oracle schema user created has the mentioned 

privileges? 

OFSAAI installer validates the database details provided during installation, so ensure: 

 Whether the oracle schema user has the required set of privileges for successful 

installation. 

 Whether the oracle schema user has been created with quota privileges on tablespace to 

create database objects. 

See the "Prerequisite Information" section for more information. 

Installation of OFSAAI was completed successfully! What next? 

Post the successful completion of OFSAAI installation, one has to perform the Post Installation 

steps. See "Post Installation Configuration", for more information. 

What is to be done when OFSAAI Installation is unsuccessful? 

OFSAAI installer generates log file OFSAAInfrastructure_Install.log in the Infrastructure 

Installation Directory. There is also another log file created in the path configured in Log4j.xml. 

The logs of any of these reported, Warnings/Non Fatal Errors/Fatal Errors/Exceptions should be 

brought to the notice of the OFSAAI Customer Support. It is recommended not to proceed, until 

the reported problems are adequately addressed. 

How to grant privileges if a new information domain is created? 

If you are creating a new information domain, provide a set of privileges (database permissions) 

to the new Atomic schema. 

 Log into the database as sys and connect as sysdba user. 

 Execute the file privileges_config_user.sql available under $FIC_HOME directory 

 Enter the database schema for which you want to grant privileges. 

When should I run the MLS utility? 

See the Multiple Language Support (MLS) Utility section in OFSAAI Administration Guide in the 

Documentation Library for OFSAAI 8.0.0.0.0 . 

Does OFSAAI support Oracle Linux versions other than 5.5? 

OFSAAI supports the Oracle Linux versions from 5.5 up to 5.10. 

On the UNIX System terminal, error message shows "Insert New Media. Please insert 

Disk1 or type it's location"while executing ./setup.sh, what should be done? 

http://docs.oracle.com/cd/E60058_01/homepage.htm
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1. Login as root user on the Unix machine where OFSAAI is getting installed. 

2. Navigate to the path /etc/security/. 

3. Edit the file limits.conf to add/edit a row for the unix user installing OFSAA: 

Unix User> soft nofile 9216 

4. After saving the changes, log in as unix user with which OFSAAI is getting installed and 

execute the command: 

ulimit -n 

5. The command should return the value 9216. 

How does one verify if the system environment is ready for OFSAAI installation? 

To verify the system environment meets the minimum requirements for the installation, a Pre-

Install Check utility is available within the Install Kit archive file. This utility can also be obtained 

separately by contacting Oracle Support. 

See Verifying the System Environment section for additional information. 

How does one know if the installation is completed successfully? 

The OFSAA Infrastructure installation performs a post install health check automatically on 

successful installation of the product. To rerun the post install verification at a later time, perform 

the following steps: 

1. Navigate to the path $FIC_HOME (Product Installation Directory). 

2. Execute the command: 

./piverify.sh 

What should one do if the installation in GUI mode is not invoked? 

There are set of configuration steps required to be performed during the installation in GUI mode. 

Verify whether the steps mentioned under Configuration for GUI Mode Installation section are 

done correctly. 

What should one do if there are any exceptions or errors in installation and how to 

proceed? 

1. Please backup the installation logs. 

2. Share the backup logs with Oracle support. 

On Solaris 11 system, if one gets the following error message during OFSAAI installation, 

what should be done: 

"Error: OFSAAI-1108 
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ORA-00604: error occurred at recursive SQL level 1 

ORA-01882: timezone region not found" 

Or 

"Time zone cannot be set as null or 'localtime' " 

This happens if the time zone is not set, that is NULL or it is set as ’localtime’. Set the 

environment variable TZ to a valid time zone region in the .profile file. For example, 

TZ=Asia/Calcutta 

export TZ 

What happens if the installation process is abruptly terminated or aborted? What should 

one do? 

If the installation is abruptly terminated, then the installation process will be incomplete. To 

recover from this, follow the below steps: 

1. Drop the DB objects in the config schema created by OFSAAI installation. 

2. Open the .profile and remove the entries made by the OFSAAI installation which 

are made between the comment statements, #Beginning of entries by OFSAA 

Infrastructure installation and #End of entries by OFSAA Infrastructure installation. 

3. Delete the OFSAA install directory created by the OFSAAI installer. 

4. Perform the OFSAAI installation again. 

Would OFSAA support any other web server types, other than the ones stated in tech 

matrix and installation guide? 

No, all the supported software and versions are stated in the OFSAA Technology Stack Matrices. 

What should one do if the database connection from connection pool throws an error 

"java.sql.SQLRecoverableException: IO Error: Connection reset"? 

This happens while running several database intensive tasks in parallel. To correct this error, add 

the line securerandom.source=file:/dev/./urandom in the java.security configuration file 

available in $JAVA_HOME/jre/lib/security/ path. 

NOTE:  This needs to be configured on all the machines or VMs where the OFSAAI components are 

installed. 

If the issue is not resolved even with the above settings, check the MTU(Maximum Transmission 

Unit) settings on the linux box. For details on MTU settings and updating them, contact your 

system Administrator. 
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When I invoke setup.sh file from my install archive, it throws syntax errors/file not found 

error messages, what should I do? 

This could mostly happen: 

 When installer was not unzipped rightly or corrupted during unzip. 

 setup.sh file which resides within the install archive was not transferred in ASCII or text 

mode, which could have corrupted the file. 

To correct this, follow the steps: 

1. Copy the installer (in BINARY mode) to the system on which the OFSAA Infrastructure 

components will be installed. 

2. Unzip the installer using the command: 

unzip <OFSAAI_Installer>.zip 

3. The corrupted setup.sh file would have introduced certain ^M characters into the file. 

You can remove ^M characters from setup.sh file by following the below steps: 

a. Login to the server where the installer is copied. 

b. Navigate to the directory OFSAAI_73300. 

c. Open the setup.sh file in the vi editor using the command: vi setup.sh. 

d. Inside vi editor in Esc mode, type: %s/^M//g 

NOTE:  To enter ^M, hold the CTRL key then press V and M in succesion. 

e. Save the setup.sh file by typing: wq! 

Does OFSAA support Oracle DB 11g Standard edition? 

The OCI client and the jdbc driver does not change depending on whether it is a standard or 

enterprise edition. So, OFSAAI will work with standard edition as well. 

We do not recommend standard edition because it will not scale and does not support partition 

pack, database security vault, or advanced analytics. 

On the UNIX System terminal, Error message shows "./startofsaai.sh: /java: Execute 

permission denied" while executing ./startofsaai.sh file. What is to be done? 

 Ensure JAVA_BIN environment variable path is set on the "unix user" terminal from where 

the reveleusstartup.sh file is invoked. 

 Ensure the .profile where the environment/ path settings are made has been executed 

successfully. 

OFSAAI Login page does not come up, error message "Could not retrieve list of locales" is 

displayed. What should one do? 
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This could be due to 2 reasons: 

 System is unable to resolve the hostname configured. 

 Conflict with the ports configured. 

To correct them, follow the below steps: 

A. Steps to replace the hostnames with IP address: 

1. Stop all the OFSAA services. See Stopping Infrastructure section on how to stop the 

services. 

2. Replace all the hostnames with the IP address in all the places mentioned in the 

document (Where to find port, IP address, HTTPS Configuration for OFSAAI 7.2 

Installation (DOC ID 1500479.1)). 

3. Restart all the OFSAAI services. See Starting Infrastructure section. 

B. Steps to correct the port number conflicts 

1. Stop all the OFSAA services. 

2. Refer to the port numbers stated in the document (Where to find port, IP address, 

HTTPS Configuration for OFSAAI 7.2 Installation (DOC ID 1500479.1)) and check on 

the discrepancy in the port numbers and correct them. 

3. Restart all the OFSAAI services. 

What happens when the OFSAAI Application Server does not proceed even after providing 

the system password? 

Ensure that, the System Password provided when prompted should match with the "Oracle 

Configuration password" provided during installation. Also check whether the connection to the 

"configuration schema" can be established through sqlplus. 

Although the OFSAAI installation has completed successfully, when OFSAAI servers are 

started, and the application URL is accessed, it gives an error message "the page cannot 

be found or displayed" or "Could not retrieve list of languages from Server. Please contact 

the system administrator". What should one do? 

Ensure OFSAAI servers have been started and are running successfully. On the server start up 

parameters options, see Starting Infrastructure section. 

For more details on the issue, refer on to the Revappserver log in $FIC_APP_ 

HOME/common/FICServer/logs directory or the Web Server log files. 

Is it necessary to provide the specified grants to the Oracle schema user before 

installation? If yes, can it be revoked after completion of installation? 

https://mosemp.us.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=1759065458063714&id=1500479.1&_adf.ctrl-state=j420nfs72_21
https://mosemp.us.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=1759065458063714&id=1500479.1&_adf.ctrl-state=j420nfs72_21
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The "Oracle schema" user requires the necessary grants specified before, during, and after the 

installation process. Grants provided should never be revoked as the application makes use of 

these grants all the time. 

Can we have distributed OFSAAI Application Server for load balancing? 

OFSAAI Application server can be scaled out/distributed across different JVM's (machines) 

based on the various services and Information Domains, in other words, Load balancing could be 

achieved with distribution of services. 

Why do we need Ftpshare? Why is it needed on all the layers? Can we have ftpshare on 

another machine other than the machines where OFSAAI is installed? 

Ftpshare is a Metadata Repository directory. All the metadata related files used in Infrastructure 

are stored in the ftpshare directory. The ftpshare contains folders for each Information Domain, 

with each Information Domain folders holding Erwin, log, and scripts folder. The transfer of data 

among the Web, Application, and Database servers in Infrastructure takes place through 

FTP/SFTP. 

You need to configure FTP/SFTP and enable communication between the servers by providing 

App server's FTP/SFTP credentials to the Web server and DB server users. 

Yes, we can have ftpshare on another machine other than the machines where OFSAAI is 

installed. 

Is it mandatory to provide the ftp/sftp password? 

Yes, OFSAAI needs credentials of the user which has complete permissions on ftpshare 

directory, and should be able to independently login to the unix server. 

What are the permissions required for ftpshare and when should I give them? 

It is recommended to provide 777 permissions on ftpshare in case of installations done across 

different machines or VMs (multitier installation ). 

In case of single tier installation, 770 permissions can be provided if the unix users of OFSAAI 

and web server belong to the same unix group. 

And on any new file that is created in the 'ftpshare' folder of any installation layer should be 

granted specific/explicit permission. 

Port Change utility could be used to have the Port number modified, which are currently being 

used by the Infrastructure application. For more information, refer Configure Infrastructure Ports 

section. 

Are there any in-built system administration users within OFSAAI Application? 

The three in-built system administration users are provided to configure and setup OFSAAI. 

 SYSADMN 
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 SYSAUTH 

 GUEST 

Does OFSAAI Application support both FTP and SFTP? 

OFSAAI supports both FTP and SFTP configuration. 

Is it necessary to enable the FTP/SFTP services to use the OFSAAI? 

Yes, enabling of FTP/SFTP services and its ports is a pre-requisite step towards using the 

OFSAAI. 

OFSAAI Configuration: Unable to save the server details? 

 Ensure the input User ID, Password, and Share Name are correct. 

 Ensure FTP/SFTP services are enabled. 

 Have a test FTP/SFTP connection made and confirm if they are successful. 

During Information Domain creation, the message "Please create a database and then 

create the information domain" appears. What should be done? 

Information Domain is mapped to only one Database; and thus before the creation of Information 

Domain, at least one database details would need to exist. 

The message "ConnectToDatabase: FatalError, could not connect to the DB server" 

appears during startup of backend engine message server. What does one need to do? 

 Verify whether connection to the "configuration schema" can be established through 

sqlplus. 

 Verify "configuration schema" password is modified post installation. 

 Ensure oracle database alias name created for oracle instance and oracle service name are 

same. 

 On a multi tier Installation mode, ensure TNSNAME and SID are the same in both the 

Application and Database Layers. 

The message "Fatal Error, failed to get user ID from LibSmsConnect" appears during the 

startup of backend engine message server. What has to be done? 

Ensure Reveleus.sec file exist under the $FIC_HOME/conf directory where the Database 

components are installed. 

Does OFSAAI Application support LDAP authentication? 

OFSAAI supports LDAP configuration and authentication. 

Does OFSAAI support multiple languages? 
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Yes, OFSAAI supports multiple languages. 

Does OFSAAI provide any data back-up features? 

OFSAAI does not have built-in back up facility. External Storage Infrastructure is recommended 

for back-up. 

What kind of security features does the OFSAAI provides? 

OFSAAI provides security at: 

 Segment Level - Users can access only the segment they are mapped to. 

 Application Level - Users can perform an operation only if mapped to appropriate role and 

functions. 

Does OFSAAI have the ability to enforce periodic password change? 

OFSAAI provides configurable parameters to define number of days after which the user 

password would expire and then the user is forced to change the password after expiration 

period. 

What is the password policy followed in OFSAAI? 

OFSAAI enforces a minimum password length with a combination of Upper and Lower case 

characters and alpha-numeric strings. 

Which version of Erwin Data Modeller does OFSAAI support? 

OFSAAI now supports ERwin version 9.2 and 9.5 generated xmls in addition to ERwin 4.1, ERwin 

7.1, ERwin 7.3 and ERwin 9.0 formats. 

Note: OFS AAI supports data model upload for data models generated using ERwin 7.1.x, 7.2.x, 

7.3.x, 9.0.x, 9.2.x, and 9.5.x versions 

Does OFSAAI provide the mechanism to upload Business Data model? 

OFSAAI provides two mechanisms for business data model upload: 

 Easy to use GUI based Model upload mechanism to upload the Business Data Model 

through Unified Metadata Manager --> Import Model. 

 OFSAAI also provides a model upload utility "upload.sh" for uploading the business data 

model through the command line parameter by executing this shell script file under the path 

<FIC_HOME>/ficapp/common/FICServer/bin. 

Refer the section Run the Model Upload Utility of the Oracle Financial Services Analytical 

Application Infrastructure User Guide for details. 

The Business Data model undergoes changes; how does this incremental change get 

applied to the existing model? 

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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Modified data model can be uploaded into the system and OFSAAI has the ability to compare the 

changes within the data model with respect to the one already present in the system and enables 

propagation of incremental changes in a consistent manner. 

What are the different types of uploading a business data Model? 

OFSAAI supports uploading of business data model from client desktop and also by picking up 

the data model from the server location. 

Can the OFSAAI "Configuration Schema" password be modified post installation? 

The OFSAAI "configuration schema" password can be modified post installation. OFSAAI 

application stores the password in the database and few configuration files, thus any changes to 

the "configuration schema" password would necessitate updating in these. Contact OFSAAI 

support for more details. 

Can the OFSAAI "Atomic Schema" password be modified? 

The OFSAAI "Atomic Schema" password can be modified. OFSAAI application stores the atomic 

schema password in the database and few configuration files , thus any change to the atomic 

schema password would necessitate updating the password. 

To change the Atomic Schema password, follow the steps: 

1. Login to OFSAA. 

2. Navigate to System Configuration > Database Details window. Select the appropriate 

connection, provide the modified password and save. 

3. Navigate to Unified Metadata Manager > Technical Metadata> Data Integrator > Define 

Sources window. Update the appropriate Source details. 

a. If you are using Apache Tomcat as Web server: 

 Update the <Context> -> Resource tag details in server.xml file from 

the $CATALINA_HOME/conf folder. (In case of Tomcat only Atomic 

<Resource> will exist). 

b. If you are using WebSphere as Web server: 

 Login to the WebSphere Administration Console from the left side 

menu. 

 Navigate to Resources >JDBC >Data Sources. A list of data sources 

will be populated on the right side. 

 Select the appropriate Data Source and edit the connection details. 

(In this case, both Config and Atomic data sources need to be 

modified). 

c. If you are using WebLogic as Web server: 

 Login to the WebLogic Administration Console from the left side 

menu. 
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 Under Domain Structure list box, expand the appropriate Domain 

and navigate to Services > JDBC >Data Sources. A list of data 

sources will be populated on the right side. 

 Select the appropriate Data Source and edit the connection details. 

(In this case, both Config and Atomic data sources need to be 

modified). 

4. Restart the OFSAAI services. 

NOTE:  If the modified passwords are not updated, OFSAAI logs displays the message ORA-28000: 

the account is locked. 

Does the upload of Business Data model depend on Java Memory? 

Business data model upload through OFSAAI depends on the Java memory settings on the client 

and server machines. Java memory setting varies with the data model size and the available 

RAM. Contact OFSAAI support for more details. 

Why do the Business Metadata Management screens (Business Processors screen) in 

User Interface, takes longer time to load? 

The Log file in DynamicServices.xml which resides in $FIC_HOME/conf is continuously being 

updated/refreshed to cache metadata. This can be observed when you are starting 

reveleusstartup.sh and if any of the log file (Ex: SMSService.log) in DynamicServices.xml is being 

continuously refreshed for longer time. 

By default, the Metadata Log file cache size is set to 1000. If in case the log is being updated 

beyond this limit, retrospectively the preceding entries are overwritten. For example, the 1001th 

entry is overwritten by deleting the first entry. This results in the application screen taking a longer 

time to load. 

Increase the cache size limit in Dynamicservices.xml located at <FIC_HOME>/conf, depending 

on the currently logged count for the specific metadata. 

1. Generate the Log report by executing the below query in config schema. 

select count(1), t.metadata_name, m.dsn_id 

from metadata_master m, metadata_type_master t 

where m.metadata_type = t.metadata_type 

group by t.metadata_name, m.dsn_id 

   

2. The above query returns a list of codes with their respective metadata count. You can 

refer to "metadata_type_master" table to identify the metadata name. 
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3. View the log report to identify the metadata which is being updated/refreshed beyond 

the specified cache size limit. Accordingly increase the cache size limit in 

Dynamicservices.xml depending on the currently logged count for the specific 

metadata. 

For example, if the "MEASURE_CACHE_SIZE" is set to 1000 and total measure 

reported in log is 1022, increase the limit to 2000 (approximately). 

4. Restart Reveleus/OFSAAI servers (Web and APP) and check the issue. 

What should I do if I get OutOfMemoryError while deploying EAR file in WebSphere 

application server? 

The Java memory needs to be increased in ejbdeploy.sh file which is present under <WebSphere 

Install directory>/AppServer/deploytool/itp. For example, 

$JAVA_CMD \ 

-Xbootclasspath/a:$ejbd_bootpath \ 

Xms256m -Xmx1024m \ 

What configurations should I ensure if my data model size is greater than 2GB? 

In order to upload data model of size greater than 2GB in OFSAAI Unified Metadata Manager- 

Import Model, you need to configure the required model size in struts.xml file available in the path 

$FIC_WEB_HOME/webroot/WEB-INF/classes. 

NOTE:  The size requirements have to be always specified in bytes. 

For example, if you need to configure for model size of 2.5GB, then you can approximately set 

the max size to 3GB (3221225472 bytes) as indicated below, in order to avoid size constraints 

during model upload. 

<constant name="struts.multipart.maxSize" value="3221225472"/> 

After configuring struts.xml file, generate the application EAR/WAR file and redeploy the 

application onto your configured web application server. For more information on generating and 

deploying EAR / WAR file, see Configuring Web Application Servers. 

What should I do if my Hierarchy filter is not reflecting correctly after I make changes to 

the underlying Hierarchy? 

In some cases, the Hierarchy Filters do not save the edits correctly if the underlying Hierarchy 

has been changed. This can occur in hierarchy maintenance, where you have moved a member 

to another hierarchy branch, and that member was explicitly selected in the Filter and is now a 

child of a node which is already selected in the Filter. 

Please refer to Support Note for the workaround. 

https://mosemp.us.oracle.com/epmos/faces/DocumentDisplay?id=1586342.1


   

 

Oracle Financial Services Software Confidential - Restricted 

246 

 

What should I do to change context name for a cloned environment? 

Refer to Support Note. 

How do you turn off unused information domains (infodoms) from cache? 

Follow the below steps to turn off unused infodoms from cache: 

Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation. 

1. In the DynamicServices.xml file, identify the section for <Service code="20">. 

2. Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1). 

3. Repeat the same in the WEB layer too. Generate the application EAR/WAR file and 

redeploy the application onto your configured web application server. For more 

information on generating and deploying EAR / WAR file, see Configuring Web 

Application Servers 

4. Restart the OFSAAI Services (APP and WEB). For more information, see Start / Stop 

Infrastructure Services chapter. 

NOTE:  This setting will cache the Infodom metadata only for the infodoms that get accessed upon 

user login. Infodoms which do not get accessed, will not be cached. 

Sample code is pasted below: 

<SERVICE CODE="20" 

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" 

NAME="BMD" 

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10"> 

<PARAMETERS> 

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" /> 

<PARAMETER NAME="BACKUP_XML" VALUE="1" /> 

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" /> 

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" /> 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" /> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" /> 

https://mosemp.us.oracle.com/epmos/faces/DocumentDisplay?id=1586372.1
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<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" /> 

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" /> 

</PARAMETERS> 

</SERVICE> 

Can I install an Application Pack on an existing Atomic schema/ Information Domain 

created manually? 

No, you cannot install an Application Pack on existing Atomic schema/Information Domain 

created manually. Application Packs can be installed only on Atomic Schemas/Information 

Domain created using schema creator utility and/ or the Application Pack installer. 

When trying to view the model outputs in Model Outputs screen, I get "Exception ->Local 

Path/STAGE/Output file name (No such file or directory)". 

Ensure you have created a folder "STAGE" under the path mentioned as "Local Path" in the web 

server details screen. This folder needs to be created under the local path on every node ,in case 

of web application server clustering. 

During OFSAA services startup, I get Exception in thread “main” 

java.lang.UnsatisfiedLinkError: net (Not a directory)? 

Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference to point to a 

physical JRE installed. 

What is the optimized memory settings required for "New" model upload? 

The following table lists the optimized memory settings required for "New" model upload. 

Table 1: optimized memory settings required for "New" model upload 

Model Upload Options Size of Data Model XML 

File 

X_ARGS_APP ENV 

Variable in OFSAAI APP 

Layer 

Pick from Server 106 MB "-Xms1024m -Xmx1024m 
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Model Upload Options Size of Data Model XML 

File 

X_ARGS_APP ENV 

Variable in OFSAAI APP 

Layer 

 

 

36 MB "-Xms2048m -Xmx2048m 

815 MB "-Xms4096m -Xmx4096m 

1243 MB "-Xms6144m -Xmx6144m 

Model Upload Utility 106 MB "-Xms1024m -Xmx1024m 

336 MB "-Xms2048m -Xmx2048m 

815 MB "-Xms4096m -Xmx4096m 

1243 MB "-Xms6144m -Xmx6144m 

Save New Erwin File In Server 106 MB "-Xms1024m -Xmx1024m 

336 MB "-Xms2048m -Xmx2048m 

815 MB "-Xms4096m -Xmx4096m 

1243 MB "-Xms6144m -Xmx6144m 

What is the resolution if I get the error - ORA 01792 maximum number of columns in a 

table or view is 1000 during T2T execution? 

You should apply the below patch set from Oracle. Applicable only for 12c. 

https://support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1  

I did not enable OFS Inline Processing Engine Application license during the installation. 

However, I have enabled it post installation, using the Manage OFSAA Product License(s) 

in the Admin UI. Are there any other additional configurations that I need to do? 

Yes. Follow the instructions explained in the OFS Inline Processing Engine Configuration Guide. 

I get an error "" when I try to build an Oracle OLAP cube. What should I do?  

Execute the below grant on the appropriate ATOMIC schema  

@ grant olap_user to &database_username 

How do you turn off unused Information Domains (Infodoms) from caching? 

Follow these steps to turn off unused infodoms from caching: 

1. Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation. 
2. In the DynamicServices.xml file, identify the section for <Service code="20">.  
3. Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1).  
4. Repeat the same in the WEB layer too. Generate the application EAR/WAR file and 

redeploy the application onto your configured web application server. For more 

https://support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1
http://docs.oracle.com/cd/E60058_01/homepage.htm
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information on generating and deploying EAR / WAR file, refer to the Post Installation 
Configuration section. 

5. Restart the OFSAAI Services (APP and WEB). For more information, refer to the Start 
OFSAA Infrastructure Services section. 

Note:  

This setting will cache the Infodom metadata only for the infodoms that get accessed upon user 
login. Infodoms which do not get accessed, will not be cached.  

Sample code is pasted below:  

<SERVICE CODE="20"  

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" 

NAME="BMD"  

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10">  

<PARAMETERS>  

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" />  

<PARAMETER NAME="BACKUP_XML" VALUE="1" />  

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" />  

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" />  

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" />  

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" />  

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" />  

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" />  

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" />  

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" />  

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" />  

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" />  

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" />  

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" />  

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" />  

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" />  

</PARAMETERS>  

</SERVICE> 

"While creating an Excel Mapping, after specifying the excel worksheet, the target table, 

and mapping each column in the worksheet to a target table, I click SAVE and nothing 

happens. But when I click CANCEL, a message pops up informing me that all changes will 

be discarded", what is to be done. 
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Check if the excel mapping creation is done using I.E 8 with JRE 1.4 plug in enabled on machine. 

If so, upgrade the JRE plug in to 1.7+ 

 

2233..11..22  AApppplliiccaattiioonn  PPaacckk  88..00..00..00..00  FFAAQQss  

What is an Application pack? 

An Application Pack is suite of products. For more information, refer Application Packs. 

Can I get a standalone installer for OFSAA 8.0? 

No. AAI is part of every application pack and installs automatically. 

How does OFSAA 8.0 Application pack relate to OFSAA 7.x series? 

8.0 is a new major release consolidating all products from OFSAA product suite. 

Can existing OFSAA 7.x customers upgrade to OFSAA 8.0 Application Pack?  

There is no upgrade path available. However, we will have migration kit / path for every product to 

8.0 application pack. Further details will be available with Oracle Support. 

Does OFSAA 8.0 Application pack UPGRADE’s automatically existing environments? 

No.  Refer Point 5.  OFSAA 8.0 application pack has to be installed in a new environment and 

subsequently migration path / migration kit needs to be run to migrate from 7.x to 8.0.  Please 

note we will have migration path only from the previously released version of OFSAA products. 

Where can I download OFSAA 8.0 Application Pack? 

OSDC 

What are the minimum system and software requirements for OFSAA 8.0 Application 

Pack? 

Refer installation guide section Hardware and Software Requirements section. 

Is my environment compatible with OFSAA 8.0 Application Pack?  

Environment Check utility performs the task.  It is part of install and can also be run separately. 

Has OFSAA 8.0 Application Pack is supports all Operating systems? 

LINUX, AIX, SOLARIS 10, 11. Refer to Technology Matrix for the technology matrix that OFSAA 

suite products are/ will be qualified on. 

How can I install OFSAA 8.0 Application Pack? 

Refer to I&C guide published in OTN for the application pack installers. 

Do we need any License Key to install? 

http://docs.oracle.com/cd/E55339_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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No, you do not need any License Key to install. 

Does this installation require any Third party Software’s?  

Installation Guide lists the third party software that needs to be installed. 

What languages are supported during OFSAA 8.0 Application Pack installation? 

US English is the language supported. 

What mode of installations OFSAA Application Pack supports? [i.e., Silent , GUI] 

OFSAA Application Packs supports both, GUI and Silent Mode. 

Does OFSAA 8.0 Application Pack support Multi tier Installations? 

OFSAA 8.0 does single tier installation.  

Does this Application Pack validate all Pre-requisites required for this installation i.e., 

Memory, Disk Space etc.? 

Yes.  The pre-requisite checks are done by the respective application pack installer.   

What happens if it aborts during installation of any application with in Application pack? 

Customer needs to restore the system and retrigger the installation 

Does this Application pack ‘Rolls Back’ if any of application installation fails due to 

errors? 

Rollback of installation is not supported. 

Does the Application pack installs all applications bundled? 

All application pack file system files are installed but there is an option to enable the licensed 

products. 

How can I re-install any of the Application Pack? 

You can retrigger in case of failure. 

Does Application pack allow enabling / disabling any of the applications installed?  

Yes.  You cannot disable once the product is enabled in an environment. 

I have installed one application in a Application pack and can I install any of new 

applications within the Application pack later point of time? 

No, installation is not required.  Enabling the application is an option to use it later. 

Is it possible to Install OFSAA 8.0 Application pack on any one of the existing ‘Infodom’ 

where another  OFSAA 8.0 application is installed? 
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Yes.  But Behavioral Detection Pack and Compliance Regulatory Reporting pack are the 

exceptions.  They need to be installed in a different INFODOM. 

Is there any option in Application pack for the user to select Infodom during installations? 

Yes. You can select or change the required infodom.  

Can I install all Application Packs in a ‘Single Infodom’? 

Yes.  But Behavioral Detection Pack and Compliance Regulatory Reporting Pack are the 

exceptions. They need to be installed in a different INFODOM. 

Is it possible to install applications on different Infodom within the Application pack? (That 

is if you want to install LRM & MR in two infodoms) 

Applications within application pack have to be installed in the same information domain in the 

same environment. 

Does ‘Data Model’ bundled is Application pack Specific or Specific to individual 

application? 

A merged data model for all applications within the application pack is bundled and uploaded. 

Is it possible to install OFS Enterprise Modeling in later point of time? 

OFS Enterprise Modeling as separate product and can be enabled as on option at later point of 

time from any application pack that bundles Enterprise Modeling. 

Does OFS Enterprise Modeling is required for all applications? 

This product is enabled depending on the applications that use the features of OFS Enterprise 

Modeling. 

Will Application pack creates sandbox automatically for the required applications? 

Yes, Sandbox creation is part of application install process. 

Do we have upgrade Kits for individual applications or it’s a Application Pack Upgrade? 

ML/ IR releases / upgrades will be across Packs.  

Can I upgrade AAI only? 

Yes, you can upgrade AAI alone. 

Can I upgrade one application within the Application Pack? i.e., LRM will be upgraded in 

Treasury Application pack, but MR won’t be upgraded. 

No. Not possible Upgrade is applied across packs. 

Is it possible to uninstall any Application from the Application pack? 

No, it is not possible to uninstall any Application from the Application Pack. 
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Can I uninstall entire Application Pack? 

No, you cannot uninstall the Application Pack. 

Is it possible to uninstall only application and retain AAI in the installed environment? 

No, you cannot uninstall only the application and retain AAI in the installed environment. 

Does Application Pack contain all Language Packs supported? 

Language Packs are installed on top of 8.0 application pack. Releases are planned post the 8.0 

availability. 

Can I install an Application Pack over another Application Pack (that is same infodom or 

different information) 

Yes, you can install an Application Pack over another Application Pack in the same information 

domain or different information domain. 

Can I use an existing manually created schema as information domain for application pack 

installation? 

No. Schemas required by OFSAA applications have to be created using Schema Creator Utility. 

Does OFSAA 8.0 support on WebLogic 10.3.6 with Oracle 12c? 

Yes, OFSAA 8.0 will support on WebLogic 10.3.6 with Oracle 12c. WebLogic 10.3.6 supports 

oracle 12c with some additional configurations. Refer the link 

http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655 for 

additional configurations. 

While running the schema creator utility, I get an error “HostName in input xml is not 

matching with the local hostname”? 

 One possible reason could be the machine is configured for zonal partitioning. Ensure all the 

known IP Addresses of the machine are present in the /etc/hosts file. 

"While creating an Excel Mapping, after specifying the excel worksheet, the target table, 

and mapping each column in the worksheet to a target table, I click SAVE and nothing 

happens. But when I click CANCEL, a message pops up informing me that all changes will 

be discarded", what is to be done. 

Check if the excel mapping creation is done using I.E 8 with JRE 1.4 plug in enabled on machine. 

If so, upgrade the JRE plug in to 1.7+ 

What are the Java versions supported in OFS AAAI Application Pack version 8.0.0.0.0? 

OFS AAAI Application Pack supports Java 1.6.x, 1.7.x and 1.8.x. 

Is this release of the OFS AAAI Application Pack version 8.0.0.0.0 supported on Java 8? 

http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655
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Yes. To install this release of the OFS AAAI Application Pack version 8.0.0.0.0 on Java 8. For 

more information, refer to specific notes mentioned in the sections Installer and Installation 

Prerequisites, Configurations supported for Java 8, Configuring the Schema Creator Utility, GUI 

Mode Installation, SILENT Mode Installation. 

What should I do when I get "[ERROR] - Error: APP Setup bin file failed." Message during 

OFS_Application_PACK installation? 

This is a generic error message that appears during application installation failure. You should 

check the installation log files for more information about what failed the installation. However, if 

the message is displayed and the log files are not generated, it could be that it is a temp directory 

issue. The resolution is that your UNIX administrator has to disable the NOEXEC option. The 

installers extract the installation files into the /tmp directory, and if NOEXEC is enabled, execution 

of binaries will not happen in the directory and the installation fails. Re-run the installer after the 

configuration is changed. For detailed information, see the support note at 

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1. 

2233..22  EErrrroorr  DDiiccttiioonnaarryy  

The content of this section has been created with the interest to help you resolve the installation 

issues if any. There is a compilation of all the possible errors that might arise during the 

installation process with the possible cause and the resolution to quickly fix the issue and proceed 

further with the installation. 

2233..22..11  AAcccceessssiinngg  EErrrroorr  DDiiccttiioonnaarryy  

Instead of scrolling through the document to find the error code, you can use the pdf search 

functionality. In the "Find" dialog available in any of the Adobe Acrobat version that you are using 

to view the pdf document, follow the below instructions to quickly find the error resolution. 

1. With the Installation pdf open, press Ctrl+F or select Edit > Find. 

2. The Find dialog is displayed as indicated. 

3. Enter the error code that is displayed on screen during Infrastructure installation. 

4. Press Enter. The search results are displayed and highlighted as indicated below. 

OFSAA_DM_Pack_8%200_Installation_Guide.docx#Installer and Installation Prerequisites
OFSAA_DM_Pack_8%200_Installation_Guide.docx#Installer and Installation Prerequisites
OFSAA_DM_Pack_8%200_Installation_Guide.docx#Configurations Supported for Java 8
OFSAA_DM_Pack_8%200_Installation_Guide.docx#Configuring the Schema Creator Utility
OFSAA_DM_Pack_8%200_Installation_Guide.docx#GUI Mode Installation
OFSAA_DM_Pack_8%200_Installation_Guide.docx#GUI Mode Installation
OFSAA_DM_Pack_8%200_Installation_Guide.docx#Silent Mode Installation
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1
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Figure 1: Error Dictionary 

View the details of the issues, its cause, and resolution specific to the error code. Repeat the step 

to find an answer to any other errors that you notice during installation. If you are not able to 

resolve the issue even after following the steps provided in resolution, you can contact 

support.oracle.com along with log files and appropriate screen shots. 

2233..22..22  EErrrroorr  CCooddee  DDiiccttiioonnaarryy  

23.2.2.1 EErrrroorr  ccooddee  --  OOFFSSAAAAII--11000011  

Cause Unix shell is not "korn" shell. 

Resolution Change the shell type to "korn". Use chsh 

unix command to change SHELL type. 

Shell type can also be changed by 

specifying shell path for the Unix user in 

/etc/passwd file. 

Note: chsh command is not available in 

Solaris OS.Cause 

23.2.2.2 EErrrroorr  ccooddee  --  OOFFSSAAAAII--11000022  

Cause No proper arguments are available. 

Resolution Provide proper arguments. Invoke Setup.sh 

using either SILENT or GUI mode. 

Example: ./Setup.sh SILENT or 

./Setup.sh GUI 
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23.2.2.3 EErrrroorr  ccooddee  --  OOFFSSAAAAII--11000044    

Cause File .profile is not present in $HOME. 

Resolution Create .profile in $HOME, i.e. in the 

home directory of user. 

23.2.2.4 EErrrroorr  ccooddee  --  OOFFSSAAAAII--11000055  

Cause File OFSAAInfrastructure.bin is not 

present in current folder. 

Resolution Copy OFSAAInfrastructure.bin into 

installation kit directory. 

 

23.2.2.5 EErrrroorr  ccooddee  --  OOFFSSAAAAII--11000066  

Cause File CustReg.DAT is not present in current 

folder. 

Resolution Copy CustReg.DAT into installation kit 

directory. 

23.2.2.6 EErrrroorr  ccooddee  --  OOFFSSAAAAII--11000077  

Cause File OFSAAI_InstallConfig.xml is not 

present in current folder. 

Resolution Copy OFSAAI_InstallConfig.xml into 

installation kit directory. 

23.2.2.7 EErrrroorr  ccooddee  --  OOFFSSAAAAII--11000088  

Cause File validateXMLInputs.jar is not present 

in current folder. 

Resolution Copy validateXMLInputs.jar into 

installation kit directory. 
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23.2.2.8 EErrrroorr  ccooddee  --  OOFFSSAAAAII--11000099  

Cause File log4j.xml is not present in current 

folder. 

Resolution Copy log4j.xml into installation kit directory. 

23.2.2.9 EErrrroorr  ccooddee  --  OOFFSSAAAAII--11001100  

Cause Unknown error occurred. 

Resolution Make sure to provide proper argument 

(SILENT or GUI) to the Setup.sh file. 

 

23.2.2.10 EErrrroorr  ccooddee  --  OOFFSSAAAAII--11001111  

Cause XML validation failed. 

Resolution Check InfrastructurePreValidations.Log for more 

details. 

23.2.2.11 EErrrroorr  ccooddee  --  OOFFSSAAAAII--11001122  

Cause Property file with locale name does not exist. 

Resolution Copy MyResources_en_US.properties to 

the setup kit directory and keep en_US in 

LOCALE tag of OFSAAI_InstallConfig.xml 

23.2.2.12 EErrrroorr  ccooddee  --  OOFFSSAAAAII--11001133  

Cause File 

OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml 

not found. 

Resolution Copy 

OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml 

to the setup kit directory. 
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23.2.2.13 EErrrroorr  ccooddee  --  OOFFSSAAAAII--11001144  

Cause XML node value is blank. 

Resolution Make sure all node values except 

SMTPSERVER, PROXYHOST, PROXYPORT, 

PROXYUSERNAME, PROXYPASSWORD, 

NONPROXYHOST, or RAC_URL are not blank. 

23.2.2.14 EErrrroorr  ccooddee  --  OOFFSSAAAAII--11001155  

Cause XML is not well formed. 

Resolution Execute the command dos2unix 

OFSAAI_InstallConfig.xml to convert plain 

text file from DOS/MAC format to UNIX format. 

OR 

Make sure that OFSAAI_InstallConfig.xml 

is valid. Try to open the file through Internet 

Explorer for a quick way to check validity. If it is 

not getting opened, create new 

OFSAAI_InstallConfig.xml using the 

XML_Utility.jar. 

23.2.2.15 EErrrroorr  ccooddee  --  OOFFSSAAAAII--11001166  

Cause User installation directory contain blank spaces. 

Resolution Provide an installation path that does not 

contain spaces. Check the tag 

USER_INSTALL_DIR in 

OFSAAI_InstallConfig.xml file. This path 

should not contain any spaces. 

 

23.2.2.16 EErrrroorr  ccooddee  --  OOFFSSAAAAII--11001177  

Cause User installation directory is invalid. 
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Resolution Provide a valid installation path. Check if you 

are able to create the directory mentioned in 

USER_INSTALL_DIR tag value of 

OFSAAI_InstallConfig.xml file. 
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